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1 Preface

1.1 About the program

The Mag2Pol source code is entirely written in C++ and can be downloaded in compiled

form for the main platforms Windows, MacOS and Linux. The program is based on the

Qt5, QCustomPlot, Eigen and OpenGL libraries.

1.2 Purpose of the program

Mag2Pol was developed to supply an easy-to-use tool for analyzing spherical neutron

polarimetry data obtained from single-crystal neutron scattering experiments using the

Cryogenic Polarization Analysis Device (CRYOPAD). In addition it can treat flipping ra-

tios in combination with a multipole expansion of the magnetic form factor. The analysis

of nuclear and magnetic structures based on integrated intensites is of course also possible.

Since version 2.4 multiple-wavelength integrated intensity data as well as X-ray data can

be treated. Version 2.4.1 introduces the calculation of Schwinger scattering flipping ra-

tios. Rietveld refinement of powder data was introduced in version 4.0. The refinement of

nuclear/magnetic structures to time-of-flight data was introduced for powders and single

crystals in versions 5.0 and 8.0, respectively.

Crystal and magnetic structure models can easily be introduced via the graphical user

interface (the latter also with the help of the Irreducible Representation and Space Group

Tables tool) and viewed in 3D in an OpenGL widget. Those models can then be refined to

experimental data within a least-squares refinement. Hereby, spherical neutron polarime-

try data, integrated intensities from a standard single-crystal diffraction experiment and

powder/x-ray diffraction data can be simultaneously analyzed in any combination.

1.3 Disclaimer

Mag2Pol is distributed under the GNU Lesser General Public License v. 3 (LGPLv3).

The complete Qt5 source code of the used Qt5 libraries can be downloaded from the

Mag2Pol download page (note that the original code was not modified). The program

1



1 Preface

is distributed with dynamically linked libraries which can be rebuilt by the user, if they

wish to use a different Qt version. A copy of the LGPL license text can be viewed in the

About window accessible from the main menu.
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2 Getting started

2.1 Installation

2.1.1 Windows

In order to run under Windows Qt5 depends on Microsoft Visual Studio. The Visual

Studio Redistributable Packages are included in the download of Mag2Pol and have to

be installed by running vcredist x64.exe. Afterwards, Mag2Pol can be started from

its executable, which should stay in its folder with all necessary libraries.

2.1.2 MacOS

Open the downloaded dmg image and drag the application to your Applications folder or

directly download Mag2Pol from the Mac App Store. Once the prompt appears saying

that the application cannot be opened (after the first attempt of starting the application

downloaded from the Mag2Pol website), cancel it and launch System Preferences. Nav-

igate to the Security & Privacy section, and under the General tab you’ll see the blocked

program. Simply click Open Anyway to launch it.

2.1.3 Linux

• AppImage (only 64 bit Linux versions)

Download and launch the AppImage.

• Debian package (only up to Mag2Pol version 3.0)

Download gdebi from a terminal by typing sudo apt-get install gdebi. Then

install the debian package with sudo gdebi mag2pol 3.0.0-1 amd64.deb, which

will download the necessary libraries from the internet. Start the program by typing

Mag2Pol.

2.2 Setting up a structure model

The main window contains a toolbar for the most frequently used menu entries and dock-

able widgets, which can be reorganized to one’s individual taste. Moving a widget on top

3



2 Getting started

of another will automatically create a tab widget and single tabs can be extracted to form

new widgets. All the settings related to the toolbar and the dock widgets can be found in

the View menu. Six different presets of different window dispositions can be accessed with

the shortcuts Ctrl/Cmd + 1-6. Note that the exact position and size of the individual

widgets are saved, when the program is closed and restored at the next start.

The first step for a meaningful use of Mag2Pol is the parametrization of a nuclear and

eventually magnetic structure model in the main window. This is done in the tab widget

on the upper left part of the main window, when Mag2Pol starts up (shown in red in

Fig. 2.1) or by loading a *.cif or *.mcif file.

The crystallographic space group (CSG) of the underlying nuclear structure has to be

entered in Hermann-Mauguin notation in the corresponding field under the Symmetry

tab. It is also possible to enter a magnetic space group (MSG) or a magnetic superspace

group (MSSG), see also Sec. 6.2 for more information about space groups. Note that all

information related to MSGs and MSSGs is based on the tables available at the Isotropy

Software Suite [1], and in particular ISO-MAG [2] and ISO(3+d)D [3–6]. The entry

of a CSG, MSG or MSSG is case dependent, i.e. the first letter should be upper case

and any following letters lower case. Eventual additional spaces will be removed. Note

that for MSGs and MSSGs lower-case symbols need to be preceded by an underscore (e.g.

P2 1’ in order to distinguish P2′1 from P21′) in order to avoid ambiguity, while this is

not necessary for CSG. For MSGs having the same label as a CSG an underscore should

be added (e.g. Pmna for the MSG and Pmna for the CSG). The symbol will be shown

in green, if the space group has been recognized, and in red in the contrary case. In the

case of CSGs, all alternative monoclinic settings are included as well as space groups with

different origin choices or trigonal space groups with different axes settings (hexagonal or

rhombohedral). For MSGs and MSSGs the following conventions are chosen by default:

monoclinic unique axis b, monoclinic cell choice 1, hexagonal axes for trigonal groups and

origin choice 2 for groups with more than one origin choice. Alternatively, the space group

can be entered by its number or its numerical label in case of a MSG or MSSG. If the

entry is followed by # the numerical entry will be replaced by the space group label (e.g.

139# for space group I4/mmm). Note that an MSG or MSSG can be changed and the

structure regenerated even while refining a magnetic structure in the fit window as long

as the atomic positions remain the same (i.e. the parent CSG needs to be the same, e.g.

a change from Pnm′a to Pn′ma′). This allows for a quick testing of different magnetic

models.

If an entered CSG has origin or axes setting choices a combo box will appear next to the

space group field, in which the corresponding choice can be entered. For cell transforma-

tions the Space group tables tool has to be used (see Sec. 6.2).

The lattice parameters should be given in Ångströms and degrees. If a CSG was entered

4



2.2 Setting up a structure model

Figure 2.1: Mag2Pol main window at the program start (in the Compact 1 preset).

The cyan box shows the toolbar from which most of the menu entries can be triggered.

The crystal and magnetic structure information are entered in the tab widget marked by

the red box. The green box contains the OpenGL widget for the 3D visualization of the

nuclear and magnetic structure and the drawing box given in relative lattice coordinates.

The blue box is devoted to the experimental geometry including wavelength and sample

orientation. Individual calculations for a given (hkl) reflection can be triggered from

here. The calculated angles corresponding to the instrument geometry are shown in the

respective boxes. The results of the calculations (nuclear/magnetic structure factors,

flipping ratios, etc.) are shown in the orange output box.
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2 Getting started

the magnetic symmetry can be given manually by a number of symmetry operators (gener-

ators) which can be constructed from the drop-down menues. It is also possible to use the

smart copy-paste feature, i.e. copy the text corresponding to a symmetry operator (e.g.

in the Irreducible representations or Space group tables windows) and paste it into the

symmetry table of the main window by right-clicking the vertical header number (start-

ing from the second row, since the first operator is always the identity). The first part

featuring xyz refers to the symmetry operator which is applied to the atomic position,

whereas the second part featuring uvw is the corresponding symmetry operation acting on

the magnetic moment. Each symmetry operator can be combined with a magnetic phase.

Note that the magnetic symmetry can be obtained from calculating the irreducible repre-

sentations through the menu item Generate→Irreducible representations (see Sec. 6.4). In

that case it is not necessary to enter the magnetic symmetry operators by hand. Similarly,

the use of a MSG or MSSG will automatically set the magnetic symmetry. Mag2Pol

supports the loading of *.mcif files for MSGs and MSSGs together with the appropriate

transformations.

Under the tab Atoms the different sites can be entered by adjusting the correspond-

ing number. Each site needs an atom label which corresponds to the element symbol in

case of a purely nuclear scatterer. For a magnetic atom, the label starts with an M or

J followed by the element symbol and the oxidation state, e.g. MCo3 or JHo3. The M

refers to the magnetic form factor containing only spherical Bessel functions ⟨j0⟩, while
J denotes a magnetic form factor of rare-earth elements approximating ⟨j0⟩+ c2⟨j2⟩. For
the calculation of Schwinger flipping ratios the exact x-ray form factor is needed for which

the oxidation state should be given as e.g. Co2 for a non-magnetic atom. Contrarily to

the space group symbol, the entry is case independent, however, no spaces can be used.

The atomic positions should be entered as fractional coordinates, where fractions like

1/3 or 2/3 need to be rounded to the 5th digit, i.e. 0.33333 or 0.66667, respectively. It is

also possible to right-click the atom label in order to choose from the list of Wyckoff sites

and respective positions within the given space group. If the atomic position is already

entered, the occupied Wyckoff site will be shown in bold and can be converted to any

other position within this list.

An isotropic temperature factor B and an occupation factor (1 for a fully occupied site)

can be entered for each site. Anisotropic temperature factors can be chosen by right-

clicking the isotropic value, which opens a pop-up menu for activating and setting the

values. Depending on the site symmetry certain entries of the anisotropic temperature

tensor may be 0 or constrained. In Mag2Pol this is handled automatically by determin-

6



2.2 Setting up a structure model

ing the site-symmetry group. As stated in [7] one should choose the first atomic position of

an equivalent set given in the International Tables Vol. A [8] in order to obtain the correct

restrictions. When the tensor is the zero matrix it will be initialized as isotropic according

to the isotropic temperature factor following [9]. The inverse operation is also possible: the

isotropic temperature factor can be set as an equivalent one from the anisotropic tensor

by evoking the previously mentioned pop-up menu. Anisotropic displacement ellipsoids

can be visualized in the unit cell by checking the corresponding checkbox in the settings

menu (see this demo video).

If a magnetic ion has been recognized, it will be displayed in the Spins tab, where its

complex Fourier components and a phase factor can be entered (in the case of user-

defined basis vectors or basis vectors of irreducible representations or magnetic (super)

space groups, the coefficients of those basis vectors should be entered here, see Sec. 3.6

and Sec. 6.4). When a CSG and no basis vectors are used, the description of the com-

plex Fourier components can be switched between Cartesian and spherical coordinates,

by right-clicking the Spin header in the spin table. For analyzing flipping ratio data it is

convenient to set the magnetic moments parallel to the applied magnetic field direction

(typically the vertical diffractometer axis) which can be done by right-clicking the z label

in the Geometry window and selecting set moments parallel. Note that this automatically

adds the generators of the used CSG as magnetic symmetry operators in order to generate

the magnetic unit cell with parallel spins.

It is also possible to describe the magnetic moments using the local susceptibility ap-

proach [10], for which the 6 entries of a symmetric anisotropic tensor (see Sec. 7.8) need

to be given together with the magnetic field value (the direction of the field is the vertical

direction of the diffractometer, either given by the orientation matrix or the z axis shown

in the Geometry window). Site symmetry relations between the tensor coefficients are

automatically set depending on the point symmetry. Note that the local susceptibility

ellipsoids need to be activated as plot objects in the settings menu.

In addition to the magnetic moment coefficients, the propagation vector can be entered

in the Spins tab, which relates the translational symmetry of the magnetic cell to the

nuclear one. The checkbox +q ̸= −q is automatically set when the propagation vector or

the space group is changed. It should be activated, when q − (−q) does not correspond

to a vector of the reciprocal lattice. The automatic setting can always be overridden,

e.g. if the reflections were measured with a component 0.501 which in fact should be

commensurate. The propagation vector can also be set by right-clicking the Propagation

vector: q = label which opens a context menu. Under the menu entry Brillouin zone

7
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label all symmetry-inequivalent propagation vectors—with respect to the currently used

space group—and their labels are listed from which one can be chosen by clicking it. The

label of the currently active propagation vector is shown in italic and is only updated after

re-generating the structure. Note that the labels are given with respect to the standard

space group setting, i.e. the effect of an eventual basis transformation on the propagation

vector is not taken into account.

A generated crystal structure can be converted to any of its maximal non-isomorphic

subgroups of type I (translationengleich), IIa (klassengleich, loss of centering transla-

tions), IIb (klassengleich, enlarged unit cell) or maximal isomorphic subgroups of type

IIc (klassengleich, enlarged unit cell). This can be achieved by right-clicking the label

Space group and selecting the appropriate subgroup from the context menu. The eventual

basis transformation and splitting of atomic positions will be applied automatically. Any

structure (except P1) can directly be converted to space group P1 by selecting convert

to P1 from the context menu. This will add all atoms (formerly generated by the space

group symmetry) to the list in the Atoms tab, which can be useful if one wants to treat

the nuclear/magnetic structure without symmetry constraints. If a structure is already

expressed in P1 symmetry, an additional menu entry create supercell is visible in the con-

text menu. When clicked, the supercell can be given in the form of na x nb x nc (note

that the x are optional, spaces work as well), which will then be applied to the lattice

parameters and to all atomic positions.

It is possible to set up multiple phases. When treating single-crystal data, this feature can

be useful in the presence of co-existing magnetic structures which have the same propa-

gation vector and therefore contribute to the same magnetic reflections. Multiple phases

may also be used to generate or analyze a powder pattern.

In order to create an additional phase simply right-click the Phase label above theOpenGL

widget and under the Add phase menu choose either New phase, Duplicate current phase

or Load from file. In the second case a copy of the present phase will be generated which

can then be modified. When a new phase is loaded from a file, *.xml or *.cif formats

are supported, while for multi-phase *.xml files all phases are added. The different crys-

tal and magnetic structures can be visualized by modifying the phase number through

the arrow buttons. A volume fraction is associated to each phase which can be set in

Structure→Phases, domains and twins.

Different example videos are available for setting up a structure model, setting up a simple

magnetic structure or setting up a complex magnetic structure.
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2.3 Visualizing crystal and magnetic structures

2.3 Visualizing crystal and magnetic structures

Once all necessary parameters have been entered, the crystal and magnetic structures

can be visualized by triggering the menu entry Generate→Unit cell or using its shortcut

(Ctrl/Cmd + U). In case of a missing or erroneous input, the corresponding error mes-

sage should pop up. Mag2Pol can optionally check, if the atomic positions entered by

the user are not too close to a special position of the space group. This would lead to gen-

erated atoms which are too close to each other and trigger a warning. This option and also

the shortest allowed distance between generated atoms can be set in Settings→Symmetry.

The perspective can be modified by dragging within the OpenGL widget. A rotation

around the axis vertical to the viewing plane can be achieved by dragging within the

upper or lower left corner of the widget. Zooming in and out is done via the mouse

wheel, wheras the original zoom can be restored with a right click. Rotations around a

user-definable axis can be achieved by entering vector components of the rotation axis,

selecting the type of vector (direct cell, reciprocal cell or viewport), the single step value

and then by using the play-stop buttons. Zooming in and out can also be done stepwise

by clicking on the up and down buttons next to the zoom value (right-clicking this value

allows to set the single step). The view can be shifted by keeping the Shift key pressed

while dragging. The perspective or orthographic view can be toggled by clicking the icon

above the play-stop buttons. When the perspective view is activated, the depth of the

projection can be modified by holding down the Cmd/Ctrl button and zooming. After a

change using the mouse wheel, the Zoom spinbox is replaced by the Depth value which can

be modified stepwise (depth values between -20 and -40 usually give satisfying results).

After a normal zoom the Zoom spinbox is restored. The bounding box of the volume

to plot can be modified in the spin boxes corresponding to relative units of the lattice

constants. In some cases, the bounding box values cannot be adjusted appropriately to

show an intended selection of atoms. For such cases, undesired atoms can be masked

by selecting them (either by a single click, a shift click showing the bond, are two shift

clicks showing the angle, see next section) and then hitting Alt+M. Masked atoms can

be cleared with Alt+C.

If more than one phase or magnetic domain is present, each individual structure can be

viewed by selecting the respective phase/domain number in the spin box. The position of

the light source can be modified by dragging the scene while pressing the Alt key. The

default position is restored by Alt+rightclick.

The appearance of every atom/spin site can be modified with the plot options shown at

the right of the atomic position. A site can be turned invisible by removing the tick below

plot. A right-click on either of the plot check boxes opens a context menu from which it

can be chosen whether all, only nuclear or only magnetic atoms will be plotted. The color
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can be chosen by clicking on the colored square and then by setting the RGB values in

the pop-up window, either for the atom or for the spin (if the atom is magnetic). The

color boxes also provide convenient shortcuts through a context menu: a selected color

can be applied to all atoms, all nuclear atoms, all magnetic atoms or all atoms with the

same label. The sizes of the atoms and spins can be defined in the boxes size a and

size s, respectively. If the Fourier components are imaginary and the imaginary part is

perpendicular to the real part (within 1◦) then an envelope will be drawn automatically

emphasizing the rotation plane of the spin.

The objects to be plotted can be chosen from the Settings menu together with the quality

and resolution of the objects. The coordinate axes can be plotted in the lower-left corner

instead of the colored unit cell axes. Also, a smart legend can be added in the upper-left

corner, which will automatically adjust the legend entries depending on repeated elements

with the same appearance (such sites will automatically be numbered, e.g O1, O2, O3...).

Furthermore, multiple unit cell edges can optionally be plotted as well as multicolored

atoms representing the respective occupation of shared sites. Furthermore, Mag2Pol

features antialiasing by using multisampling per pixel and the objects’ distance to the

viewer is calculated for each view which allows for a correct back-to-front rendering of

transparent objects. Those features massively increase the quality of the rendered pic-

ture. The OpenGL objects have been designed in order to minimize the calls to the

frame buffer, for which the improved graphics don’t come alongside with slower perfor-

mance.

Via File → Export the crystal/magnetic structure plot can be exported into a *.png

file or into a binary GL Transmission Format *.glb file for further use in PowerPoint

presentations or in 3D rendering programs like Blender. When creating a *.png file, an

input dialog will open up in which the zoom factor can be entered. This factor is propor-

tional to the image size and quality. Upon export of a 3D model, three dialogs will pop

up which serve to modify the object material with respect to its basis color, metallicity

and roughness.

2.4 Atom and spin info

Once a (magnetic) structure is drawn in the OpenGL widget the user can visualize atomic

positions, magnetic moment values, bond distances, angles between 3 atoms and angles

between two spins. In order to get information concerning the position of an atom or

the Fourier components of a magnetic moment, just click on the atom (sphere) or on

the cone of the spin, respectively. The information will be shown in the status bar of

the main window, the object will be drawn with a different lighting/material (depending

10



2.5 Bonds and polyhedra

on the rendering settings, see Sec. 3.1.5 and highlighted in the respective atom or spin

table. After highlighting an atom or spin in that way, its components can be inverted by

pressing Alt+I, or individual components can be flipped by using Alt+X, Alt+Y or

Alt+Z. Atom and spin info can alternatively be shown, when the atom or spin label in

the respective table is clicked, which will also highlight the object in the unit cell plot.

In order to get distances between 2 atoms click the first atom and then Shift-click a second

one, which will show the distance in the status bar and will draw the bond between those

2 atoms. The same procedure has to be done to get the angle between 2 spins. For the

angle made up by 3 atoms simply Shift-click the 3 atoms. Note that you can rotate the

perspective in between Shift-clicks if necessary.

Figure 2.2: Geometry options in Mag2Pol.

2.5 Bonds and polyhedra

Mag2Pol features the plotting of bonds and polyhedra. After a structure has been

generated this can be done via the Generate→Bonds menu or the toolbar icon. A control

window will open up, which is shown in the upper part of Fig. 3.1. Here the number of

bond types to search and generate can be entered which creates the according number of

rows in the Bonds and Polyhedra tables. The center (atom1) and ligand (atom2) atoms

can be chosen from the combo boxes. Note that the content of these boxes is a list of
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elements followed by the list of sites. In the example shown in Fig. 3.1, the structure

contains two Co sites, so in order to plot all possible Co-O bonds, irrespective of the

specific site, the elements have been chosen from the first (element) list. A number of

parameters can be adjusted in order to control the bond distances and the appearance

of the rendered objects. The meaning of these parameters are explained when hovering

the mouse over the horizontal header items. Note that the minimal distance between the

center atom and the polyhedron faces should be increased, if the resulting polyhedra look

unexpected. This can be the case for heavily distorted polyhedra. The information about

bonds created in the OpenGL widget can be retrieved by clicking on the center of the

bond. This will show the two connected atoms, their positions and the bond length in the

status bar of the window.

The parameters for the bond search as well as for the appearances of bonds and polyhedra

are saved in the *.xml file.

2.6 Rigid bodies

Rigid bodies can be used when the relative position of a group of atoms is known and

the deformation of the rigid body is zero or negligible, e.g. when a molecule occupies a

specific Wyckoff position. Before using a rigid body by placing it in the atom table of the

main window, the Rigid body window (Fig. 2.4) has to be used in order to construct one

or several rigid body models.

2.6.1 Creating a rigid body model

When the Rigid body window is first entered, one has to click the New button which will

create a new model labeled Rigid body 1. The name of the model can be changed by

modifying the Label line edit. The next step is to define the number of atoms, which can

of course also be done step-wise during the process of construction. The atoms and spin

tables are where the rigid body information will be entered and the result is automatically

visualized to the right-hand side of the window (the visualization options are the same

as for the unit cell in the main window). The rigid body models are created using the

Z-matrix, where each line gives the internal coordinates for one of the atoms within the

molecule. The first atom is the center of the rigid body and any further atoms have

specific relations to the previously defined ones. An atom is created in the same way

as explained in Sec. 2.2 including the possibility to create magnetic atoms (note that in

addition to choose between Cartesian and spherical coordinates by right-clicking the Spin

header of the spin table it is also possible to choose between local and cell reference).

Note that the center can be displaced by using the offset values ∆x, ∆y and ∆z. The
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2.6 Rigid bodies

Figure 2.3: Bonds and polyhedra plotting in Mag2Pol.
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orientation of the rigid body, given by the local orthogonal reference xyz is given by the

three angles θ (angle between the z and the unit cell’s c axis, measured towards the positive

a axis), ϕ (counterclockwise rotation around the c axis when viewed from above) and χ

(counterclockwise rotation around the z axis when viewed along −z). The second atom

is given by a bond distance in relation to the first atom: ref1 is A1. The third atom

(and any atom onwards) has a choice for ref1 and can be set to any of the previously

defined atomes. Additionally, it needs a bond angle which is formed between ref1, ref2

and the new atom. Starting from the fourth atom the dihedral angle has to be entered

which defines the angle between the two half planes containing ref1, ref2, ref3 and ref2,

ref3 and the new atom, respectively. Bonds are automatically created between the newly

entered atom and the ref1 atom, where the bond style can be customized as in Sec. 2.5.

Note that dummy atoms can be used, which can be advantageous for creating specific

molecule geometries. A dummy atom has the label X and will not be taken into account

for structure factor calculations. Depending on the geometry of the created rigid body it

might be necessary - for the sake of visualization - to create additional bonds, which can

be done at the bottom of the window by increasing the number of additional bonds and

defining it between two atoms (numbered as in the atoms table).

Further rigid bodies can be defined by clicking the New button and it can be switched

between them using the combo box. A right-click on the rigid-body label evokes a context

menu showing a small library of molecules which can be used as a starting point or for

understanding the Z-matrix formalism.

2.6.2 Boundaries and constraints

Boundaries and constraints can be defined in order to provide a more robust structural

model in the refinement process. Constraints are especially useful in order to maintain a

specific molecule symmetry and thereby reduce the number of refinable parameters. Both

features refer to the bond distance, the bond angle and the dihedral angle (depending on

the number of the atom) and can be accessed by right-clicking the label of an atom which

opens a context menu allowing to choose either Set boundaries or Constrain. The default

boundaries are 0 and 10 Å for the bond distance, 0 and 180◦ for the bond angle and -180

and 180◦ for the dihedral angle, and a click on Clear boundaries restores these values.

The bond distance and angle as well as dihedral angle of an atom can be constrained to

any of the atoms above in the list. While the bond distance and angle are defined to be

positive, the dihedral angle can also be constrained to be -1 times the reference value. In

the spin table the constraints are also set by right-clicking the magnetic moment label

and by choosing from a list of options (whole moment, module, real/imaginary part only

etc.). Constrained values will be grayed out in the atom and spin tables and automatically
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2.6 Rigid bodies

updated when the reference value is changed.

2.6.3 Model vs. instance vs. fit instance

All models created in the Rigid body window can be used in the main window and they

will also be saved to the project xml file. Regardless of the label chosen for a particular

rigid body model, the symbol to be used in the atoms tab corresponds to the position

of the rigid body model in the list, i.e. the first one will be identified as R1, the second

one as R2 and so on. The fractional x, y and z positions define the position of the

rigid body center to which the eventually defined offset will be added. The (an)isotropic

temperature factor applies to all atoms of the rigid body. Special attention needs to

be paid to the occupation factor. While for conventional atomic position the occupation

defines the actual occupation of this Wyckoff site (1 for a fully occupied site, 0.5 for a half-

occupied site), rigid bodies will be - depending on the space group and on the Wyckoff site

symmetry - generated on top of each other, no matter if the rigid body symmetry matches

the Wyckoff site symmetry or not. As an example: a benzene molecule has a main C6 axis

which would fit, for example, perfectly fit on the site 6.. symmetry of Wyckoff position 1a

in space group P6. Nevertheless, the molecule will be generated six times, rotated by 60◦,

which is not visible in the unit cell plot, but can be easily seen by activating the Dummy

atom as rigid body in the settings and by verifying the atomic positions in the Sample info

window. Therefore, in such a case the user is responsible to enter the correct occupation

factor, i.e. for a fully occupied 1a site in the present example the occupation factor would

be 1/6. This also applies to molecules whose symmetry is lower than the site symmetry

of the Wyckoff position they are placed on. In that case, multiple molecules will be seen

at the same position and the occupation factor has to be adjusted accordingly.

By using a rigid body model in the atom table a new instance will be created, which is

a one-to-one copy of the model. In the instance, the molecule geometry can be changed

within the constraints and boundaries defined by the model. In order to do so, right-click

on any of the x, y or z value of the rigid body in the atom list and choose edit rigid body

from the pop-up menu. This will open the Rigid body window in the instance mode, where

the unconstrained values can be changed, but the constraints and boundaries as well as

the offsets and all appearances (atom colors, bond styles, etc.) are fixed. In addition, the

orientation of the rigid body can be set (note that a quick way to set the orientation is

to choose set orientation from the pop-up menu mentioned previously). If the geometry,

constraints or boundaries are changed in the rigid body model, all instances used in the

structure model will be updated. The individual atom parameters can also be changed

from within the fit window (by either right-clicking the positional parameters, or - in the

case that the nuclear structure is not refined - by right-clicking the magnetic moment
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parameters). In addition, each of those parameters will have a check box to signal it as

a refined parameter. Fit flags can also be conveniently set by choosing Fit flags from the

pop-up menu.

Figure 2.4: Rigid body window for the construction of rigid bodies.

2.7 Saving and loading input files

All parameters which have been entered or modified can be saved into an input control

file in xml format from the menu entry File→Save/Save as. Additional information con-

cerning scale and extinction factors, magnetic domains, fit parameters and constraints,

user-defined magnetic form factors, powder patterns, plot parameters like the cell range,

the perspective and the zoom are saved as well. Note that if a magnetic (super) space

group is used after having calculated irreducible representations, the latter will not be

saved in the xml file. The respective parameters will be explained in Sec. 3. Saved input

files can be loaded via File→Load. The Mag2Pol main window can also be reset by

File→Reset.

Crystal and magnetic structures can also be exported in *.cif or *.mcif format. When

the propagation vector is 0, the magnetic symmetry will be exported either using the

user-defined magnetic symmetry operators or that given by an irreducible representation.

Note that only 1-dimensional irreps can be exported and that for mixed representations

only the first will be considered. For non-zero propagation vectors the magnetic moments
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(real vectors) will be calculated for all atomic sites and the structure will be exported in

P1 symmetry.

2.8 Calculation of structure factors and polarization matrices

Besides the correct description of a magnetic structure, Mag2Pol needs information

concerning the experimental geometry in order to calculate the nuclear/magnetic struc-

ture factors and the polarization matrices. Herefore, the wavelength should be given in

Ångströms, which already allows the calculation of structure factors. The calculation of

the polarization matrix depends on the orientation of the sample, which can be given

either by defining the vertical sample axis (reciprocal lattice vector) or by supplying the

orientation matrix of the experiment in the menu Geometry→Orientation matrix. In the

latter case the instrument angles are automatically calculated and shown in the respective

boxes. For the 4-circle geometry a ψ value can be given, which is the rotation angle around

the scattering vector, where ψ = 0 refers to bisecting geometry. From any given angles

the corresponding (hkl) indices can be calculated by right-clicking any angle value and

selecting calculate hkl.

Note that that the flipping ratio geometry requires the use of the vertical axis (not Cry-

ocradle). The vertical axis will automatically be calculated and set after setting the

normal-beam orientation matrix. Since in a flipping ratio experiment one usually assumes

the magnetic moments to be aligned parallel to the vertical direction (magnetic field di-

rection) one can align the moments automatically by right-clicking the label z axis and

choosing set moments parallel. If the UB matrix is not given the program will calculate

the moment direction from the values given for the vertical axis. Note that the uvw com-

ponents of the magnetic moments will have to be constrained in a refinement. Another

option is to use user-defined basis vectors before aligning the moments vertically, which

requires the refinement of only one parameter.

With Mag2Pol it is possible to calculate flipping ratios due to Schwinger scattering [11–

14], which is automatically done in the absence of magnetic ions in the unit cell (e.g. use

Fe2 instead of MFe2). Note that the polarization axis of the neutrons is taken to be parallel

to ki × kf .

The calculations are done for the Bragg reflection (hkl)±q entered by the user by pressing

Go! (see also this demo video). If the propagation vector is 0, there is no difference

concerning the combo box. When more than one propagation vector was entered in the

Domain window (see Sec. 3.4), they will all be shown in this combo box and by selecting

e.g. (hkl)-q2 the program will automatically check if a contribution from another config-

uration domain is present at the Q position.

If the checkbox show is activated, the local coordination system (see Sec. 7) and the mag-
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netic interaction vector M⊥ are drawn.

The results of the calculation are shown in the output text window (orange box in Fig. 2.1)

and the individual polarization matrix entries are shown in their respective boxes in the

Geometry section of the window (blue box in Fig. 2.1).

Whole lists of reflections can be generated under Generate→Reflection list for given crite-

ria like hkl range, intensity, polarization and diffractometer angles. This can be useful as

a preparation for an experiment e.g. by selecting those magnetic reflections which show a

large chiral component in the Pyx term. The reflections which fullfil the given criteria are

shown in a table after clicking Create hkl list. By right-clicking on a respective horizontal

header the list can be ordered according to that parameter, either ascending or descending.

The reflection list can be saved in ASCII format which is directly readable by MAD or

NOMAD due to the comments marked by ’ !’.
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In addition to simple calculations as shown in the previous section, scale/extinction pa-

rameters and magnetic domains can be defined, which obviously affect the observed inten-

sities and polarization values. In case of a crystallographic site being shared by multiple

magnetic ions, user-defined magnetic form factors can be created, plotted and saved.

3.1 Global settings

The global settings of the application can be evoked from the Settings or Preferences menu

(depending on the platform).

3.1.1 General

General parameters concerning the application, the instrument, symmetry and the view

can be found in the General tab. Most of the settings are self-explaining, however, a short

notice on the use of p0 and the cell efficiency is necessary. The sign of p0 depends on the

instrument’s neutron beam polarization and is positive (negative) if the neutron beam is

polarized up (down). While in the fitting procedure the cell efficiency is always taken as

a positive value, the use of a negative value in the settings only effects single calculations

of polarization matrices in the main window, where the sign of the cell efficiency defines

the direction of the analysis vector. Therefore different combinations ++, +−, −+ and

−− can be calculated, while when analyzing data, this information is extracted from the

data file. Note that the theme colors and the dark mode can also be set via the shortcuts

Alt + 1 to Alt + 8 from within the main window.

In the Symmetry section, the option Check special atomic positions assures that the user

does not define an atomic position (by mistake) which is too close to a special Wyckoff

position. If after generation of the unit cell, atoms of the same site reveal a distance

shorter than the one defined under Shortest allowed distance, the program will show a

warning. The option Constrain lattice parameters in powder fit will automatically add

constraints concerning the lattice parameters during Rietveld refinement depending on

the space group. The setting Constrain propagation vector in powder fit constrains e.g.

qy = qx for a tetragonal, trigonal (hexagonal setting) or hexagonal space group or e.g.

qz = qy = qx for a cubic or trigonal (rhombohedral setting) space group. Note that
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when using a space group or magnetic (super) space group with a lattice system of lower

symmetry, it is still possible to maintain the original constraints of the parent structure

by right-clicking on the Cell or Propagation vector q label and then clicking override in

the symmetry menu. Afterwards, the lattice system can be chosen by evoking the context

menu once more.

The setting Extract observed FM using model refers to flipping ratio data, where the

magnetic structure factor FM is extracted from the observed flipping ratio R by solving

an equation of order 2. If this option is checked, the solution being closer to the calculated

FM value (based on the underlying magnetic structure model) will be selected. Otherwise,

the solution with smaller |γ| will be chosen, where γ = FM/FN (as in SORGAM from the

CCSL).

3.1.2 Refinement

Under the Refinement tab different least-squares fit parameters can be set. The con-

vergence criterium is defined as the maximum parameter shift divided by its standard

deviation. The range in multiples of the peak FWHM can be defined for which the peak

profile will be calculated in a powder pattern. When the Calculate pattern in excluded

regions option is disabled, only the peak positions will be calculated and shown, but no

intensities will be calculated. This can be a convenient choice for low-symmetry struc-

tures with hundreds (thousands) of reflections in the high-Q region of the powder pattern.

The setting Ignore secondary phases for single crystal should be unchecked when those

secondary phases are only present in a powder diffraction pattern. It should be checked

when two nuclear and/or magnetic phases are actually present in the single-crystal sample

and contribute to the same reflections.

Usually, the magnetic form factor is refined against flipping ratio data, but if a refinement

against integrated intensity data is desired, then the Refine magnetic form factor with INT

data should be checked which enables the necessary tabs in the fit window. The option

Automatically constrain split sites is useful for atoms sharing the same site and sets rea-

sonable constraints when entering the fit window for the first time (position, temperature

factor, split occupation, magnetic parameters).

3.1.3 Plot

All settings concerning the unit cell plot in the OpenGL widget can be found under the

Plot tab. Here the objects to be rendered can be chosen as well as the mouse sensitivity

for zooming and rotating the plot. Note that a right-click on the Spins, cone radius label

opens up a context menu that allows to restore the default values for the spin vector

geometry.
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The powder pattern plot in the (batch) fit window can be fully customized regarding the

marker, line and plot background colors (a click on Reset restores the default values). In

addition, the color gradient of 2D maps can be defined here. Note that in the intensity

maps and magnetization density maps windows, the shortcuts Alt + +, Alt + - and

Alt + I can be used to cycle through the different gradients and to invert the color scale,

respectively.

3.1.4 Labels

Under the Labels tab the position, scale and font size of the coordinate axes and legend

can be customized. It is also possible to enter individual translation values for the axes

labels. These settings are also saved in the *.xml file.

3.1.5 Render

In the Lighting and material section different profiles can be defined in which the lighting

and material properties of (un)selected objects in the unit cell plot can be modified with

respect to their ambient, diffuse and specular values. A click on the light color tool button

opens the color selection dialog, while the horizontal slider next to it increases/decreases

the 3 RGB values simultaneously, e.g. to quickly move between black and white over

different gray tones. The shininess can also be defined for selected and unselected objects.

These settings can be saved into different profiles. Four built-in profiles are included in

Mag2Pol and can be recovered by clicking Reset all.

Several options exist to adjust the rendering quality which affect the fluidity with which

you can manipulate the drawing. The level of multisampling can be set by the number

of samples per pixel, which affects the rendering of edges (smoother edges for increasing

multisamples). The object resolution is a measure of the number of vertices which are

calculated for the creation of an object. The minimum number is 3 and corresponds to a

triangle in comparison to a circle with higher resolution.

Crystal and magnetic structures can be visualized with a depth effect, like fading or blur-

ring, and the customizable factor regulates the intensity of this effect. For the blur effect

a pixel-by-pixel post-processing step is necessary, which can be slow depending on the

computing power. It is therefore recommended to use a low Quality setting for a fluid

movement of the drawing and eventually a higher setting for the export to file. The focus

for the blur effect can be modified by holding down the Opt/Alt key while zooming.

In order to correctly render transparent objects, when they are aligned one behind the

other, the order is crucial. Since the perspective is constantly changed by the user, the

order of the transparent objects is automatically recalculated on-the-fly. For a large num-

ber of transparent object this means a lot of calculation cost, of course. Therefore, the
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threshold for continuous reordering can be adjusted, the default value being 1000 objects,

e.g. 100 octahedra (each containing 8 transparent planes) and 200 spin envelopes. Above

this threshold, the order will only be recalculated when the mouse button is released after

dragging the perspective. In order to avoid too long calculation times when a very large

supercell with a lot of transparent objects is plotted, the automatic reordering can be

turned off with the second threshold value (default is 5000).

Figure 3.1: Global settings in Mag2Pol.

3.2 Scale factor and λ/2 contamination

The scale factor and the fraction of λ/2 contamination can be set via the menu entry

Structure→Scale factor. The scale factor is multiplied to the calculated intensities of

Bragg reflections in order to be compared with the observed ones. If the λ/2 contribu-

tion is greater than 0, the calculation of nuclear and magnetic structure factors as well

as flipping ratios and polarization matrices of a reflection (hkl) will include the higher-

order contamination of (2h 2k 2l) by λ/2. For a zero propagation vector the nuclear

and magnetic intensities will have their respective higher-order contamination, whereas

for an incommensurate propagation vector, no λ/2 contribution will be calculated. For

half-indexed propagation vectors, the lambda/2 contamination of nuclear nature is added

to the magnetic intensity of (hkl). Note that this contamination is not calculated, when

purely magnetic is chosen in the fitting procedure.

3.3 Extinction

The extinction parameters can be set via the menu entry Structure→Extinction. The

extinction parameters xij build up the tensor x which allows the treatment according to
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an empirical model which represents a compromise to treat both primary and secondary

extinction. It is also implemented in FullProf [15] and in ShelX [16] and has shown to

work well in practice. The extinction correction is given by

y =

(
1 +

pxanisoF
2
c λ

3

4 sin(2θ)(sin θ/λ)2

)− 1
2

where xaniso is the anisotropic extinction parameter and Fc is the calculated structure

factor. p is 1e−3 for neutrons and 1e−6 for x-rays. xaniso is obtained by operating the

tensor x subsequently on the scattering vector (hkl):

xaniso =
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The isotropic version of this model only requires a single parameter x and the extinction

is corrected according to

y =

(
1 +

pxF 2
c λ

3

sin(2θ)

)− 1
2

A more physical model based on the highly oversimplified concept of an ideally imper-

fect crystal takes into account the size of structural domains and the mosaicity and was

developed by P. J. Becker and P. Coppens [17–19]. The same implementation as in the

CCSL and FullProf is featured in Mag2Pol and corrects secondary extinction effects

by

ys =

(
1 + 2xs +

Asx
2
s

1 +Bsxs

)− 1
2

,

where xs is given by

xs =
2

3
QαT̄ · 1e3

with T̄ being the mean beam path length given in mm and

Q =
F 2
c λ

3

V 2 sin(2θ)

with the sample volume V in mm3 and the wavelength λ in Å. The coefficients As, Bs

and α depend on the mosaicity distribution which can be assumed to be Lorentzian (L)

or Gaussian (G):

As,L = 0.025 + 0.285 · cos(2θ)

Bs,L =

−0.45 · cos(2θ), for 2θ ≥ 90

0.15− 0.2 · [0.75− cos(2θ)]2, for 2θ < 90
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αL = ᾱ

(
1 +

2ᾱ

3ωD

)−1

As,G = 0.58 + 0.48 · cos(2θ) + 0.24 · cos2(2θ)

Bs,G = 0.02− 0.025 · cos(2θ)

αG = ᾱ

(
1 +

ᾱ2

2ω2
D

)− 1
2

Finally, ᾱ is given by

ᾱ =
3

2
rD sin(2θ)/λ

where the domain radius rD (in nm) and the mosaicity distribution ωD (in inverse radians)

are refinable parameters. Note that - due to the dependence on the sample shape - this

model can only be chosen after designing a convex-hull model of the single crystal (see

Sec. 4.2.2). In that case, the beam path lengths are calculated for each (hkl) reflection and,

therefore, this model should be used on a data set without averaging equivalent reflections.

Mag2Pol offers the possibility to create a corrected data set after refining a structural

model with Becker-Coppens extinction correction in which the intensities are corrected

by y. The corrected data set (which is also corrected for eventual λ/2 contamination

and absorption effects, see also Sec. 4.2.3) can then be merged and re-analyzed without

extinction correction.

3.4 Domains and twins

An unlimited number of magnetic domains and structural twins can simply be added via

the menu Structure→Domains and twins (see demo video). The program differentiates

between S-domains and k-domains, see [20] for a review. For k-domains at least two

propagation vectors have to be set to which the magnetic domains (see below) can be

attributed.

For magnetic domains, first the number of different domains has to be set, which automat-

ically applies an even population between the domains. Then, the symmetry operators

(usually the ones from the paramagnetic space group which have been lost in the magnetic

phase transition) have to be entered using the combo boxes. This can also be done using

the smart copy-paste feature, i.e. copy the text corresponding to a symmetry operator

(e.g. in the Irreducible representations or Space group tables windows) and past it by

right-clicking the vertical header number (starting at the second row, since the first is al-

ways the identity). In addition, check boxes can be activated to define inversion or chiral

domains. The first simply reverses every magnetic moment, whereas the latter takes the

complex conjugate but keeps the phase shift of the user-given Fourier components describ-

ing the magnetic structure. If a symmetry operation is not included in the little group, i.e.
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3.4 Domains and twins

it transforms +q into −q, the program calculates the complex-conjugate and inverts the

phase. That means that if a magnetic structure breaks inversion symmetry and therefore

two magnetic domains are related by the inversion center, the chiral checkbox should not

be checked. When only one propagation vector is present, then all magnetic domains are

considered as S-domains. When more than one propagation vector is entered, then each

of the magnetic domains can be attributed to a specific k-domain by choosing the arm of

the propagation vector star through the combo box with q1, q2, etc.

Structural twins are set up in the same way, however, in this case the matrix relating the

(hkl) reflections of the different twins has to be given. For the calculation of structure

factors those rotations matrices will be multiplied to the observed (hkl) values and if the

result corresponds to integer indices (± the propagation vector) it will be considered as a

contribution from another twin. Note that in the presence of multiple magnetic domains

it is possible to reorder their sequence for each structural twin, which can be necessary

in order to retrieve the same kind of domain in each twin for some particular cases. The

sequence is simply entered by typing n integer numbers from 1 to n (with n being the num-

ber of magnetic domains defined), e.g. 4 2 3 1, when 4 magnetic domains are present.

The structural twins and their relation to another can be visualized in the Twin Q-space

viewer by clicking on the icon on the right of the tolerance value. A new window opens

which is divided into two parts separated by a horizontal splitter: on the left a 3D plot

of each twin’s reciprocal lattice and on the right side several plot options for each of the

previously defined twins. The options apply to the twin that is selected at the top.

In the Orientation section the matrix relating the twins’ (hkl) is repeated and is further

expressed as the rotation axis and angle around the direct/reciprocal axis of the 1st twin

from which the reciprocal lattice of the nth twin is obtained. Here, both the matrix and

the rotation axis/angle are synchronized, i.e. one is always recalculated from the other

when any value is modified.

Under the Plot settings it can be specified for each twin, if the reciprocal lattice edges and

points are shown and in which color or size. Nuclear reflections are represented by spheres,

whereas magnetic reflections are depicted by cubes. The beyond tolerance appearance is

used for reciprocal lattice points of twins different from the selected twin that would not

be measured using the selected twin’s reciprocal lattice (plus and minus the propagation

vector). This is a very useful visual feedback in order to define the tolerance value in

accordance with the observed reflections. It can further be selected, if forbidden, nuclear

or magnetic reflections should be hidden in the plot.

The reciprocal lattice points of nuclear and magnetic origin can be clicked and selected in

the 3D plot, which shows their respective (hkl) values in the status bar and also in the

Output section. If the colored checkbox is actived, the output is given using the colors as

shown in the plot legend. It is further possible to carry out structure factor calculations
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of a given (hkl) Bragg peak (in the reference of the 1st twin) by entering the respective

values of the scattering vector Q and clicking on Go!.

Figure 3.2: Twin Q-space viewer showing the reciprocal lattices of three structural twins.

3.5 X-ray and magnetic form factors

3.5.1 Built-in form factors

In the present version of Mag2Pol the scattering length, absorption cross section, inco-

herent cross section and X-ray form factor of all elements and the magnetic form factors of

the 3d, 4d and actinide ions are implemented. The latter are described by the analytical

expression

fM (Q) = A exp(−as2) +B exp(−bs2) + C exp(−cs2) +D (3.1)

with s = sin(θ)/λ. The magnetic form factors marked with the letter M (e.g. MCo2 for

Co2+) consist of only spherical Bessel functions ⟨j0⟩. For the rare-earth elements addi-

tional magnetic form factors are implemented which are marked with the letter J (e.g.

JHo3 for Ho3+) which approximate ⟨j0⟩+ c2⟨j2⟩.
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3.5 X-ray and magnetic form factors

The atomic or X-ray form factor is given by

f(Q) =
4∑

i=1

ai exp(−bis2) + c (3.2)

The form factor is then corrected for anomalous dispersion which modifies it to

f(Q) = f0 + f ′ + if ′′ (3.3)

where the real and imaginary part of the anomalous dispersion f ′ and f ′′ are stored

wavelength-dependent in Mag2Pol. The complete list of built-in scattering lengths and

(magnetic) form factors can be accessed under Form factors→View list (see this demo

video). The list can be ordered either by element name, by atomic number or alphabet-

ically by right-clicking on the combo box and selecting the appropriate menu entry. By

selecting an element from the combo box the scattering lengths, cross sections and the

(magnetic) form factor coefficients will be displayed as well as a plot of the x-ray and

magnetic form factor as a function of sin(θ)/λ. Multiple form factors can be plotted by

clicking Keep before selecting another element (see Fig. 3.3). Parts of the plot can be

zoomed in by the usual controls of clicking and dragging, while the original view is reset

by a right click. The plot can be cleared by clicking Clear.

3.5.2 User-defined form factors

In some cases it is desirable to use a custom magnetic form factor, e.g. if the magnetic

form factor under question is not tabulated or if one crystallographic site is shared by

different magnetic ions. In this case Mag2Pol offers a simple method to add user-defined

magnetic form factors which can then be saved in the input control file. In order to

add (or delete) custom magnetic form factors, open the respective window under Form

factors→Manage user-defined (or the corresponding toolbar icon), where you will find

two tabs for the respective actions. Under Add either enter the form factor coefficients

and the scattering length manually or type in a linear combination of built-in magnetic

form factors. The number of elements is unlimited, however, the weights have to sum

to 1. Interstitial sites can be handled through the occupation factor in the main win-

dow. Fig. 3.4 shows an example of a compound in which Co and Fe ions in bi- and

trivalent oxidation state share the same crystallographic site. The corresponding input is

0.19*MCo2+0.27*MCo3+0.31*MFe2+0.23*MFe3, which is case-independent. A correct en-

try, i.e. the sum of weights is 1 and the (magnetic) ions have been recognized, is signalled

by green text (red otherwise). Note that you can only mix either only magnetic or only

non-magnetic ions. Instantly, the weighted magnetic and atomic form factor coefficients

and scattering length will be displayed as well as the plot of the form factors as a func-

tion of sin(θ)/λ. In order to save the new element a symbol has to be given. Any name
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Figure 3.3: Example of the comparison of multiple form factors.

Figure 3.4: Example of a user-defined magnetic form factor.
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(different from any built-in element) can be used for the new element. Upon clicking Save

a pop-up window will inform the user, if the new element has been saved as magnetic or

non-magnetic ion.

Built-in form factors can be viewed in the complete list as well as under the Delete tab.

In the latter you can remove the selected one by clicking the button Delete.

3.6 User-defined basis vectors

For magnetic structures with higher symmetries it may be of advantage to use symmetry-

adapted basis vectors instead of manually putting constraints between the individual com-

ponents before refining the structure. Therefore, under Structure→Basis vectors up to 6

basis vectors can be defined (see Fig. 3.5). Once the use basis vectors check box is acti-

vated Mag2Pol will interpret the values under the Magnetic structure tab as well as in

the Fitting window as coefficients to be multiplied to the basis vectors. This is signalled

by the label <- BVs -> between the first and last 3 basis vector coefficients. Note that

symmetry-adapted basis vectors can be deduced with the Irreducible Representation tool

which is described in Sec. 6.4.

Figure 3.5: Example of a user-defined basis vectors.
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3.7 Mixed irreducible representations

Two one-dimensional representations can be combined to a two-dimensional one. This can

be achieved by setting the number of representations to 2 under the Symmetry tab of the

main window. This will duplicate the symmetry operations where the first half corresponds

to representation 1 and the second half to representation 2. The nuclear symmetry can

obviously not be changed, however, the magnetic symmetry should be set by adjusting the

(uvw) combo boxes according to the individual representations. Under the tab Magnetic

structure you can now attribute the individual real and imaginary parts of the Fourier

components to a respective representation by right-clicking on its value, which will open

a context menu. Here you can select either irrep1 or irrep2 as shown in Fig. 3.6 (if the

magnetic moments are described by spherical coordinates, the attribution still concerns

the x, y and z directions of the Fourier components, for example: the context menu

on the value Rθ applies to Ry in Cartesian coordinates). Note that symmetry-adapted

basis vectors of the irreducible representations can also be mixed using the Irreducible

Representation tool (see Sec. 6.4).

Figure 3.6: By right-clicking on the value of the Fourier component it can be defined

according to which irreducible representation it transforms.

3.8 Magnetic form factor models

When defining a magnetic ion the default magnetic form factor corresponds to a spherical

magnetization density which is expressed by the radial integral ⟨j0⟩. Further magnetic

form factor models can be chosen for each magnetic ion individually by entering the Form

factor models window via Form factors→Form factor models (or its toolbar icon). Note

that those parameters (not belonging to the default model) can be refined in the fitting

procedure by activating the Refine magnetic form factor checkbox when the refinement

is done on flipping ratios. When integrated intensities are analyzed the checkbox Refine

magnetic form factor with INT data should be activated in the settings.
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3.8.1 Sum of radial integrals

This model still yields a spherical magnetization density and the magnetic form factor is

given by

fM (Q) = ⟨j0⟩+ w2 · ⟨j2⟩+ w4 · ⟨j4⟩+ w6 · ⟨j6⟩ (3.4)

with the ⟨jn⟩ being spherical Bessel functions and the wn refinable parameters. The

coefficients of the analytic approximation of the ⟨jn⟩ integrals are stored inside the program

and can be looked up in the form factors window (Form factors→View list). The analytical

approximation of the different spherical Bessel functions is given by

⟨j0⟩ = A exp(−as2) +B exp(−bs2) + C exp(−cs2) +D (3.5)

with s = sin(θ)/λ and

⟨jn⟩ =
(
A exp(−as2) +B exp(−bs2) + C exp(−cs2) +D

)
· s2 (3.6)

for n ̸= 0.

The resulting magnetic form factor is plotted together with the spherical ⟨j0⟩ in order

to point out the differences and can be exported as a PDF or ASCII file.

3.8.2 Multipole expansion

If the data allows for a more sophisticated description of the magnetic form factor, the

deviation of the magnetization density from the spherical symmetry can be achieved by

a linear combination of basis functions. In Mag2Pol those basis functions are the real

spherical harmonics which describe the angular dependence of the magnetization density.

The radial dependence is calculated according to a Slater-type function (see Sec. 7.4 for

a complete description). The description of each combination of multipoles is always in

relation to a orthogonal local reference system, where for θ = φ = χ = 0 the local x axis

is parallel to the unit cell’s a axis, y is within the a-b plane and z is perpendicular to a

and b. By selecting the multipole expansion for a particular magnetic ion the coefficients

of the different basis functions (multipoles) can be set together with the Slater-type func-

tion coefficients and the local reference angles for each magnetic ion. Non-magnetic ions,

e.g. O2− can in principle be treated by first creating a new magnetic ion as described in

Sec. 3.5.2 and then using that ion in the multipole expansion.

The respective ion to which the local reference and the multipole/Slater coefficients apply

can be chosen in the combobox. The tab widget then offers a clearly arranged represen-

tation of the coefficients Cm
l , the Slater exponent n and the parameter Z, diveded into
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monopole, dipoles, quadrupoles, octupoles and hexadecapoles. Note that the monopole

coefficient C0
0 represents the global magnetic moment of that ion and that the values in

the magnetic structure tab are ignored. As soon as a coefficient Cm
l is different from zero

the respective multipole can be plotted in the OpenGL widget (see Fig. 3.7, left panel).

When using many multipoles it can be difficult to see the individual ones clearly, so in

this case the tickboxes above the OpenGL widget can be used in order to only plot the

ones of interest. Clicking on color scale according to coefficients changes the color code in

dependence on the values of Cm
l . It is also possible to visualize the weighted sum of the

individual multipoles, which plots the angular dependence of the magnetization density

distribution (see Fig. 3.7, right panel). Since the magnetization density is non-spherical

the magnetic form factor in the right panel can now be plotted along a user-defined recip-

rocal lattice vector. It can also be chosen to show the amplitude, the real or the imaginary

part.

On clicking OK all parameters are saved for each atom. In the main window the (angular

dependence of the) magnetization density distribution around the ion can be visualized in

the unit cell, if the Multipoles and eventually the Local references check boxes are checked

in the Plot tab of the settings window. Note that the scale can be modified by the spin

and atom plot scales, respectively.

A demo video can be seen here.

Figure 3.7: Multipole window allowing to the set the coefficients of the multipole ex-

pansion of the magnetization density. Left: Visualization of the individual orbitals with

positive and negative lobes. Right: Weighted sum of the individual orbitals.
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3.9 Orientation matrix

Figure 3.8: Multipole expansion of the magnetization density for each magnetic ion in the

crystallographic unit cell (arbitrary population coefficients).

3.8.3 Orbital expansion

The relation between multipole population parameters and orbital occupancies can be gen-

eralized as shown in [21] for which the magnetization density distribution can be expressed

in a similar way as in the previous section, but by using well-defined orbitals centered at

the atomic position. The angular dependence can be chosen between 2p, 3d, 4f and a

hybridized sp orbital, while the options for the radial dependence are the tabulated ⟨jn⟩
values, a hydrogen-like orbital or a Slater-like orbital as in FullProf. Note that the

coefficients Cm
l are normalized before being converted to the multipole population param-

eters (see Sec. 7.5) for which a single non-zero coefficient does not have any effect in a

least-squares refinement.

3.9 Orientation matrix

As mentioned briefly in Sec. 2.8 the orientation matrix of a Cryocradle experiment is nec-

essary to calculate the sample orientation for each (hkl) reflection. In other geometries the

orientation matrix is necessary e.g. for calculating the absorption correction or the diffrac-

tometer angles. This UB matrix can either be entered manually or by using the smart

copy-paste feature (right-click on the UB matrix which offers to paste a single value, a

row, a column or the whole matrix depending on how many readable numerals have been

copied to the clipboard) in the window which opens by clicking Geometry→Orientation

matrix or by selecting Get UB in that window. Here the individual observations with
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their respective angle values after centering can be entered manually or a list of reflections

can be loaded by clicking Browse. The program reads *.dat files which are generated and

filled by the MAD centering commands on the instrument D3. The refinement of the UB

matrix is done according to the formalism presented by Busing and Levy and is based

on the conventions of the instrument given in the Geometry→Instrument menu, see next

section. The positioning of the sample with the Cryocradle setup does not correspond

to the bisecting geometry as for standard four-circle geometries due to the fact that the

angle ω is fixed. The positioning by using the angles χ and ϕ basically correspond to

a non-zero ψ value (ψ being the angle around the scattering vector, which is 0 in the

bisecting geometry). Fig. 3.9 shows the corresponding window for calculating and refining

an experimental UB matrix after the centered reflections have been read from a file.

Figure 3.9: The experimental orientation matrix can be calculated and refined from a

number of observed reflections.

The refinement is presently reserved for the lattice parameters only (by activating the re-

spective check boxes), i.e. the wavelength cannot be varied. The symmetrical constrains,

e.g. a = b and γ = 120◦ are automatically set and fixed from the space group. By clicking

the Refine button a least-square refinement will be started, where the initial orientation

matrix is calculated form the first two reflections in the list and then refined on all obser-

vations.

The results of the calculation/refinement are shown in the text field and consist of the

initially calculated UB matrix, a list of all observations and their observed and calculated
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angles, the refined UB matrix, the refined lattice constants including their respective stan-

dard deviations and the reduced χ2. By clicking OK the refined UB matrix will be passed

on to the previous window, which can than be saved by clicking OK on the latter.

Another possibility is to set the orientation matrix by choosing two vectors - either direct

or reciprocal - pointing along the positive z axis and the positive x axis of the instrument

(i.e. according to the definition of the instrument geometry), respectively. The corre-

sponding UB matrix will be calculated by clicking on Calc UB. If the given vectors are

not perpendicular (2-digit precision in reciprocal Å), the program will show a warning. It

is possible to add an offset on ω (rotation around the vertical axis), χ (rotation around

the beam axis for ω=0) and φ (rotation around the vertical axis for χ=0) which will au-

tomatically update the calculated UB matrix. Note that the rotation senses of the ω, χ

and φ angles also follow the definition of the actual instrument geometry.

If a crystal model has been setup in the Sample info window (under Absorption) (or in

the Data reductioni window), it will be shown in a 3D plot on the right-hand side of the

window (see Fig. 3.10). The usual OpenGL controls like rotating, zooming, panning and

changing the light direction (Alt + rotating) are available. The plottable objects can be

switched on/off using the checkboxes on top of the 3D plot, which can be exported to a

*.png file by clicking on the export button. Recalculating the UB matrix from the given

sample orientation (through the 2 definable vectors) or by moving the angle sliders will

update the sample orientation in real time.

Furthermore, it is possible to visualize the successive rotations of the sample when posi-

Figure 3.10: Orientation of the 3D sample model with respect to the Busing-Levy frame

(colord axes). The instrument geometry definition is taken into account for the visualiza-

tion.
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tioning it for a particular Bragg reflection. In addition, the scattering vector, the incoming

beam and the diffracted beam will be shown. This can only be achieved, when the UB

matrices between the main window and the UB window are synchronized, i.e. the UB

window was just opened without modifying the orientation matrix. Then, when calcu-

lating the angles and structure factors of a Bragg reflection Q in the main window, the

sample will be positioned in the 3D plot of the UB window. If one wishes to see the final

orientation only, the animate checkbox can be unchecked before clicking Go! in the main

window.

3.10 Instrument

All instrument angle calculations are based on the definitions given in theGeometry→Instrument

menu (Fig. 3.11). On the one hand it is necessary for calculating the vertical sample axes

for a given (hkl) reflection for polarization matrix calculations, on the other hand it is

needed by the absorption correction module in order to calculate the beam path lengths

in the sample (see Sec. 4.2).

Five ILL single-crystal diffractometers (D3, D9, D10, D19, D23) can be selected from the

combo box and their axes definitions, angle rotation senses and standard angle limits will

be automatically set. It is also possible to either change the definitions for another in-

strument or to choose a Custom instrument. The angle definitions are taken with respect

to the conventions of Busing & Levy [22], i.e. the incident beam is directed along the

positive y axis, z is the vertical axes and x completes the right-handed coordinate system.

E.g. the definition x: -x, y: +y, z: -z means that the x axis according to Busing &

Levy is actually the −x axis according to the instrument’s definition. In this example the

reference frame is rotated by 180 degrees around the y axis. In case the instrument axes

definition does not coincide with the Busing & Levy convention the instrument orientation

matrix is internally transformed before the calculation of the diffractometer angles. The

scattering geometry can be chosen between normal beam and 4 circle as well as Cryocradle

for D3. In 4-circle geometry the chi quadrant in which the instrument performs should

be given, but is automatically set to the standard value for the ILL diffractometers. The

calculated angles are converted back to the instrument’s convention with respect to the

rotation senses and whether the neutrons are diffracted to the left or to the right. The

diffraction direction is taken in the reference frame of the neutron, i.e. standing at the

source and looking towards the sample. The rotation sense of the angles θ, ω and ϕ (ϕ for

χ=0) are called clockwise or anticlockwise when viewed from the top. The sense of χ is

defined for ϕ=0 and looking towards the source. These definitions are shown as tooltips

when hovering the mouse above the respective combo boxes. The angle limits are used in

order to calculate the exact position of the sample in case the bisecting scattering geome-
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try cannot be achieved and/or another chi quadrant has to be tried. Note that the offsets

are not yet used.

Figure 3.11: Instrument axes and angles definitions used for the calculation for the sample

orientation at a particular (hkl) reflection.
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4 Fitting

The main purpose of Mag2Pol is the refinement of a nuclear and/or magnetic struc-

ture model to different kinds of data sets: spherical neutron polarimetry data, flipping

ratios, integrated intensities from a monochromatic single-crystal diffraction experiment

and powder diffraction patterns. Correlated refinements can be done in any combination

of the previously mentioned data types. After the structural data, the magnetic struc-

ture model, magnetic domains, scale factor and extinction parameters have been entered

and the unit cell has been successfully generated and visualized, one can proceed to the

refinement module by clicking Fit→Fit or the icon in the toolbar.

4.1 Loading raw data

The raw data are loaded in the Data tab using the respective buttons. In the present

version of Mag2Pol the accepted data types are

• D3 *.fli files containing the polarization values of the individual polarization matrix

entries and/or the flipping ratios

• D3 raw data Numors

• FullProf *.int files containing (a) integrated intensities of integer reflections plus

eventually a list of propagation vectors corresponding to +qn and −qn both constant

wavelength or time-of-flight (the latter is identified by λ = 0 and an additional

column for the wavelength of each hkl) or (b) flipping ratios together with the beam

polarization and the orientation matrix.

• *.col files as an output of a RACER integration [23] of two-dimensional detector

data

• *.fsq files as an output of a COLL5 integration of single-detector data

• *.sf files as an output of a CCSL program

• *.bra files as an output of a D19 large-detector integration

• powder data in different formats (see below)
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When data files have been successfully loaded a list will appear in the respective part of

the Data tab of the fit window. By right-clicking on a list entry the wavelength, source and

weight can be adjusted or the loaded data set can be deleted (note that the wavelength and

source of powder patterns can be entered in the respective tab, which will be explained in

Sec. 4.5). When loading *.fli files the program will detect if the data has been collected

in polarimetry or flipping ratio geometry of D3 and will modify the GUI accordingly (e.g.

enable/disable the spin-filter related information). In case of flipping ratio data the check-

box Refine magnetic form factor appears, which if set will add a corresponding tab to the

fit window. If flipping ratio data were loaded from a *.fli file the data reduction window

will open, which will be explained in more detail below for integrated intensity data. The

loaded data can be viewed by clicking on View data. Right-clicking on a vertical header

opens a context menu, which permits to delete a single reflection (Delete) or all reflections

of the same (hkl) values (Delete all). This is useful to remove nuclear reflections, which

have been measured to calibrate the efficiency of the 3He spin-filter cell, from a list of

polarization matrices (note that polarization matrices from spherical neutron polarimetry

data can be visualized in matrix form, both using numbers or colored dots, by clicking on

the Color plot button at the end of the data list, see Sec. 6.16). Activating the checkbox

Refine nuclear structure for any data type will add an Atoms tab containing the atomic

positions, isotropic temperature factors and occupation factors as well as the scale and

extinction factors. In the case of integrated intensities the checkbox Purely magnetic scat-

tering should be checked, if the loaded data was obtained from a subtraction of a nuclear

background.

When opening a *.col, *.fsq, *.sf, *.bra or a flipping ratio *.fli file a data re-

duction window will open (see Fig. 4.1), in which the user can merge the loaded data with

respect to a given space group (at the beginning the space group from the main window

is automatically set). The reflections will be shown regrouped and the Rint value will

be printed together with reflection statistics (unique, symmetry inequivalent, forbidden

reflections). The internal R value is calculated according to

Rint =

∑
n
In − Ī∑
n
In

(4.1)

and the sum is taken over all n reflections without previously averaging repeated obser-

vations. Forbidden reflections can be excluded from the calculation. The reflection list is

ordered by scattering angle by default, but it can be ordered with respect to h, k, l, I/R,

dI/dR or 2θ by right-clicking on the corresponding horizontal header and by choosing

either ascending or descending from the sort menu. A right-click on a column header to
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4.1 Loading raw data

the right of the individual (hkl) reflections allows to plot the data against 2θ, sin(θ)/λ

or d value. Hovering the mouse over the cell containing the integrated intensity or the

flipping ratio shows the corresponding Numor as a tooltip. A particular reflection can be

searched by opening a find dialog using the Ctrl/Cmd+Shift+F shortcut.

Among the equivalent reflections the weighted average of the observations yi is calculated

by

ȳ =

∑
i

1
σ2
i
yi∑

i

1
σ2
i

In the case of integrated intensities the error is given by the larger value between

σ̄1 =

√√√√ χ2∑
i

1
σ2
i

,

where

χ2 =
∑
i

(y − ȳ)2

σ2i
,

and the arithmetical mean over the N equivalents

σ̄2 =

∑
i
σi

N
.

When flipping ratios are averaged among equivalent reflections, the error is calculated in

a slightly different way (in Mag2Pol) and corresponds to the larger value between the

statistical error

σ̄S =

√√√√ 1∑
i

1
σ2
i

and the standard deviation reflecting the weighted distribution of the observations

σ̄D =

√√√√ χ2

(N − 1)
∑
i

1
σ2
i

.

Furthermore, the flipping ratio statistics include the counting time T and the aimed count-

ing time to achieve a certain error (aim value in %):

Taim = T ·

[(
100 · dR/|R− 1|

aim

)2

− 1

]
.

The aimed counting times are shown in color when the standard deviation is larger than the

statistical error and an improvement of statistics by repeated measurements is improbable.
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The (hkl) indices can by transformed by entering a transformation matrix and a pre-

cision setting (e.g. to round 5.998 to 6) in the upper-right part of the window and then

clicking Apply. Any further application of different transformation matrices will be applied

to the original indices and the applied changes can be reverted by clicking the correspond-

ing button.

The data can then be transfered to the fit window or be exported in a format corresponding

to a FullProf *.int file (this is also possible for flipping ratio data). Furthermore, for

integrated intensity data a second data set can be subtracted from the first one by click-

ing on Subtract dataset, which is useful for removing the nuclear contribution from q = 0

reflections. If the second data set lacks reflections which are present in the first data set,

there are two options: either ignore (delete) the corresponding reflection or treating the

missing reflection as I = 0. The latter can be convenient, if a low-temperature magnetic

data set contains (hkl) reflections which are forbidden and have not been measured in

the high-temperature nuclear data set. Note that before subtraction repeated reflections

within each dataset will be merged.

Figure 4.1: Data reduction window permitting to merge integrated intensities with respect

to a given space group.

From within the data reduction window an absorption correction of integrated intensities

can be applied for different sample shapes, see next chapter. Changing the wavelength

automatically re-calculates the absorption coefficient and the scattering angles.

The integrated intensity or flipping ratio data transferred from the data reduction window
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to the fit window as well as the data directly loaded from an *.int file will be shown as

a list in the Integrated intensities or in the Polarization data section, respectively. Note

that several data files can be loaded one after the other. A right-click on a data set offers

different options in a context menu, e.g. deleting or replacing the data set. The replace

option is useful if one wants to use the same structure including the scale factor for the

refinement of another data set. Note that deleting a data set also deletes its correspond-

ing scale factor. Other parameters which can be addressed from the context menu are

the source, the wavelength and the weight of the data set in the least-squares algorithm.

Polarization data sets have further options like the incident polarization, the sample ori-

entation and the spin-filter efficiency (the latter only for polarimetry data).

Before loading powder patterns the corresponding format of the file has to specified in the

drop-down menu. The different options are

• Mag2Pol format. It consists of a header with title, wavelengths, ratio and temper-

atures followed by the data in values of 2θ, counts and sigmas. Powder patterns in

other formats can be exported in this format by clicking on Save data after successful

opening.

• XYSIGMA corresponding to FullProf Ins = 10

• D1A, D2B corresponding to FullProf Ins = 6

• D1B, D20 corresponding to FullProf Ins = 3

• Free Format corresponding to FullProf Ins = 0

• DMC, HRPT corresponding to FullProf Ins = 8

• GSAS TOF corresponding to FullProf Ins = 12

• ISIS TOF corresponding to FullProf Ins = 14

When a wrong format was specified an error message will be shown, otherwise, after

successful opening a Patterns tab will appear in the tab widget in which the loaded data

can be viewed and analyzed (see Sec. 4.5). A successfully opened diffraction pattern of

any format can be exported into Mag2Pol format with *.m2p extension. The data is

stored in three columns - 2θ, counts and σ - and is preceded by a header containing

the lines TITLE, WAVE, TEMP, COMP (composition parameter x, e.g. in AxB1−x) and the

corresponding metadata. Further lines might be added in future versions while obviously

maintaining compatibility. A pattern is exported by selecting it in the table of loaded
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patterns and clicking Save data. Input dialogs will pop up in which the metadata can be

entered. As for integrated intensity data, a right click on the data set evokes a context

menu with the possibility to delete or replace the data set as well as to change the weight

in the least-squares algorithm.

4.2 Absorption correction

4.2.1 Simple sample shapes

An absorption correction can be applied for spherical sample shapes and cylindrical sam-

ple shapes with normal-beam geometry, which is based on [24]. The linear absorption

coefficient is automatically calculated based on the structure model and displayed in the

according box, but of course, one is free to enter whatever value. The calculation is done

according to:

µ =

∑
i
oi(σi,a · λ/1.798197 Å + σi,inc)

V
(4.2)

where the sum is done over the atoms i of the unit cell with volume V . oi is the occupa-

tion, σi,a is the absorption cross section (at λ = 1.798197 Å) and σi,inc is the incoherent

scattering cross section of atom i. The incoherent scattering cross section is wavelength

independent for most elements, with a notable exception being hydrogen for which it is

given by

σH,inc = 19.2 · λ+ 20.6 (4.3)

with λ given in Å resulting in σH,inc in barns [25].

After setting the radius of the sample in mm one only needs to click Apply to perform the

absorption correction. The internal R value will directly be recalculated. The corrected,

uncorrected and normalized uncorrected data can be verified under Compare. The button

Undo permits to remove the applied correction.

4.2.2 Special sample shape

Mag2Pol offers the possibility to index the bounding faces of a convex crystal shape

based on a sequence of picture frames which can be loaded into the program (note that a

crystal model can be set up blindly even without such frames, see hints below). This is

done within an interactive OpenGL widget, which can be opened by selecting the special

sample shape and clicking Set faces. When first opened the crystal model utility should

show a red crosshair on a white or black background (for dark mode off/on, respectively).

Depending on the platform (as seen for Linux and Windows) borders in a different color

can be present, which should be removed by right-clicking witin the widget and selecting

Adjust size (furthermore Linux and Windows machines display a wrong aspect ratio of
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the frames which is not a problem for the following treatment). The program assumes that

the picture frames are taken during a successive rotation of the sample around the φ axis

for 4-circle geometries or around the ω axis for normal-beam geometries. For the first, it

is necesssary to indicate the χ value at which the frames have been taken. Before opening

the picture files the lower and upper angles spanned by the rotation should be entered

in the corresponding boxes. When selecting the files in the file browser, they should be

ordered according to angles with the first file selected corresponding to the lower angle.

Since the camera position and rotation can be general, it should be stated to which diffrac-

tometer axes the right and up directions of the OpenGL widget refer to. The file names

and camera parameters will automatically be saved in a crystalFrames.info file which

can conveniently be chosen for the next time. The diffractometer axes should be given

according to the convention of Busing & Levy, i.e. the incoming beam is along the positive

y axis and the z axis is vertical, x completes the righthanded set. The orientation matrix

will internally be transformed according to the instrument’s definition (see Sec. 3.10). On

the ILL instruments the camera is mounted on the omega table and is pointing upwards.

With the neutrons entering from the top part of the taken picture the correct settings for

this geometry are those which are loaded by default, i.e. right = +x, up = −y. The frames

are then taken by rotating around the φ axis with χ = 90◦ and the sense of rotation is

calculated based on the instrument’s definition.

Camera and sample offsets can be set in the Offsets tab on the right. x sample off-

sets should be set, when a picture close to φ = 0 is viewed, while y sample offsets can

be seen for φ ≈ 90. The buttons for ±90 or ±180 rotations can be used for finding the

offsets conveniently. A z sample offset concerns the height along the sample pin. The

camera offsets refer to the lateral misalignment of the camera and its rotation around the

z axis. The goal is to have the crystal’s center of mass in the center of the crosshair. In

the View tab it is important to set the zoom factor so that the radius of the crosshair (in

mm) corresponds roughly to the real crystal dimensions.

The frames can be viewed by dragging the horizontal slider below the OpenGL widget

or by using the buttons below it. The play speed can be adjusted and the loop checkbox

can be set, if you want to see a continuous rotation.

In order to add a plane to the crystal model, one has to rotate the crystal to a posi-

tion in which the face is parallel to the view direction. In this position simply click and

drag a line along the edge, which will add a plane (converted to hkl) to the table. The

length of the line is not very important and only serves for drawing unbound planes as

a square having the edge length according to the drawn line. By adding more planes in
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different sample positions the program will redraw the bound volume and show the model

on top of the picture. Note that it is of course possible to draw a sample model without

having loaded any frames. In that case, it is recommended to change the plane color under

the View tab to a different color than the background. First, one should draw e.g. four

lines in the shape of a square around the crosshair, then move the φ slider by +90◦ or -90◦

and draw two horizontal lines above and below the center position, which should create a

closed volume.

In order to highlight a plane simply click on it in the table or in the model. When a

parameter in the table is highlighted, it can be adjusted using the horizontal slider or a

new value can be entered directly. The crystal model will be updated instantaneously.

If a plane is actually needed to draw the smallest possible volume will be shown with a

yes or no in the last column of the table. Planes can be removed by right-clicking the

vertical header and selecting Delete. Multiple planes can be deleted simultaneously. For

very irregularly shaped crystals it may be more intuitive to uncheck the Hide planes be-

hind picture option in the View tab. An example of a complex crystal shape is shown in

Fig. 4.2 and a tutorial video can be seen here. By clicking OK the created planes will

be transfered to the Data reduction window. Note that the planes are only saved when

at least 4 used planes are present. Unused planes are not saved. Mag2Pol will auto-

matically calculate the corresponding diffractometer angles for every measured reflection

based on the instrument definition and will determine if a non-zero ψ angle or a different

χ quadrant was necessary to measure a particular reflection. Furthermore, the number of

integration samples should be given along the a, b and c axes of the sample by clicking

on Set grid. The grid points will be distributed according to the Gaussian integration

procedure described in [26].

Once all the necessary information are entered, the absorption correction is done like

for simple sample shapes by clicking the Apply button. By clicking on any hkl index in

the table the orientation of the crystal model and the integration points are shown together

with the diffractometer axes and the incoming/outgoing neutron beams (see Fig. 4.3). The

planes of the model which are intersected when diffracting from the origin are marked by

orange edges. The diffractometer angles are shown below the OpenGL widget together

with the average path lengths along the incoming (r1) and outgoing beam (r2). The
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4.2 Absorption correction

Figure 4.2: Complex crystal shape containing 19 limiting faces.
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average transmission T is approximated by a Gaussian integration [26] according to

T =

∫
V

1

V
exp[−µ(r1 + r2)]dV

≈
nx∑
i=1

ny∑
j=1

nz∑
k=1

(b− a)[d(xi)− c(xi)][f(xi, yj)− e(xi, yj)]RiRjRk1/V exp[−µ(r1 + r2)],

(4.4)

where the a, b, c, d, e, f are the corresponding limits of integrations and the Ri, Rj , Rk

are the respective weights which are taken from [27]. The visualization of the scattering

geometry is animated by default, i.e. the successive rotation of angles will be shown. By

unchecking animate the final diffraction position will be shown immediately. For a more

fluid rendering the grid points can be omitted in the rendering process. The absorption

Figure 4.3: Orientation of the sample for a given (hkl) reflection within the Busing-Levy

frame (colored axes). The diffractometer angles are give together with the average beam

paths inside the sample and the transmission factor.

correction in Mag2Pol has been compared to the subroutine AVEXAR of the CCSL

subroutine library for normal beam and 4-circle geometries. The results are identical

within rounding errors starting from nx = ny = nz = 3 as can be seen in Fig. 4.4.

4.2.3 On-the-fly absorption correction

The absorption correction mentioned in the section above can be applied to correct the

dataset of integrated intensities which was opened in the data reduction window. In that

case the correction factors are applied to each measured (hkl) reflection before an eventual

merging with respect to the given space group. The corrected data can directly be used
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Figure 4.4: Transmission as a function of integration points nx = ny = nz for three

different Bragg reflections calculated by Mag2Pol and CCSL.

in the analysis or they can be exported into an *.int file.

It is also possible to use the convex-hull crystal model to do an on-the-fly absorption

correction, which is useful if one wants to refine the occupation of a heavy absorber as it

influences both the absorption through the linear absorption coefficient and the scattering

potential through the scattering length (e.g. incomplete 11B or 160Gd substitution). This

possibility allows for a self-consistent analysis of the data. In order to activate this feature

a crystal model needs to be present before entering the fit window, which can be done

by opening the Sample info window (see Sec. 6.1) and clicking Edit under the Absorption

tab. In that case, when the fit window is entered the option On-the-fly absorption cor-

rection becomes visible below the loaded integrated intensity data. When it is activiated

the program will calculate the neutron beam path lengths for all the reflections only once

before starting the refinement iterations. In each iteration the linear absorption coefficient

may be different, if the atomic occupations are refined parameters. Note that the use of

this feature is even possible for multiple integrated intensity files as long as the data were

recorded in the same instrument geometry (e.g. different wavelengths).

If the occupation of a heavy absorber is uncertain and needs to be refined, the recom-

mended procedure is the following:

In a first step, the integrated intensities should be reduced in P1 or P -1 symmetry (the

beam path lengths are identical for Friedel pairs, however, small deviations may be possible

in the calculation due to precision errors) and loaded for the refinement. After activating

the on-the-fly absorption correction check box, the nuclear structure refinement can be
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done as usual.

In a second step, the refined nuclear structure from the first step should be used to apply

the absorption correction on the raw data which are then eventually merged and exported

(as explained in Sec. 4.2.2). Alternatively, a corrected data set can be conveniently created

after the refinement process by clicking on Create corrected dataset at the bottom of the

Fit tab (note that in the presence of multiple data sets, a single one has to be selected

first from the plot data combo box). This will subtract the λ/2 contamination from the

observed intensities and then correct for absorption and extinction effects (the latter only

in the case of the Becker-Coppens model which also depends on the beam path within

the sample). The resulting intensities will be shown in a new data reduction window and

can be merged, exported or directly used for the subsequent analysis (note that it may

be necessary to change the wavelength either in the data reduction window or in the fit

window using the right-click menu in the loaded data list, since the wavelength in the data

reduction window is initially read from the main window).

The last step consists in refining the nuclear structure to the corrected and merged data

set of step 2 (without the on-the-fly option), which should give similar results as in the

first step, but with better agreement factors due to a reduced number of observations (due

to the merging of equivalent reflections).

4.3 Correction for the spin-filter efficiency

Usually the efficiency of the 3He spin-filter cell is monitored by measuring e.g. the polar-

ization Pzz on a purely nuclear Bragg peak - which is known to be 1 - several times a day

during the experiment. The reduction from the expected value is due to the initial polar-

ization of the neutron beam (which can be set in the Settings menu) and the spin-filter

efficiency. In the case of a loaded *.fli file the program analyzes the lines which signal a

cell change and the time of the respective observations to show the decrease of efficiency as

a function of hours. On D3 depending on the used cell the decay is usually between 10 and

20% per day. The reflection on which the calibration has been performed throughout the

experiment and the polarization canal has to be selected followed by clicking Apply. The

polarization data will now be corrected with respect to the decaying spin-filter efficiency

according to

Pcorr = Pmes ·
P0

Pcell
(4.5)

where P0 is the polarization of the incident neutron beam, note that setting this value to

1 in the settings of the program or in the input dialog after clicking Apply will correct

the data also for the initial polarization. Repeated measurements of the same polarization

matrix element for the same (hkl) reflection can optionally be merged by activating the
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4.3 Correction for the spin-filter efficiency

corresponding checkbox. A further checkbox can be activated, if a certain temperature-

binning should be applied to the merging. A weighted average will then be calculated

from the standard deviations given in the *.fli file. In order to interpolate the spin-filter

efficiency for any given time an exponential decay function of the form

P (t) = P0,n · tanh[O · P0,He · exp(−t/T1/2)] (4.6)

is used, where O = λ · l · p · 7.282 · 10−2 is the cell opacity at room temperature. The

wavelength, the length of the cell l, the cell pressure p and initial cell polarization P0,He

are fixed, while the halflife T1/2 and the initial neutron polarization P0,n are refined. The

results can be seen by clicking on View cell efficiency, which opens a window similar to

the one shown in Fig. 4.5. The different cells recognized from the entries in the *.fli file

Figure 4.5: Visualization of the spin-filter efficiency decay as a function of time.

can be chosen from the combo box. The legend shows the name, the pressure and initial

polarization of the cell as well as the refined values including standard deviations for the

initial neutron polarization and the halflife. The refined neutron polarization should be

similar to the nominal neutron beam polarization of the instrument.

The corrected data can be saved from the fit window in order not to repeat this proce-

dure.

Note that when chiral or nuclear-magnetic interference scattering is present, the polar-

ization data should only be corrected to the spin-filter efficiency and not to the initial

polarization (i.e. the P0 value of the incident beam needs to be entered in the Mag2Pol

settings) as the respective entries contain terms which are dependent on the initial neutron

polarization and terms which are not. Two options are possible:
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• In order to analyze the raw data the checkbox Refine on uncorrected data using cell

efficiency should be activated before you hit the button Apply. The program will

still take into account the cell efficiency at a given time of an observation, but it

will be used in combination with the initial neutron polarization to calculate the

respective entry of the polarization matrix. In this case no merging of reflections is

possible.

• The raw data can be corrected for the spin-filter efficiency only. This can be done

in two steps. First, click Apply and accept the popup input dialog with whatever

value, then extract the refined incoming neutron polarization P0,n. In a second step,

delete the *.fli file and load it again. This time, when applying the correction,

enter the previously refined P0,n value.

Loading Numors directly is intended for a special type of measurement, where the initial

neutron spin is rotated within the local y-z plane. The positions and amplitudes of the

minima and maxima allow important conclusions concerning the magnetic structure. In

this case the polarization value (including the time of the observation) as well as the

directions of the initial neutron polarization and analysis vector are extracted from the

Numor files. As no information is present concerning any potential spin-filter cell changes

only those data should be loaded which have been measured with the same cell. The

correction with respect to the cell efficiency is done as described above (note that for a

final polarization vector within the y-z plane no chiral scattering is present).

4.4 Refinement flags and constraints

All the magnetic ions defined within the magnetic structure will be listed in the same

order under the Magnetic moments tab as M1, M2, .... The magnetic domains are shown

under the Domains tab together with their corresponding symmetry, an eventual keyword

signalling an inversion or chiral domain and their population. In the case of a form factor

refinement, the multipole, orbital or radial integral coefficients are refinable parameters

as well. By activating the checkbox next to a respective value, this parameter will be

considered as a refined variable. Nuclear structure parameters can be refined, when the

checkbox Refine nuclear structure is activated in the Data tab, which will insert a new tab

called Atoms including the positions, thermal and occupational parameters, scale factor

and extinction coefficients. A right-click on any table’s column header or tab (except for

the Data tab) opens a context menu for quickly (un)checking all respective parameters.

Anisotropic displacement parameters can be flagged by chosing the set betas context menu

entry after right-clicking an isotropic temperature factor. Constrained Bij values and fit

flags are disabled if they are constrained by symmetry.
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Figure 4.6: Anisotropic displacement parameters and the visualization of thermal ellip-

soids.

Linear constraints can be set under the Constraints tab by chosing the variables and

relations from the combo boxes and entering the proportionality factors and summands

by hand. M1 refers to the whole vector of magnetic moment 1, |M1| refers to the modulus of

the moment, whereas Mr1 and Mi1 would denote the real and imaginary part, respectively

(note that vector quantities can only be constrained to other vector quantities and that

a moment modulus can only be constrained to another moment modulus). In the case

of non-zero real and imaginary components, Mag2Pol will constrain Mr and Mi to be

perpendicular, if they are not defined as parallel. If the real components are refined, the

imaginary vector will be adjusted and vice versa. If both real and imaginary components

are refined, the imaginary vector will be adjusted after each iteration.

The constraints take the form of

p1 = a · p2 + b (4.7)

where p1 depends on p2. If you choose the equal sign, the parameter p1 is regarded as a

constant (in relation to parameter p2) and should therefore not be refined. For relations

’greater than’ or ’smaller than’ the constrained parameter p1 should be marked as a refined

parameter. If the multiplication factor a is 0, then p2 is a dummy parameter which is not
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necessarily refined and p1 is directly related to the scalar b. If |a| > 0, then p2 needs to

be set as a refined parameter as well (note that errors will be shown as pop-up warnings).

The keyword various for parameter p1 can be used to define multiple constraints. By

choosing various a button will appear to the right which permits to select various param-

eters from a list which will be constrained to p2 (see Fig. 4.7).

In the present version of Mag2Pol up to 20 constraints can be set. In case of multiple

magnetic domains or structural twins, the population of the first domain/twin is automi-

cally set to 1 minus the rest in each iteration. Constraints can be deleted by right-clicking

the parameter to be constrained and then clicking Delete.

Figure 4.7: Multiple parameters can be selected after choosing various.

Note that constraints on atomic positions due to special Wyckoff sites, e.g. (x x + 1
2 z)

or (x 2x 1
2), do not need to be set by the user, because Mag2Pol will consider them au-

tomatically. The same applies to anisotropic temperature factors of atoms on special sites.

Freeform constraints can be constructed in a similar way as the linear constraints, but

they offer additional flexibility and complexity. They can be entered freely by following

a certain syntax. Parameter names need to be enclosed in quotes and mathematical ex-

pressions, e.g. exp, sin, need to follow C++ syntax (i.e. x2 is written as pow(x,2)). On

the left-hand side of the (in)equality sign either only one parameter should be entered or

several parameters separated by commas. On the right-hand side, any equation can be

entered. The correct syntax is visualized by green text, while the opposite is shown as
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red text. It is recommended to separate the parameters from the operators by a space as

eventual double minus signs can be wrongly interpreted. Parameters can also be inserted

by right-clicking the line edit and by choosing from the context menu. For example, 2

site occupations constrained simultaneously to be one minus the site occupation of 3 other

sites is written as ’A1occ’,’A2occ’ = 1 - ’A3occ’ - ’A4occ’ - ’A5occ’. Both linear

and freeform constraints will show a warning in the fit output, when a boundary was hit

in the case of an inequality constraint.

Simple constraints, i.e. of the form p1 = p2, can directly be set in the Atoms, Mo-

ments and Domains tabs by right-clicking the respective label and evoking context menus

as shown in Fig. 4.8. Note that the parameter to which one wishes to constrain needs to

be placed higher in the atom/moment/domain/twin list or it needs to be in a phase with

lower index. E.g. the position of atom 3 in phase 2 can be constrained to atom 2 of the

same phase or to atom 4 of phase 1. Parameters being lower in the list are automatically

grayed out in the context menu.

In the case of atoms the parameters which can be constrained are

• position: x, y and z fractional coordinates

• B: isotropic temperature factor

• anisotropic B: all anisotropic displacement parameters

• occupation: the occupation factor

• split occupation: 1 minus the occupation factor for two atoms occupying the same

site

• all atomic parameters: all of the above (except for the split occupation)

If the parameter in questions is a magnetic atom, the options are

• moment: all real and imaginary components

• moment modulus: the modulus of the moment

• real part: the parameters belonging to the real part of the complex magnetic moment

• real part modulus: the modulus of the real part of the complex magnetic moment

• imaginary part: the parameters belonging to the imaginary part of the complex

magnetic moment

• imaginary part modulus: the modulus of the imaginary part of the complex magnetic

moment

55



4 Fitting

• phase: the magnetic phase

• all magnetic parameters: all real and imaginary components as well as the magnetic

phase

In the case of domains and twins the population can be constrained to any other do-

main/twin population with a lower index similarly to what was explained above concerning

atomic sites. Note that constraining a domain (twin) population to the first domain (twin)

population equally distributes the remainder of the other domain (twin) populations to 1

(i.e. 1 minus the rest) on the constrained domains (twins), which is not supported when

using constraints under the Constraints tab. Setting a constraint in this way will disable

the manual editing of the corresponding parameters and fit flags. In order to quickly find

to which parameter a constraint is set, the corresponding menu fonts are set in italic. A

constraint can be removed by unchecking it. Some constraint combinations will be auto-

matically summarized as a different one, e.g. if the imaginary part of a magnetic moment

is constrained after the real part was already constrained, then the constraint will be found

under Constrain moment.

Changing a parameter will automatically update the parameter(s) which is/are constrained

to it (both for constraints under the corresponding tab as well as for simple constrained

which are set via context menues).

Figure 4.8: Simple constraints can conveniently be set using context menues.
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4.5 Powder patterns

When at least one powder pattern has been loaded, the Patterns tab appears which is

shown in Fig. 4.9. The left part of the tab features the pattern plot with the corresponding

plot controls above it, while the scroll area on the right side contains all necessary param-

eters and fit flags separated into different categories. The category labels, e.g. Geometry,

Background, etc., contain further options which can be evoked by right-clicking the label

which opens a context menu. The context menu generally contains a list of loaded patterns

and contributing phases in order to set constraints between them (see Sec. 4.5.6). Further

options of certain categories are explained below. Note that the parameters depend on

the type of data loaded, i.e. if it was taken on a constant-wavelength or a time-of-flight

diffractometer.

Figure 4.9: Pattern tab within the Fit window in which all parameters can be set which

are necessary for the Rietveld/LeBail refinement.

4.5.1 Plot controls

The default plot options show the observed data points in red, the calculated pattern in

black and the difference between the two in blue (the colors can be set in the program

settings). Furthermore, the positions of nuclear and magnetic Bragg reflections calcu-

lated from the underlying model(s) are shown as green markers between the data and the

57



4 Fitting

difference curve. Like in other 2D plots hovering the mouse over data points shows the

respective coordinates, while hovering over the peak markers reveals the scattering angle

(or time of flight, Q, d depending on the axis choice), the Miller indices and the multiplic-

ity of the Bragg reflection. When more than one pattern file was loaded, one can switch

between them by choosing from the combo box in the upper-left corner. The two buttons

to the right of the combo box toggle the background and excluded regions mode which will

be explained in Secs. 4.5.3 and 4.5.4. The third button activates the propagation vector

finder tool, see Sec. 6.10, and the fourth button cycles the x axis unit between scattering

angle / TOF, scattering vector Q or d-spacing. The next 3 buttons toggle the plot grid,

the legend and the χ2 value on the plot, whereas the last button exports the plot into

either a pdf or an ASCII file taking into account the actual zoom (note that for the ASCII

output the excluded angles and peak markers are labelled with an asterisk, whereas the

latter are given in 2θ/TOF values after the data table). The plot boundaries for the 2θ

and counts axes can be set further to the right. Those boundaries will also be used for

the plot in the Fit tab. They can be reset to the optimal values by right-clicking on any

of the 4 values and then clicking reset boundaries. Shift-clicking the plot permits to drag

the pattern without changing the zoom.

4.5.2 Geometry

The Geometry section concerns the basic information of the used instrument like the

source (neutron or x-ray) and the wavelength. Note that constant-wavelength (CW) and

time-of-flight (TOF) instruments in Debye-Scherrer geometry are currently supported in

Mag2Pol. For CW patterns the λ/2 contamination or the Kα2 line can be entered

in the λ2 field with the corresponding intensity ratio between λ1 and λ2. When x-ray is

selected, a right-click on the λ1 value allows the selection between different frequently used

x-ray Kα1,2 lines. The values K and 2θM are only needed in the x-ray case in order to

calculate the monochromator polarisation within the Lorentz factor (see Sec. 7.7.1). For

TOF patterns the detector bank angle 2θB has to be given. From the Geometry context

menu the instrument configuration of various instruments from different sources can be

loaded, which include the wavelength, the resolution, the peak shape and asymmetry

parameters for constant-wavelength diffractometers as well as time-of-flight, detetor bank,

rise and decay and peak shape parameters for TOF. This is a convenient way of setting

up a starting point of the refinement, see Fig. 4.10.

4.5.2.1 Instrument resolution function (IRF)

The resolution function of an x-ray or neutron powder diffractometer can be loaded from

and saved to an *.irf file (same format as for FullProf). Both options can be evoked
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Figure 4.10: Selection of predefined instrument configurations.

from the Geometry context menu by choosing the custom submenu. After successfully

loading an IRF file all read parameters will be applied to the current pattern and refinable

parameters, e.g. u, v and w for CW data or σn, γn, αn and βn for TOF data, will be set

to 0 and the respective label changes to a preceding ∆. This means that the instrumental

contribution is now stored internally (the global value can be retrieved by hovering the

mouse over the respective parameter label) and only the difference due to the sample

contribution should be refined (see Sec. 7.7.1.8 for the respective isotropic Gaussian and

Lorentzian broadening parameters). Note that the observed resolution function can be

visualized (split into Gaussian and Lorentzian parts for the TCH Pseudo-Voigt profiles)

by right-clicking the Profile label in the Patterns tab.

For TOF patterns the profile lookup table - containing d values vs. σ2, γ, α and β -

supplied by FullProf IRF files is supported. For a particular d value in a pattern,

the table values are interpolated (or extrapolated if before/after the first/last entry).

This lookup table can be edited or created by clicking edit profile table from the custom

submenu. When creating a lookup table from scratch, the peak finder slider can be used

as well as individual peaks can be added/modified/deleted exactly as in the Cell finder

window (see Sec. 6.9). Individual peaks can be examined by clicking on the vertical header

number and the modification of the peak profile parameters leads to a live update of the

plotted peak. The first fit option is fitting the table values to the polynomial d-value

dependence as shown in the upper part of the window. This functionality can be useful

to determine and visualize an instrument resolution function. This can be done by right-

clicking any of the σ2, γ, α or β headers and choosing either Plot vs. d or Plot vs 1/d.

Note that individual values in the table being checked are excluded from the fit. On the

other hand, a global refinement to the selected sections of the diffraction pattern can be

done. Each selected section is marked by a blue bar in the main window (corresponding

to a d-value in the lookup table) and the fit range corresponds to the number of FWHM

specified in the settings menu. Here, the checked profile values in the lookup table are
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independently refined from the global d dependence given by the parameters at the top

of the window. The individual parameters can be constrained to vary less than a given

percentage from the global value by checking the respective shift checkbox.

Figure 4.11: Profile lookup table for TOF powder patterns with different plot and fit

functionalities.

4.5.3 Background

There are different ways to introduce the background of a powder pattern. The first is to

give a list of points between which a linear interpolation is calculated. In order to do so the

background mode needs to be activated by clicking on the first button next to the pattern

file name. If a background is already defined it will be shown as green squares connected

by green lines (see e.g. Fig. 4.9). A background point is simply added by left-clicking on

the pattern. A green square will be added to the plot and the corresponding 2θ value and

counts will be added to the table on the right. An already drawn point can be moved by

placing the mouse over it which will turn the mouse cursor into an open hand symbol.

Now simply click and drag the background point to the desired position. The coordinates

of each point can also be modified by directly editing them in the table. A background

point can be deleted by right-clicking it. The pattern will be calculated using the newly

defined background after leaving the background mode, i.e. by clicking the corresponding

button.

The background can also be modeled with a polynomial function of different degrees or
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with a Debye-like model (see Sec. 7.7.1.7 for more information). In order to change the

background type, simply right-click the Background label in the scroll area and select one

of the diffent models, see Fig. 4.12. Note that when you select polynomial (6 coeffs) and

you have manually introduced points before, the program will fit the coefficients (if they

are all equal to 0) to the linear interpolation as a convenient starting point. From there

you can eventually choose one of the two more complex models.

Figure 4.12: Selection of different background models.

4.5.4 Excluded regions

All regions of the powder pattern which cannot be explained by the underlying model(s),

e.g. direct beam, negative intensities, zero sigmas, parasitic peaks etc., should be excluded

from the refinement and from the calculation of agreement factors. In order to do so one

has to activate the excluded region mode by clicking the second icon next to the pattern file

name. Now, exluded regions can be drawn by left-clicking and draggin which will create a

gray box (note that zooming is disabled when excluded region mode is activated). Already

drawn excluded regions can be modified by placing the moue over one of the limits which

will change the mouse cursor into horizontal arrows. The lower/upper limit can now be

dragged. The excluded regions can also be modified in the table on the right. An excluded

region can be deleted by right-clicking it in the pattern plot. Note that depending on the

chosen option in the settings menu the pattern is nevertheless calculated in these regions,

but not included in the calculation of χ2.

4.5.5 Pattern and phase parameters

In order to allow the correlated refinement of powder patterns and single-crystal data at

different temperatures, the overall temperature factor Bov has a special function. If it is

set to 0 and is not refined, then the temperature factors listed in the Atoms tab will also

be used for this particular powder pattern. If a non-zero value is entered for Bov or if it

is flagged as a refined parameter, only the Bov value will be used in the powder pattern,

while the B values in the Atoms tab are applied to the single-crystal data. Like this it
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is also possible to use anisotropic temperature displacement factors for single-crystal data

sets, while using an overall isotropic temperature factor for the powder data at the same

time.

The remaining parameters grouped in the Offsets/Time of flight and Scaling categories

are explained in Secs. 7.7.1 and 7.7.1.6.

More than one phase can contribute to a single pattern and in that case multiple phases

have to be set up in the main window (see Sec. 2.2). The parameters which are grouped

in Cell, Profile, Asymmetry/Rise and decay, Preferred orientation and Absorption and

extinction (only for TOF) concern a specific phase in a specific pattern. The pattern can

be specified - as explained above - by choosing from the combo box in the upper-left part

of the tab. The phase can be chosen in the Phase category. Furthermore, it can be defined

if the phase has a nuclear contribution, a magnetic contribution or both. A right-click

on the contribution labels (nuclear or magnetic) allows to toggle between Rietveld and

LeBail refinement for that particular contribution. Having different sets of parameters

for the same phase, which contributes to different patterns, allows for example the co-

refinement of two patterns at two very different temperatures resulting in different lattice

constants. The only part which is common to all patterns (and other types of data of the

same phase) are the parameters listed under the Atoms and Moments tabs (except for

the temperature factors if Bov > 0 in the powder pattern). Therefore, one has to keep

in mind that co-refining different data sets is only meaningful if one can assume that the

fractional atomic parameters do not change too much. Note that the information given in

the Domains tab is ignored for the calculation of powder patterns, i.e. only a single twin

with a single magnetic domain is considered. If different phases with different cell metrics

contribute to the powder pattern, the option Ignore secondary phases for single crystal

needs to be checked in the settings menu, if a co-refinement with single-crystal data is

intended. Otherwise, the contribution of secondary phases will be considered to the (hkl)

reflections of the main phase, which is not correct.

Note that after accepting a fit result (click on the Accept button) the lattice constants and

the propagation vector(s) are not automatically transferred to the model(s) in the main

window as those values are in principle used in the reduction and refinement of single-

crystal data (the cell and q are of course saved in the powder model). One can however

transfer these parameters between the main window and the models for powder patterns

by right-clicking the label Cell or Propagation vector q (in the Symmetry and Spins tab

of the main window) and choosing the corresponding option and pattern number.
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4.5.6 Constraints

If one can safely assume that the same structural model contributes to different patterns,

e.g. a neutron and an x-ray pattern taken at the same temperature or two neutron patterns

taken with different wavelengths, then constraints should be set. In such a case it would

be a good idea to constrain the cell parameters. Or if two phases contribute to the same

pattern and one can exclude peak broadening due to strain, then the profile parameters

could be constrained. Constraints can conveniently be set by right-clicking the respective

category label and then choosing the pattern and phase to which the parameters should

be constrained (in analogy to simple constraints described in Sec. 4.4). The example in

Fig. 4.13 shows how the cell parameters of phase 1 in pattern 2 are constrained to the

cell parameters of phase 1 (i.e. the same phase) in pattern 1. After setting a constraint

the corresponding values are directly synchronized and the fit flags (in this case of phase

1 in pattern 2) are disabled. It is not necessary to constrain the profile and asymmetry

parameters of the magnetic contribution to the nuclear contribution, since all magnetic

parameters are ∆ values, i.e. they are added to their nuclear counterparts. In other words,

if a magnetic ∆ parameter is 0, it is automatically constrained to the nuclear parameter.

Figure 4.13: Example of how the cell parameters of one phase can be constrained to be

the same in two different patterns.

4.6 Refinement and results

Once the data are loaded and the refinement flags and constraints are set, one can proceed

to the Fit tab. Here one can control how the eventual co-refinement should be weighted.

This is visualized by a weight triangle in which a draggable dot marks the different weights

in trilinear coordinates (see Fig. 4.14). The weights of the respective data sets sum to 1

and are shown on the left of the triangle where they can also be set manually. If only one

type of data was loaded, then the dot is fixed in one of the three corners. If two types are

loaded, the user can drag the dot on one of the three lines of the triangle. And when all

three data types were loaded, the dot can be dragged everywhere within the triangle. For

convieniency the dot snaps to the center of the triangle and to the bisections.
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Figure 4.14: The weight triangle is a graphical way to set the respective weights of the

data sets. When 2 (3) different types of data were loaded the dot can be dragged within

a line (within the whole triangle). When only a single data type is present, the dot stays

in the respective corner. The weights can also be set in the respective boxes, which are

synchronized with the triangle.

The least-squares refinement will therefore minimize

χ2 = wSNP · χ2
SNP + wINT · χ2

INT + wPOW · χ2
POW (4.8)

where χ2
SNP , χ

2
INT and χ2

POW are the respective χ2 values of the polarimetry, integrated

intensities and powder data, respectively. Note that the weight given for intensity and

powder data is further split if multiple data sets exist for which the individual weights

can be set in the Data tab. The convergence criterium ϵ can be set in the Settings of the

program and it refers to the maximum relative shift of a parameter in an iteration divided

by its standard deviation. The refinement stops when

∆(p)/σ(p) < ϵ (4.9)

where ∆(p)/σ(p) represents the maximum value in an iteration for parameter p. Also the

maximum number of iterations can be set.

The refinement can be started by clicking the Fit button and the progress as well as the

results are shown in the text field to the left. For every iteration the χ2 value will be

printed together with the maximum relative parameter shift. Either when the maximum

number of iterations has been reached, the convergence criterium is fullfilled or the Stop

button is clicked (the Fit button changes label automatically), the refinement will stop and

list the χ2, reduced χ2 and RF value (the last only applies for the integrated intensities

and powder patterns). The refined parameters with their respective standard deviation

are shown below. It is also possible to run a previously defined fit macro (see Sec. 4.8)

by choosing it from the combo box below the Fit button and by pressing the play button.

The macro can be stopped by pressing the stop button. Each step will be visualized and

results printed as if it were a single refinement.
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The refinement is visualized on the right-hand side of the window (see Fig. 4.15), where

the integrated intensites are shown in an Iobs-vs-Ical plot (flipping ratios are shown in an

Robs-vs-Rcal plot), powder patterns are represented as usual with the observed, calculated

and difference lines and the polarization matrices are shown for each magnetic Bragg re-

flection. The latter is achieved by showing the observed polarization matrix entries as

circles and the calculated ones as squares. The color code is red for x, green for y and blue

for z, while those colors refer to initial polarization Pi for the marker face color and to the

final polarization Pf for the marker edge color. E.g. a red square with a blue edge refers

to an initial neutron polarization along the local x axis and a analysis direction along

the local z axis, i.e. to the term Pxz of the polarization matrix. In case of multiple data

sets of a single type (intensities or powder patterns) the one to plot can be selected from

the combo box in the upper-right corner of the window (appears only when multiple data

sets are loaded). If you have loaded Numors corresponding to a rotation of the incident

Figure 4.15: Output and visualization of the fit results.

neutron polarization within the y-z plane, the resulting plot contains the curves for each

magnetic Bragg reflection on which this measurement was done (Fig. 4.16). The usual

zoom controls work on this plot and the mouse can be hovered over a data point to obtain

the exact values. A table of the observed and calculated intensities (also derived from

powder patterns), flipping ratios as well as polarization matrices can be seen by clicking

on View results, the same table can also be exported into an ASCII file by clicking on

Export results. The values in the results table can be plotted against different scattering

variables by right-clicking the respective column header and by choosing from the context
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Figure 4.16: Visualization of the fit results when the data correspond to a rotation of the

initial neutron polarization within the y-z plane.
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menu. Note that polarization matrices can be visualized in matrix form, both using num-

bers or colored dots (see Sec. 6.16), by clicking on Color plot.

When more than one parameter is refined, the View correlations button is enabled which,

when pressed, opens a window in which the correlation and the covariance matrix is

shown. Note that if correlations exceeding 70% are present the View correlations but-

ton will be given the focus in order to notify the user. Within the correlations window,

the (anti)correlations with more than 70% will be marked. This threshold value can be

modified in order to focus on weaker or stronger correlations. Note that this window can

be kept open for subsequent refinement steps, which will automatically update the values

of the correlation matrix. The button focus will be set according to the actual threshold

value in the correlation matrix window.

If you are satisfied with the refinement (step) you can click the button Accept. This will

pass on the refined parameters to the main window, replot the magnetic structure and

you can afterwards save it to your input file. If the fit diverged or did not improve you

can close the window without clicking Accept, like this the initial parameters before the

respective refinement step are kept in the main window. It is also possible to (repeatedly)

click the Undo button (or Ctrl/Cmd + Z) which reloads the parameters and flags which

were present before clicking the Fit button.

4.7 Batch fitting

4.7.1 Single-pattern

Batch fitting is presently only possible for powder patterns. It first requires to refine

a single powder pattern (for multiple powder patterns, see Sec. 4.7.2) as described in

Sec. 4.5 and accept the fit in order to transfer the refined parameters to the main window.

Note that eventual constraints need to be set in this single refinement and will be used

in the batch fit afterwards. The parameters to be refined will be loaded from the single

refinement, but can also be modified in the batch fit window afterwards. It is also possible

to open an xml file to which fit results have been saved previously. However, when the fit

model is changed in the fit window, the previously stored batch fit results will be erased

(a warning will be displayed before).

If an initial model is present the action Batch fit will be enabled in the Fit menu of the

main window. When entering the Batch fit window the initial model and its corresponding

pattern will be shown in the upper-right part of the window. An eventual previously saved

batch fit will be shown. The same functionalities are enabled as for the pattern plot in
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the Fit window.

A sequence of powder patterns can be loaded in the upper-left part of the window by

clicking on the Load button. The sequence can consist e.g. of powder patterns of a sample

recorded at different temperatures or of different samples with varying composition. For a

meaningful use of the batch fit option the powder patterns should not vary too much from

step to step. The loaded samples will be shown in the item list below the Load button and

clicking the different items will show the different patterns in the pattern plot together

with the initial model. If the loaded patterns contain metadata like temperatures (set

point, regulation, sample) or composition it can be sorted according to that parameter by

clicking on the Sort button. A dialog box will open which contains the possible variables,

note that sorting according to the file name is always possible. A right-click on one of

the items opens a context menu which offers several options concerning the refinement

flags of that particular chosen pattern. First, in the Fit parameters menu, all possible

fit parameters are listed which can be checked or unchecked for the refinement of that

particular data set. A click on Clear fit flags removes all fit flags and from the Restore fit

flags menu it is possible to either restore the refined parameters to those in the single-fit

model (in the standard fit window) or to the last state which was run as a batch fit. By

selecting multiple data sets and choosing Apply fit flags to all selected the fit flags of the

item which was right-clicked will be applied to all selected items.

The loaded patterns can be cleared by clicking on the Clear button.

When a sequence of powder patterns is loaded, the refinement can be started by clicking on

Fit batch or by selecting a previously prepared fit macro from the combo box and clicking

the play icon. By using the option refined values = next start values it is more probable to

have a converging fit from pattern to pattern. Otherwise, the same start parameters of the

initial model will be used for every single pattern in the list. A certain range of patterns

or even a single pattern can be chosen for the batch refinement by marking the respective

patterns in the loaded pattern list and by activating the fit only selected patterns checkbox.

The fit progress is shown for every pattern by outputting the iterations and χ2 values like

for standard refinements. After each fit the corresponding pattern is shown in the pattern

plot. When the last pattern has been processed the refined parameters are shown in the

parameter table in the center of the window. The current pattern or all patterns at one

time (the pattern number will be added as an extension to the chosen file name) can be

exported into pdf format. After the refinement process it is possible to export the refined

parameters into a new xml file by right-clicking the file name in the list and choosing save

fit result as xml.

Variables can easily be plotted by ticking either the check box Plot 1 or Plot 2 which refer

to the left or right y-axis of the parameter plot on the lower-right part of the window.

The plot style can be customized by changing the color, the line style and width as well as
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marker type and size. Legend entries and axes labels can be entered in the corresponding

text fields which are synchronized with the parameter plot. The plot can be exported

either as pdf or ASCII.

Figure 4.17: Batch fit window allowing to sequentially refine powder patterns. The refined

parameters can easily be plotted against temperature, composition or pattern number.

4.7.2 Multipattern batch fitting

Multipattern batch fitting is possible as long as the number of patterns is the same for all

items in the batch, e.g. for all temperature or doping steps. This feature may be used,

e.g. when a neutron and an X-ray pattern have been recorded or when multiple banks

are included in the refinement of TOF data at various temperatures. Everything in the

previous section is also valid for the multipattern batch fitting option, there only a few

additional details to consider. When the single-fit model contains two or more powder

patterns and the batch-fit window is entered, a combo box will become visible situated

left to the Load button. This allows to specify the different batches corresponding to the

patterns of the single-fit model to be loaded. For example, in a single-fit a neutron powder

diffraction pattern was used as the first pattern and a X-ray diffraction pattern was used

as the second pattern. Then, all neutron data (e.g. as a function of temperature) have to

be loaded with Pattern 1 showing in the combo box, and all X-ray data will be attributed

to Pattern 2. Note that Pattern 1 data have to be loaded first and that all subsequent

batches (Pattern 2, Pattern 3, ...) are added afterwards. Data files can be added step-wise,

but the Fit button is only enabled when all patterns have the same number of elements in
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the batch. When it is intended to load more data files than those that are present under

Pattern 1, then all the excessive files will be discarded. It is also important to note that

each batch has to be sorted individually, i.e. even after sorting the files under Pattern 1

with respect to temeprature, the subsequently loaded files under Pattern 2 are not sorted

although they may show the respective sample temperature. Data files in batches other

than Pattern 1 can only be sorted after the number of loaded files matches that in the

Pattern 1 batch.

4.8 Fit macros

Mag2Pol offers the possibility to create up to 20 custom fit macros for a convenient

automation of refinement strategies of powder and/or single-crystal data analysis. The

macros can be constructed in a user-friendly and interactive way by entering the Fit macro

window and they can be run from either the fit window or from within the batch fit window

(see previous two sections).

When entering the Fit macro window for the very first time, three built-in macros can

be chosen as an example from the combo box in the upper-left part of the window (see

Fig. 4.18). The first is a sequence of refinement steps to refine the nuclear structure against

a powder pattern. The second concerns the analysis of single-crystal data and the third

cycles through all available irreducible representations in order to return the magnetic

structure which best describes the observed data.

To construct a macro the user needs to drag icon objects from the left part of the window

to the right part of the window and place them on the path indicated by gray connected

squares. Once placed on the macro path a right-click on the icon allows to check the

refinable parameters or choose other options which will be explained below. The available

items and the related fit options are the following

• Scale

Fit options are to refine the powder or single-crystal scale factor, λ/2 contribution

for single-crystal data, overall temperature factor for powder patterns as well as the

option to simply adjust the powder scale factor without refining it. This can be

useful when the scale factor cannot be refined due to insufficient overlap between

calculated and observed peaks.

• Extinction

Set refinement flags for extinction parameters belonging to the three different im-

plemented extinction models (isotropic ShelX, anisotropic ShelX, Becker-Coppens).

The flags to be set depend on the extinction model which is actually used within the

structure model.
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• Atoms

Fit flags can be set for the x, y and z fractional parameters of an atomic position,

the isotropic temperature as well as the anisotropic tensor (for the latter all tensor

elements allowed by the site symmetry will be checked) and the occupation factor

for the case that it is inferior to 1 (i.e. for a split site or a non-fully occupied

site). Furthermore, the refine atom by atom option can be clicked in order to run a

refinement process after adding atomic sites one by one, otherwise fit flags will be

set for all atomic sites followed by a refinement process. It can also be decided to

refine weak scatterers or not which depends on the scattering lengths (neutrons) or

atomic number (X-rays) chosen (top of the window) to define a weak scatterer.

• Magnetic moments

Similarly to the extinction case, model-dependent parameters can be checked, i.e.

depending on how the magnetic moments are described (spherical/Cartesian coor-

dinates, basis vectors). In the case that a magnetic structure is described by basis

vectors of an irreducible representation, it is possible to use the cycle irreps function

which will go through all available irreducible representations, automatically check

the available basis functions (set the multiplying coefficient to 1 µB as a starting

value) and choose the one with the smallest χ2. It is also possible to cycle mixed

representations—either in phase or in phase quadrature—, where all combinations

will be tested and a summary listed by increasing χ2 values will be shown at the end

of the refinements.

A fit flag for the phase of the magnetic moment is also possible as well as to refine

moment by moment (in analogy to refine atom by atom).

• Domains, twins and phases

Fit options are to equally distribute the population of domains, twins and phases and

to set the respective refinement flags. In the case of phases, the switch phase option

allows to activate the next phase in the user-defined model to which the remaining

macro steps will be applied. If all phases should be affected by each macro step,

then the apply to all phases check box can be activated at the top of the window.

• Background

The first option is to initialize background points within the linear interpolation

model. This is automatically done by detecting peaks with I > 5σ between the first

and last excluded region. A background point is then placed between two identified

peaks, if the distance to either peak is at least 3·FWHM. Further options are convert

linear interpolations into other models and the last option is to refine all background

parameters.
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• Offsets

For constant-wavelength powder patterns the refinable offsets are ∆0, ∆x, ∆y and

the wavelength, whereas for time-of-flight data they are Z0,D1 andD2 (see Sec. 7.7.1.6).

For multi-pattern refinements - in analogy to structure models with more than one

phase - the switch pattern option can be activated, if the apply to all patterns option

is deactivated, in order to apply the remaining macro steps to the next pattern in

line.

• Lattice

The first option is to run the indexation algorithm with the last used values in the

cell finder window (including the peak finder slider position defining the peak inten-

sity criterion). The indexation returns the best option, if any, and overwrites the

current lattice parameters. The space group and eventual transformation operator

will not be overwritten. Note that if a cell axes permutation is present, the result-

ing lattice parameters will be attributed to the closest ones of the used structure

model in the case that the nuclear contribution is set to Rietveld (in the case of a

LeBail contribution the lattice parameters will be overwritten as obtained from the

indexation process, since the order is insignificant due to the fact that the atomic

positions do not contribute to the calculated pattern). The remaining options are

fit flags for the lattice parameters a, b, c, α, β and γ as well as for the propagation

vector components qx, qy and qz.

• Profile Here again, the fit options can be set for constant-wavelength or for time-

of-flight data. For the first, u, v, w, η, S, Ig, X and Y (as well as their magnetic

counterparts) can be checked and will be refined, if the respective parameter is

available in the chosen profile function (see Sec. 7.7.1.5). For the latter, the refinable

parameters are σ2, σ1, σ0, γ2, γ1, γ0 and Ig.

• Asymmetry / Rise and decay Asymmetry refers to the constant-wavelength parame-

ters A1, A2, A3, A4 as well as SL and DL (and their magnetic counterparts), whereas

the latter will only be refined, if available in the chosen profile function. For TOF

data, the rise-and-decay parameters α0, α1, β0 and β1 (or κ depending on the profile

function) can be refined.

If in the course of the refinement strategy, it is intended to remove the refinement flag

of a parameter, the same icon has to be placed on the path a second time, but without

checking the respective parameters.

Whole blocks can be moved up and down the path by choosing move block up or move

block down from the context menu. A block consists of the icons between the one selected

and all connected icons down the path. A macro step can be removed by choosing remove
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4.8 Fit macros

Figure 4.18: Fit macros showing a 15-step macro to refine the nuclear structure against

a powder pattern.

from the context menu or by dragging the icon to the left part of the window.

In order to save a fit macro, click on the Save macro button, then select a slot between

1 and 20 and eventually rename the fit macro. The fit macros are saved in the system

registry and will be loaded when entering the Fit macro window. A macro can be cleared,

i.e. all steps will be removed, by clicking on Clear macro and a click on Reset all restores

the 3 default macros from the very first start.
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5 Reflection lists, powder patterns and
maps

5.1 Reflection lists

Once a crystal and magnetic structure has been set up reflection lists can be generated via

the menu entry Generate→Reflection list or using its toolbar icon or shortcut (Ctrl/Cmd

+ L). A window will pop up in which the criteria like the (hkl) or Q range, nuclear and

magnetic structure factors, polarization values can be set. If an orientation matrix has been

entered, then the diffractometer angles (calculated according to the instrument definition,

see Sec. 3.10) and the angle α between the scattering vector and the vertical diffractometer

axis can be used as a criterium as well. In that case it can be chosen, if only accessible

reflections should be listed. By clicking Create list a table will be created which can be

ordered according to a specific value by right-clicking on the horizontal header entry and

choosing ascending or descending. The table can be exported in a format directly readable

by MAD or NOMAD (running on ILL diffractometers) by clicking Save. A demo video can be

seen here.

5.2 Intensity maps

Intensity maps can be generated by triggering Generate→Intensity map, using its toolbar

icon or shortcut (Ctrl/Cmd+ M). All nuclear and magnetic structure factors for integer

and satellite reflections will be calculated (for the current phase in the main window) in

the range from -10 to 10 for h, k and l (this is the initial setting which can be changed

by right-clicking the label Boundaries). The initial view is the (hk0) plane, which can

be changed by defining two reciprocal vectors or the layer in the spin box (see Fig. 5.1).

Note that the vertical direction is shown when hovering the mouse over the label z. The

boundaries can be set for the horizontal and vertical axes in the second line. The resolution

corresponding to the full width at half maximum of a 2D Gaussian function can be set

individually for the h, k and l directions. The intensity maps’ intensity color scale will

automatically be rescaled to the minimum and maximum intensity of the actual map. In

order to compare intensities between different maps or layers, the check box Rescale can
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5 Reflection lists, powder patterns and maps

be unchecked, which will therefore conserve the scale. Furthermore, a logarithmic scale

can be chosen or nuclear scattering can be hidden. Note that all the previous parameters

are saved after closing the map window and will be applied upon the next map calculation.

The maximum and minimum values of the intensity scale can be modified by the vertical

sliders to the right of the map. This can be useful to emphasize weak reflections.

In case of multi-q magnetic structures scattering from differently modulated components of

the magnetic structures can be added. For that the magnetic structure in the main window

should be modified (especially the propagation vector) and regenerated. Alternatively, a

second phase can be added in the main window and set as the current one. Afterwards,

the scattering from that new magnetic structure can be added to the intensity map by

clicking Add. The x, y and intensity values are visualized by hovering the mouse over the

map. Zooming in and out is achieved with the usual mouse controls. Intensity maps can be

saved as pdf or ASCII files by clicking the corresponding button at the bottom. By holding

down the Ctrl/Cmd key while drawing a rectangle a projection will automatically be

calculated and plotted in a new window (see Fig. 5.2). The projection is always along the

shorter side of the rectangle. Zooming and point labels are enabled and the projection

can be saved as pdf and ASCII as well. By holding down the Alt/Opt key an integration

mask can be drawn on the 2D map (note that there is no limit as to the number of masks

on the map). The mask can be moved by dragging it from its upper-left corner and resized

by moving its lower-right corner. The integrated intensity is updated in the label, where

also the x and y range is shown. Integration masks can be deleted by right-clicking either

the upper-left or the lower-left corner (after the mouse cursor changes into an open-hand

or resize cursor).

It is also possible to view maps in 3D (see lower panel of Fig. 5.1). This feature is

particularly interesting for non-orthogonal systems in order to appreciate the real crystal

symmetry. By clicking on the buttong View 3D a new window will open, showing the

map with the same boundaries and color code in three dimensions. The intensity scale

(peak amplitude) and appearance of axis and labels can be adjusted before creating a

high-quality picture.

5.3 Powder pattern

Mag2Pol features the quick simulation of powder patterns which can be done via the

menu entry Generate→Powder pattern or the toolbar icon (see also this demo video). A

new window will open showing the global pattern, i.e. the sum of all phases (see Fig. 5.3).

In the lower left corner of the window the geometry of the instrument can be changed,

i.e. the source (neutron or X-ray), the wavelength and the resolution function via the uvw
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5.3 Powder pattern

Figure 5.1: Intensity map in the (hk1) plane.
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Figure 5.2: Projection along k of the scattered intensity along the (h20) line of the map

shown in Fig. 5.1.
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5.3 Powder pattern

Figure 5.3: Powder pattern showing the nuclear and magnetic contribution separately.

parameters of the Caglioti formula:

FWHM2 = u tan2 θ + v tan θ + w

The powder diffractometers of the ILL (D1B, D2B, D20) can be chosen with different

configurations from the combo boxes which will set the respective parameters automati-

cally. When xray is chosen as source, then a right-click context menu is enabled for the

wavelength value from which different standard x-ray wavelengths can be chosen, which

will automatically use the α1 and the α2 line.

The plot of the powder pattern can be zoomed in with the usual rectangle zoom and

zoomed out with a right click. Hovering over the peak markers below the pattern will

show a tool tip containing the scattering angle and the corresponding (hkl) reflections.

In the Patterns frame the user can change the appearance of the powder pattern (colours

and line styles) and choose whether nuclear and/or magnetic patterns should be shown

individually. An additional broadening of the peaks can be introduced through the ∆w

value for the nuclear and magnetic patterns separately. The individual patterns can be

exported into a text file or the visualized pattern(s) can be exported as a PDF file.

On the right-hand side a preview option allows to follow the changes in the diffraction

pattern as a function of the lattice parameters, propagation vector components or atomic

positions. The nuclear and magnetic structures are modified simultaneously in the main

window (note that the presence of bonds and polyhedra can lead to a notable lag).
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5.4 Magnetization density maps

Magnetization density maps (see an example in Fig. 5.4) can be created by calculating a

Fourier inversion according to:

ρ(r) =
1

V

∑
hkl

M exp[2πi(hx+ ky + lz)]

where the Fourier coefficients are the magnetic structure factors M . Projections, like e.g.

onto the x-y plane are obtained by

ρ(r) =
1

ab

∑
hkl

M exp[2πi(hx+ ky)]

Note that the theoretical magnetic structure factor of the experimentally inaccessible (000)

reflection is added for scaling purposes in both calculated and observed maps. Different

Fourier maps can be chosen from the combo box, e.g. calculated maps with different cut-

off angles corresponding to a critical Qc, observed maps from *.int or *.fli flipping ratio

input files or difference maps. Furthermore, the user can choose from projections, cuts or

slices within custom planes defined by two vectors of the real lattice. The different layers,

or the vertical parameter, can be changed using the arrow buttons (note that hovering the

mouse over the label z will show the vertical direction as a tool tip). A right-click on the

layer value will pop up a context menu from which either the single step value can be set

to the actual shown value or the whole range of layers from 0 to 1 can be calculated at

once. For all calculations the program will make use of the nuclear symmetry in order to

speed up the process, if the apply symmetry checkbox is activated. Note that each map

is only calculated once, i.e. repeated scrolling through already calculated maps will not

cost calculation time. However, when the bin value is changed (or the slice thickness),

all previously calculated maps will be deleted. It has to be noted that the maps will

sometimes show unusual details coming from binning artifacts. Therefore, the default bin

has been set to 0.1 Å and the lattice constants are rounded, which usually gives good

results for the Fourier maps. The zoom controls, projections and integration masks are

the same as for intensity maps in reciprocal space (Sec. 5.2). The magnetization density

maps can also be viewed in 3D (see Fig. 5.4). This feature is particularly interesting for

non-orthogonal systems in order to visualize the correct symmetry (see also this demo

video). The volumetric data can be exported by clicking on the corresponding button and

visualized in other programs, e.g. Vesta [28].
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5.4 Magnetization density maps

Figure 5.4: Slice of 0.2 Å thickness around x = 0.15 in the y-z plane in 2D (upper panel)

and 3D (lower panel). The Fourier inversion is taken up to the highest measurable Qc

with the given wavelength.
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6.1 Sample information

Once a nuclear and/or magnetic structure model has been entered it is possible to see

a summary of the main parameters via the menu entry Tools→Sample info or the tool-

bar icon. Under the Crystal structure tab (see Fig. 6.1) the real and reciprocal lattice

paramters and volumes are shown together with a list of all the atoms in the unit cell.

A list with magnetic moments and Fourier coefficients can be found under the Magnetic

structure tab together with the magnetic symmetry used. All information related to the

absorption correction are shown under Absorption. Note that the interactive tool to cre-

ate the sample model (Sec. 4.2.2) can directly be accessed from here. The last refinement

results can be viewed unter the Fit tab.

Figure 6.1: Summary of basic parameters entered by the user.
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6.2 Space group tables

The space group tables and conversion tools for crystallographic (CSG), magnetic (MSG)

and magnetic superspace groups (MSSG) can be consulted under Tools→Space group ta-

bles or via its corresponding toolbar icon. When entering the window without a previously

defined structure model, the symmetry operators and Wyckoff positions as well as basis

vectors for MSGs can be viewed for any space group with or without basis transformation.

Selecting a space group to set up a structure model including the transformation of the

unit cell and atomic positions is only possible with a previously defined structure model.

The Space group tables window is organized in four tabs, from which the first three are:

CSGs, MSGs and MSSGs (see Fig. 6.2). Space groups can be entered via their (numerical)

labels, e.g. I4/mmm or 139, Pm′n′a or 53.326, P2.1′(0, 0, g)0s or 3.1.5.3.m2.2, or they

can be chosen from the combo boxes where they can also be sorted by system for easier

navigation. As stated in Sec. 2.2, all information concerning MSGs and MSSGs is based on

the computer-readable tables available on the Isotropy Software Suite website [1–3]

and the work published in [4–6]. For further information, the reader may refer to the

excellent reviews [29, 30]. If a space group has been correctly entered its label will be

shown in green (red if not) and the crystallographic information will be shown in the text

window below. This information consists of the operators of the space group (including

time inversion operator for MSGs and the internal variable for MSSGs) followed by the

Wyckoff positions in case the space group has been entered in its standard setting (a few

non-standard CSGs are implemented in Mag2Pol). The basis of any space group can be

transformed to another setting which can be useful to compare a structure with another

one published in a different setting, and is necessary for a reasonable use of MSGs and

MSSGs. The transformation operator can be entered either by writing a string in standard

notation which will display the rotational part R and translational part t of the operator,

or vice versa, by entering R and t which will display the transformation string. The cor-

rect syntax will be shown in green and requires the transformation string to be enclosed

in parantheses, the rotational and translational part to be separated by a semicolon and

the individual axes to be separated by a comma. The identity would be expressed as (a,

b, c; 0, 0, 0), where the spaces are optional. A swapping of the a and b axes with an

origin shift along c would correspond to (b, -a, c; 0, 0, 1/2). Note the minus sign to

conserve a right-handed set of axes and the possibility of entering fractions. The correct

application of basis transformations, especially when entering information obtained from

other tools (e.g. Bilbao Crystallographic Server or Isotropy), will be shown in

the next sections. When basis-transformed symmetry operators are printed as nAo (not

an operator), the transformation was probably wrong.
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6.2 Space group tables

The fourth tab Preview serves to visualize the crystal and magnetic structure in the

main window and allows to modify the degrees of freedom, i.e. atomic positions and basis

vectors of magnetic moments respecting the underlying symmetry. If bonds and polyhedra

were drawn beforehand, the program will show their deformation in real time. Note that

this tool works optimally, when all atomic positions are defined as the first position of

the Wyckoff site (see Sec. 2.2 for a straightforward conversion) and if only positive xyz

parameters are used.

Figure 6.2: Left: Space group tables for crystallographic, magnetic and magnetic super-

space groups containing information about symmetry operators, Wyckoff positions and

basis vectors. Furthermore, any transformation can be applied to any of the space groups.

Right: Preview window allowing to transfer a space group to the main window, to modify

the degrees of freedom and to visualize the crystal and magnetic structure.

6.2.1 Space group transformations

After choosing a space group from the combo boxes or by entering its (numerical) label,

Mag2Pol will always load the untransformed operators and Wyckoff sites regardless of

the given transformation operator. The basis transformation is only applied when clicking

on Transform SG, which will update the crystallographic information in the text box

above, which is also shown by the basis transformation string next to the space group

label.

If the user wishes to transfer the space group to the structure model initiated in the main

window, this can be achieved by clicking Transfer SG in the Preview tab. Several options
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exist which depend on what the user wishes to achieve. If the checkbox convert lattice

constants is activated, the rotational part of the transformation operator is applied to the

lattice which will be updated in the main window. The same applies to convert atomic

positions which - if activated - will convert the position vectors by taking into account

the rotational and translational part. The last checkbox split sites in subgroup should

be activated, when a group was chosen in the Space group tables which is a subgroup of

that in the main window. In this case, the program will identify the symmetry operators

missing in the subgroup and create new atoms in the structure model, if sites split into

different orbits. Two examples will clarify the use of these checkboxes:

• Convert a structure expressed in Pnma to Pnam

Enter the Space group tables with a Pnma structure model in the main window.

The transformation to Pnam is expressed by (a, c, -b; 0, 0, 0) or equivalently

by (a, -c, b; 0, 0, 0) which should be entered in the corresponding field under

the Crystallographic SGs tab. Alternatively, the rotation matrix can be entered,

which will create the transformation string as a confirmation. Click Transform SG

to apply the transformation and check the results in the text box above.

Now switch to the Preview tab. Due to the swap of b and c axes the lattice pa-

rameters and the atomic positions previously defined in the main window should be

updated in order to conserve the structure. Therefore, convert lattice parameters

and convert atomic positions should be activated. On the other hand, all symmetry

operators of Pnam will be different from the ones in Pnam, but the site multiplicity

remains unchanged. Therefore, the split sites in subgroup checkbox should not be

activated. Now click Transfer SG and inspect the structure in the main window.

You can move the sliders or enter values for free positional parameters to verify the

structural degrees of freedom and you can go back to the initial values by clicking

Reset parameters. If the transformation does not show the expected results, it can be

reverted by clicking Reset symmetry which will take the structure back to its state

before entering the Space group tables window. If the Space group tables window was

closed after transferring the space group and converting the structural data, it is still

possible to recover the original structure by right-clicking the Space group label in

the main window and choosing the appropriate action from the reset transformation

menu. Any of the options will set the transformation operator to identity, i.e. the

symmetry operators of the original space group will be used to generate the cell.

The optional conversion of the lattice parameters and the atomic positions will be

done with the inverse of the former transformation operator. In this example, the

correct option would therefore be convert both.

• Convert a structure expressed in Pnma to its non-isomorphic subgroup P21ma
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From the International Tables Vol. A [8] one can obtain the following information

concerning the non-isomorphic subgroup: P21ma (Pmc21, 26) 1; 4; 6 ;7. The sub-

group P21ma is a non-standard setting of space group 26, Pmc21, and the symmetry

operators 1, 4, 6 and 7 of Pnma are conserved. Since Mag2Pol lists the opera-

tors in the exact same order, it is straightforward to compare the respective space

groups. First, set up the structure in Pnma symmetry in the main window and

then enter the Space group tables window (copy the symmetry operators for a more

comfortable comparison afterwards). Choose space group Pmc21 under the Crystal-

lographic SGs tab, which now has to be converted to P21ma. The rotational part

of the transformation is easy to extract by comparing the two space group labels.

Therefore, in a first step the transformation (c, a, b; 0, 0, 0) can be entered

followed by a click on Transform SG. Now, paste the Pnma symmetry operators

below the converted ones and compare operators 1, 4, 6 and 7. It is apparent that

a rotation of the basis is not sufficient and that a shift of origin is necessary. It can

be verified that the correct transformation is (c, a, b; 1/4, 1/4, 0). Enter the

string and click Transform SG (note that for each transformation the original space

group is reloaded before applying the transformation, i.e. one cannot do a chain

of transformations), which should produce the four symmetry operators of Pnma

numbered 1, 4, 6 and 7. The transfer of the new symmetry to the main window

is effectuated in the Preview tab. In this case, the axes and atomic positions have

been transformed to match those of the original structure in Pnma, so the first two

checkboxes should not be activated. On the other hand, since the general multiplic-

ity of P21ma is 4, while it is 8 in Pnma not all atomic positions will be generated

in the subgroup, for which the split sites in subgroup option needs to be activated.

Finally, click on Transfer SG and verify the result.

The conversion from the non-standard setting P21ma to Pmc21, if intended, can be

done by closing the Space group tables window and by resetting the transformation

via the Space group label context menu as explained in the previous point.

6.2.2 Magnetic space group transformations

The basic use of magnetic space groups and their transformations is very similar to the

explanations in the previous section with a few exceptions. The first is related to the

fact that the transformation operators are always applied to the parent space group which

is the definition used by the programs of the Bilbao Crystallographic Server for

example. Therefore, the chosen magnetic space group is transformed with the inverse of

the shown transformation, since the direct transformation is applied to the parent space

group which is (related to) the paramagnetic space group. The second difference concerns
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the transformation of lattice constants and atomic positions which are always calculated

according to the transformation operator under the Crystallgraphic SGs tab. This makes

it possible to effectuate complex transformations of both the CSG and the MSG to obtain

the desired result. A good starting point for finding appropriate MSGs is the use of the

MAXMAGN program [30] on the Bilbao Crystallographic Server. After entering

the crystallographic space group and the commensurate propagation vector one obtains

a list of maximal magnetic space groups. By clicking the Show button in the General

positions column one can obtain both the augmented transformation matrix for the CSG

and for the MSG. How to correctly enter this information will be shown in the following

example from [30].

• Magnetic space group Paca21 as a child of the parent space group Pbam

The use of MAXMAGN with space group Pbam and propagation vector q = (1/2 0 0)

reveals four maximal magnetic space groups, one of them being Paca21 (#29.104),

but in a special setting. First of all, set up the paramagnetic Pbam structure in the

main window and enter the Space group tables window. Here, enter the basis trans-

formation of the parent space group which is given as (2a, b, c; 0, 0, 0) on the

General positions page of the MAXMAGN output (or simply copy and paste it).

Click Transform SG which will result in doubling the symmetry operators of space

group Pbam due to the additional translation t(1/2 0 0). Now switch to the Mag-

netic SGs tab and enter either P aca2 1 or 29.104 which will show the symmetry

operators, Wyckoff positions and basis vectors for that magnetic space group. Enter

the transformation of the MSG, this time given in matrix form in the MAXMAGN

output, which becomes (a, -c, b; 1/8, 0, 0), and click Transform MSG. Alter-

natively, you can also copy the 12 numerical values from the website and paste them

into the table by right-clicking any of the cells and choosing paste (R|t). At this

point it is important to compare the symmetry operators in both tabs. If the trans-

formations were applied correctly, the MSG should be a subgroup of the SG and

reveal a subset of the symmetry operations (primed or unprimed) of the latter. In

this example the 8 MSG operators can be found in the CSG (operators 1, 3, 6, 8,

9, 11, 14 and 16). Now the MSG can be transferred from within the Preview tab.

Since the CSG was adapted to the doubling along the a axis, the lattice parameters

and the atomic positions need to be changed accordingly, i.e. the convert lattice con-

stants and convert atomic positions checkboxes need to be activated. Furthermore,

since the MSG only reveals a subset of the symmetry operators in the CSG, not all

the atomic positions can be generated, for which the split sites in subgroup check-

box needs to be activated as well. Now, click Transfer MSG, inspect the resulting

structure in the main window by adjusting the degrees of freedom under the Crystal
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structure and Magnetic structure tabs and accept the result by closing the Space

group tables window. As described above, the transformation of the MSG can be

converted back to the original Paca21 setting by evoking the context menu on the

Space group label in the main window.

6.2.3 Magnetic superspace group transformations

The use of MSSGs is almost the same as for MSGs with the exception that no transfor-

mation of the parent paramagnetic space group is necessary. When selecting a MSSG

symmetry (either by typing its label or by choosing it from the list) and transferring it

to the main window in the same way as described for MSGs, Mag2Pol automatically

calculates the basis vectors for all the magnetic ions in the structure model. Depending

on their point symmetry certain components may be extinct or relations between real and

imaginary components might exist. Note that the order of basis vectors is not necessarily

the same as shown in the Isoviz plotting tool and that split sites are treated as indepen-

dent sites in Mag2Pol. The interested reader may consult [29] for a complete overview

on MSSGs.

A good starting point to identify possible MSSGs for the underlying crystal structure

and incommensurate propagation vector is the use of the Isotropy Software Suite

website [1–3]. A *.cif file can be exported from Mag2Pol and loaded on the website

to start a new distortion (choose only magnetic). Enter the propagation vector using

Method 2: General method - search over specific k points, enter the necessary propagation

vector coefficients, set the number of incommensurate modulations to 1 [note that only

(3+1)d modulations can be treated with the present version of Mag2Pol] and click OK.

On the next page all necessary input parameters can be found for the different possible

modes. Either extract the information from this page or select a mode and click OK. On

the next page it is possible to download an *.isoviz or *.cif file, from which the latter

can be directly loaded in Mag2Pol after changing its extension to *.mcif. The *.mcif

files downloaded from the Isotropy Software Suite contain the original setting and

the one adapted to a standard paramagnetic space group. On loading the file, it can

be chosen which setting to employ. By selecting Employ parent-like basis vectors on the

first page the *.mcif file will be adapted to the conventional cell of the original structure

(recommended). Note that for MSSGs with origin translations t such that the dot prod-

uct with the propagation vector q is non-zero, the visualization in the conventional cell

might look different than that of the untransformed MSSG. The correct use of the MSSG

transformation is shown in the following example.

• Magnetic superspace group P21/b.1
′(0, 0, g)00s as a child of the parent space group

P21/c with propagation vector q = (0 0.32 0)
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First, set up a structure in P21/c symmetry and export is to a *.cif file which can be

uploaded on the Isotropy Software Suite website. Enter the propagation vector

underMethod 2 by choosing LD, k3 (0, b, 0) and enter b = 0.32, set the number of in-

commensurate modulations to 1 and click OK. On the next page, select the first mode

corresponding to the MSSG P21/b.1
′(0, 0, g)00s. From here the necessary input can

already be transferred to Mag2Pol by entering the given basis transformation. In

this example the output basis={(1,0,0,0),(0,0,1,0),(0,-1,0,0),(0,0,0,1)},
origin=(0,0,0,0) needs to be entered as

R =


1 0 0 0

0 0 −1 0

0 1 0 0

0 0 0 1

 t =


0

0

0

0

 (6.1)

followed by a click on Transform MSSG. Alternatively, the whole string can be copied

to the clipboard, i.e. including e.g. basis or origin, as long as the 20 numerical

values are included. Then, by right-clicking any cell in the rotational or translational

part of the basis transformation, the transformation string can be pasted by selecting

paste (R|t). At this point, it should be verified that the transformed operators

constitute a subset of the ones in the parent space group P21/c. As this is the

case one can transfer the MSSG from the Preview tab. The parent space group is

left unchanged for which no conversion of lattice constants and atomic positions is

necessary. Furthermore, the general site multiplicity is the same in both MSSG and

CSG. Therefore, all the options should be unchecked before clicking Transfer MSSG.

6.3 Data converter

Data from ILL Triple Axes Spectrometers (TAS) and from PSI muPAD can be opened

with Mag2Pol and converted to a *.fli file under certain conditions:

• each Numor contains a 1-point (peak) or 3-point scan (left background - peak - right

background)

• the scan was done using a PAL file which defines the polarization channels to measure

• the information concerning Pi and Pf are listed as output parameters for each point

of the scan

If these criteria are not met, the program will show an error message for each corresponding

Numor which could not be (fully) loaded (see Fig. 6.3). The loaded polarization matrix

elements can optionally be merged in the final *.fli file by activating the corresponding
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6.3 Data converter

Figure 6.3: List of loaded polarization data. Incomplete information will be output with

a warning message.
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checkbox at the bottom of the window. The binning values for temperature and Miller

indices can also be given.

6.4 Irreducible representations

Mag2Pol offers the possibility to calculate the irreducible representations (irreps) which

yield magnetic structure models with different symmetries that are allowed by the under-

lying crystal structure and the propagation vector (see this demo video). The method of

obtaining the so-called little group irreps is based on the induction method which is very

well explained in [31]. In fact, in order to obtain the irreps of space group G(q) one has to

find the irreps of its invariant subgroup G′(q) of index 2 or 3. This co-set decomposition is

done iteratively until the translation group or a cyclic group is reached, whose irreducible

representations can readily be written down. The case of cubic space groups is dealt

with separately in the original paper and has been adopted as well in Mag2Pol. The

irreps of the full group (or paramagnetic group) are induced from the little group irreps

according to the symmetry operators (coset representatives) that transform q to −q or

q1 to q2 following the procedure detailed in [32]. In fact, Mag2Pol offers to use both

the induced irreps (as calculated within the program) and the tabulated irreps following

[32], which—in particular—differ for type-1 irreps that have been brought into real form

in the latter case. Note that both results are equivalent, i.e. the irreps only differ by an

equivalence transformation and therefore the projection operator produces different sets

of basis vectors, which, nevertheless, are linear combinations of one another. The user

can choose between the little group irreps, complex irreducible representations (CIR) and

physically irreducible representations (PIR). The latter are those that are used on the

Isodistort website.

The menu item Generate→Irreducible representations and the toolbar icon will be enabled

after generating a structure with at least one magnetic site. Note that depending on the

magnetic symmetry operators remaining in the little group certain magnetic sites split into

several orbits. This will automatically be updated by the program in the main window,

when a little-group irrep is activated (note that split sites should be grouped together in

the atom list, when a structure model is entered manually, i.e. without using the irrep

tool). Similarly, if the given structure already contains split sites (either because the user

entered them or because the irreps calculation has already been run at least once), they

will not be split again. I.e. the irreps calculation can be performed several times without

the need of modifying the sites in the main window.

Triggering Generate→Irreducible representations will open a new window in which a sum-

mary of the symmetry information will be shown in the Symmetry tab (see Fig. 6.4).
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6.4 Irreducible representations

Figure 6.4: Irreducible representations window showing the symmetry operators, the coset

representation of the paramagnetic group, the atomic positions and a summary of the

calculation.
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The symmetry operators are shown exactly as in the International Tables for Crystallog-

raphy Vol.A including the same order. Further below, the symmetry operators of the little

group are shown, i.e. those symmetry operators which are compatible with the magnetic

translation symmetry. If the little group Gq is a subgroup of the paramagnetic group, the

coset representation will be printed, i.e. which coset representatives induce the group Gqq̄

and G starting from Gq. Then a list containing the magnetic atom positions is shown

including the information if a split orbit is present and which symmetry operator (lost in

the transition) relates the orbits. Under the tab Multiplication table (see the left panel

of Fig. 6.5) one can see how the symmetry operators act under the group multiplication.

The note below the table changes depending on the active cell and adds the information

if a phase shift needs to be applied, when a non-zero propagation vector is present.

The tab Irreps contains the table of the irreducible representations (see central panel of

Fig. 6.5). The combobox at the bottom of the window offers the choice between Irreps

of the little group, Irreps of the paramagnetic group (CIR) and Physically irreps of the

paramagnetic group (PIR). The checkbox to the right, use ISO-IR tables selects between

the irreps induced by Mag2Pol and those tabulated by ISO-IR [1, 32] (for PIRs only the

ISO-IR result is available for the moment). When Gqq̄ is a subgroup of G, i.e. q2 exists

which is not equivalent to q1 or −q1, an additional checkbox multi-q appears. When

selected, additional basis vectors for the different qn will be calculated. This output cor-

responds to the basis vector calculation of Isodistort for a commensurate propagation

vector.

By hovering the mouse over the labels Γ1, Γ2 etc., the Cracknell-Davies-Miller-Love

(CDML) label [33] will be shown as a tooltip, e.g. mGM+
1 , mGM+

2 , etc. This infor-

mation is extracted from the file CIR data.txt based on the work published in [32]. Note

that the CDML labels are shown with respect to the standard setting of the space group,

i.e. the Brillouin zone label might be different for a non-zero propagation vector and de-

pending on the type of basis transformation.

Within the table, eventual exponential factors are abbreviated and explained in the legend

below the table. There are two ways to activate one or more irreps and to use them as a

magnetic structure model. The first is done via a right-click on the vertical header item,

e.g. Γ1, popping up a menu in which this particular irrep can be transferred to the current

phase in the main window (note that the transfer of irreps can even be done while refining

a magnetic structure in the fit window, which allows for a quick testing of different mod-

els). By highlighting two irreps and right-clicking either one a mixed irrep can be set. If

no particular basis vectors are selected in the tab Basis vectors all basis vectors are trans-

ferred to the current magnetic structure in the main window. Note that a maximum of 6

basis vectors can be used per site, for which an error message will pop up, if this number

is exceeded. In that case, or also if certain basis vectors can be excluded, the basis vectors
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to export can be highlighted in the Basis vectors tab (see third panel of Fig. 6.5) for the

corresponding irrep(s). The basis vectors can be visualized in different ways: basis vector

of the first atom of each site normalized to 1, normalized with abbreviated exponential

factors or with the smallest component normalized to 1. Note that the basis vector will

always be exported normalized to 1 so that the multiplying coefficients can be interpreted

as Bohr magnetons. Each basis vector can (repeatedly) be multiplied by i, e.g. to combine

two irreps in phase quadrature. By default the basis along the principal crystallographic

axes is chosen in order to calculate the basis vectors. An orthogonal basis can be chosen

instead by activating the corresponding checkbox. A right-click on the checkbox opens a

menu that allows the user to introduce a custom basis by entering 9 numerical values that

are interpreted as 3 vectors (click set basis). If the checkbox is activated, Mag2Pol will

check if the vectors are orthogonal. The basis can be reset to its default value by clicking

reset basis in the popup menu.

The second way of activating one or multiple irreps is via the Preview tab (see right

Figure 6.5: Irreducible representations window showing the multiplication table, the irre-

ducible representations, the basis vectors and the preview sliders with an order parameter

constraint.

panel of Fig. 6.5). Here, the corresponding irrep can be chosen from the combobox and

then activated by clicking the on/off button next to the combobox. Sliders permit the

direct visualization of the magnetic structure in the main window. Note that only the first

six non-zero basis vectors will be considered per site. The shortcut Shift+Z sets all basis

vectors of the selected irrep to 0. An additional irrep can be activated by selecting it in

the combobox and clicking on the on/off button again.

When a CIR or a PIR is chosen, the order parameter direction (OPD) can be specified.

Special OPDs result in constrained basis vectors and a higher magnetic symmetry, and can

directly be transferred from the Isodistort output for the case of a PIR (or a type-1 CIR,

since type-2 and type-3 PIR have double the dimension compared to the corresponding

CIRs). The correct OPD syntax is fed back by green text, red otherwise. A right-click

on the OPD field allows to reset the order parameter direction to the general one. For
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example, the irrep mX1 of space group P4 with an OPD of (a;a) reveals a magnetic

structure with P4 symmetry, instead of P2 for an OPD of (a;0) which corresponds to

the little-group symmetry. Note that with CIRs and PIRs it is not necessary to multiply

basis vectors by the imaginary factor as for little group irreps, since the imaginary coun-

terparts are automatically calculated if −q is not equivalent to +q.

The coefficients, which are multiplied to the basis vector can also be set in the main win-

dow (under the Magnetic structure tab). The irreps information will be saved in the input

file, so that the calculation does not need to be repeated. Hovering over the coefficients

in the main window will show tool tips explaining to which irrep and basis vector the co-

efficients belong. Note that when the magnetic structure results from an irrep calculation

it is not necessary to explicitly enter the magnetic symmetry operators by hand. They

are internally stored together with the corresponding magnetic phases. One can also look

up the basis vectors in Structure→Basis vectors and change the way of setting up the

magnetic strucure, i.e. use symmetry-adapted basis vectors from the irreps calculation,

use user-defined basis vectors or use no basis vectors at all (i.e. use uvw coefficients).

6.5 Spin correlations

Mag2Pol offers a spin-correlation tool which calculates the spin-correlation function

⟨S(R)⟩, the intensity as a function of Q and the magnetic pair distribution function

(mPDF). To calculate those distributions it is only necessary to enter a magnetic structure

in the main window and click on Tools→Spin correlations or the corresponding toolbar

icon. A new window will open and the 3 distribution functions will be calculated based

on the Rmin and Rmax values which can be set to the right of the ⟨S(R)⟩ plot. For the

I(Q) and mPDF plots start and end values as well as a step width can be chosen. For

the latter the resolution can be taken into account via a FWHM value. The underlying

formalism is explained in Sec. 7.6.

The structure plot offers the same functionalities as the main window, i.e. one can click

on the atoms and spins to retrieve information concerning the position, spin components,

distances and angles. In the spin-correlations window the 3D plot is interactively linked

with the 2D plots of the respective distribution functions. Shift-clicking two atoms to

evoke their distance will automatically show the corresponding distance in the ⟨S(R)⟩
and mPDF plots. It also works the other way round: clicking on a bar in the ⟨S(R)⟩
bar plot will draw the bond between all spins separated by this particular distance. This

offers an intuitive way to understand the correlation functions. All distribution functions

can be exported either as PDF or ASCII via the File→Export menu.

The spin-correlation tool furthermore offers the possibility to visualize the results of reverse

Monte-Carlo simulations performed with the Spinvert program [34]. This can be done
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by opening a * spins xx.txt file containing the spin configuration within the supercell.

Note that the atomic positions in Spinvert andMag2Pol should roughly agree (precision

of 0.01) in order to identify the correct positions for plotting the structure. The Rmax

value will be set automatically depending on the used supercell. Eventually there is a

huge number of spins in the supercell, therefore, in order to increase rendering speed and

fluidity the object resolution can be reduced. The visualized supercell can also be adapted

using the box boundary values.

Figure 6.6: Spin-correlation window showing the magnetic structure and the different

distribution functions. The 2D and 3D plots are interactively linked to each other so as

to identify correlations at a particular distance.

6.6 Multi-q magnetic structures

Multi-q magnetic structures, e.g. conical or fan-like structures, are not only beautiful

but also tricky to visualize. With Mag2Pol this is very easy to do. One only needs

to set up two phases in the main window (see Sec. 2.2) which have exactly the same

crystal structure (note that different space groups may be used as long as the atomic

positions coincide), but different magnetic parameters. In the example shown in Fig. 6.7

a ferromagnetic (q=0) component along the c axis has been used together with a helical

component in the a-b plane modulated by the propagation vector q=(0 0 1/7). In order to
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visualize the resulting multi-q structure one has to click on Tools→Multi-q structure or the

corresponding toolbar icon, which will open a new window. The case might occur where

the different components have been set up with a different number of magnetic domains.

If the domain number to plot is superior than the number of domains in that phase, then

the first domain is chosen by default. In order to combine more than two q vectors, e.g.

for skyrmion lattices, a single phase with different q-domains can be set up.

Figure 6.7: Multi-q window showing the superposition of two magnetic structure com-

ponents, one being ferromagnetic along the c axis and the other one being a helically

modulated component in the a-b plane. The resulting superposition is a conical magnetic

structure. The modulated in-plane component can be emphasized by an ellipse, where

the spin direction is marked by a thin cylinder (left panel) or by a cone tracing the spin

rotation (right panel).

6.7 LATEX export

The presentation of nuclear and magnetic structure parameters as well as information

about the magnetic symmetry are the central part of a scientific report or publication.

With Mag2Pol it is possible to create tables in LATEX format containing

• nuclear structure parameters (including standard deviations from the last accepted

and saved refinement)

• magnetic structure parameters (including standard deviations from the last accepted

and saved refinement)

• the multiplication table of the given space group or little group
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• the table of irreducible representations

• the table of basis vectors for a given irreducible representation and atomic site

These tables can be copied to the clipboard by clicking on Tools→LaTeX export and pasted

into an open *.tex document.

6.8 Pattern editor

The pattern editor is a tool which offers the following features

• plot patterns in 1D, 2D and 3D and export as *.pdf

• add offsets on the 2θ/TOF/Q/d and counts axes of loaded patterns

• create new patterns by building sums and differences

• export patterns in the Mag2Pol format

• index patterns (see Sec. 6.9)

Patterns can be loaded by clicking the Load button and then selecting the corresponding

format from the input dialog window. If the wrong format was chosen, an error message

will be shown, otherwise the patterns will be shown as a 1D-plot in the panel on the

left part of the window. The loaded files and the corresponding properties are shown

in the table on the right. It contains the file name, wavelength (or D1 values for TOF

data), temperature, offsets and plot styles. The table can be sorted according to file

name, wavelength/D1 or temperature by right-clicking the respective column header and

choosing either ascending or descending from the Sort menu. The listed temperature can

be switched between sample, regulation and setpoint by right-clicking the temperature

header and selecting from the list within the Temperature menu.

As in all other plots zooming is done by clicking and dragging, while a right-click re-

establishes the boundaries which are specified above the plot. If these are changed by the

user they can be reset to the optimal values by right-clicking any of these values and then

clicking reset boundaries. The first button to the right of the plot boundaries switches

between 2θ/TOF, Q and d-spacing for the x axis. The remaining three buttons toggle the

legend, error bars and plot grid, respectively. Hovering the mouse over the data points

shows the 2θ values and counts when no more than 5 patterns are plotted.
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The appearance of each data set can be modified with the respective line and marker

options and the checkbox Show allows to show or hide a particular pattern. A right-

click on the Show header allows to select between Show all, Show every nth and Hide all.

Choosing the second option will open an input dialog in which the value n can be entered.

In 1D-plotting mode or in order to manipulate and export patterns, offset values can be

added to the 2θ or counts axes. There is a convenient way to apply a gradual offset and

even a gradual color change to all visible patterns: Select the offset/color of the first and

last visible pattern in the table and then right-click on the respective column header and

select Set gradient. Choosing Set as first obviously sets the respective property to the one

for the first pattern in the list. The legend entries can be either typed in manually or set

to the temperature (the one selected in the table) or to the file name by right-clicking the

Legend header and selecting the corresponding option.

When at least 2 patterns are visible the View 2D button is enabled which - after activating

it - shows all visible 1D patterns in a 2D plot where the vertical axes corresponds to the

temperature and the intensity is represented in a color code. Zoom and plot boundaries

work as in 1D mode, additionally, the minimum and maximum values of the color bar can

adjusted by the vertical sliders on the right side of the plot. Note that any offset values in

2θ and counts are only considered in 1D plots. The reset boundaries context menu further

allows to set the map’s bin size on the temperature axis and to set the interpolation mode

(on or off).

Clicking the button Export plot will save the shown plot (1D or 2D) in *.pdf format.

As for other 2D maps holding down the Ctrl/Cmd button and zooming will calculate

the projection of the data along the shorter side of the rectangle and the result will be

shown in a new window. After a 2D map has been plotted it can also be shown in 3D by

clicking on the enabled button View 3D which opens a OpenGL plot. Like for intensity

and magnetization density maps the plot appearance can be adjusted and the plot can be

exported in high resolution.

The loaded list can be cleared or exported in Mag2Pol format with *.m2p extension by

clicking on the Clear or Save all button, respectively. Individual patterns can be exported

or removed by right-clicking the vertical header number. The file name shown in the table

will be used to save the file, however, the program will remove any other extension and

replace it with *.m2p, therefore, no original data can be overwritten. Note that patterns

are always exported in 2θ or TOF, even if the pattern is plotted against Q or d-value.

New patterns can be created from the loaded ones, e.g. sums or differences, by typing

an equation in the field below the table. Each pattern is represented by the letter p and

by its corresponding number in the table. Each pattern, e.g. p3, needs to be preceded
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by a multiplying factor, e.g. 2*p3 and the different patterns are combined by either the

+ or − sign, e.g. 2*p3-1*p4. The correct syntax is visualized by a green font, while a

red font means that there is an error in the equation. When the font is green, the Create

button becomes active and clicking it creates a new pattern which is added to the table

and plotted. At the same time the standard deviations are calculated according to the

error propagation rule.

6.9 Indexation of powder patterns

The indexation tool, which helps to determine the unknown cell from the instrument ge-

ometry and the observed peak positions in a powder pattern, is based on the successive

dichotomy method [35–37]. It can be opened from within the pattern editor by clicking

on the cell-finder button (on the far right above the pattern plot) after loading at least

one powder pattern file. When multiple patterns are loaded, an input dialog will pop up

to determine which pattern should be indexed. All remaining patterns will be removed

from the plot in order to improve visibility.

The cell finder window contains all necessary input parameters and options for running

the successive dichotomy method and in principle it is not necessary to change a lot of

them. First of all, the user needs to identify the positions of observed peaks. This can

be done by clicking and dragging individual peaks in the pattern plot, but an automatic

peak search provides a quicker result. The latter is triggered by simply moving the slider

below the Peak finder label, where the far-right position corresponds to including peaks as

weak as 1/100 of the maximum peak intensity. The detected peaks will be marked by dark

blue rectangles in the pattern editor. It is possible to add (left-click), remove (right-click

on a blue rectangle) or move (by dragging the blue rectangle) peaks. The information is

automatically updated in the cell finder window. Peak positions can also be updated in

the obs column of the table, which will in turn modify the position of the peak marker.

The lattice systems which are checked will be tested individually starting from the cu-

bic case working its way down to the less symmetric ones. The indexation algorithm is

very fast down to the orthorhombic case for which it is reasonable to make a prelimi-

nary search including cubic, hexagonal, tetragonal and orthorhombic systems. Note that

trigonal an rhombohedral systems are included in the hexagonal case, the latter via the

hexagonal setting of rhombohedral space groups. When this preliminary search does not

yield any result or at least no convincing result, then the monoclinic and triclinic cases

can be tested separately.
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Figure 6.8: Upper panel: Pattern editor showing diffraction patterns in 1D mode. Center

panel: When at least 2 diffraction patterns are set to be shown, a 2D thermodiffractogram

can be shown by clicking on the View 2D button. Bottom panel: After viewing the plot

in 2D the View 3D button can be clicked which opens a 3-dimensional OpenGL plot of

the thermodiffractogram.102
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The Precision section contains several options which will influence the number of so-

lutions which will be found, e.g. to use the first m peaks and allow a maximum of n

impurity peaks within those m peaks. ∆obs defines the absolute error which is tolerated

when comparing a calculated with an observed peak position. The VS/Vmin value is a

criterion for new solutions with volume VS to be kept after another solution with Vmin

has been found. With the default value VS/Vmin only solutions with the same or smaller

volumes will be kept, while increasing this parameter will keep more solutions and can

be useful when a non-zero number of impurity peaks is expected. Vmax is the maximal

volume a solution can have and the search is carried out in shells of 400 Å. All found

solutions will be refined including at least the lattice constants as refinable parameters

(other parameters, like offsets, will be explained later) and it can be chosen in which σ

interval solutions are considered to be equivalent. Furthermore, the use reduced (Niggli)

cell option can be checked in order to avoid equivalent solutions in monoclinic and triclinic

symmetries (the Niggli cell is calculated using the algorithm described in [38]).

In the Ranges section the minimum and maximum as well as the step values of linear

and angular cell parameters can be entered. Note that the maximum angle of triclinic

angles is internally limited to 115◦.

The Refinement section contains a reduced but sufficient amount of parameters to be

refined. The refinement can be done either only on the peak positions of those peaks

included in the algorithm or by doing a full-pattern LeBail fit. The latter is activated

by checking the corresponding checkbox. The three offset parameters can be refined to

both refinement options, whereas the remaining parameters only apply to the LeBail fit.

A profile function can be chosen from a combo box and the points of a linearly interpo-

lated background can be refined. Note that an approximate description of the peak width

(through the uvw parameters for constant-wavelength patterns or through the σn and

γn values for TOF data) is necessary for a correct initialization of the background. The

peak width and asymmetry parameters can in turn be refined depending on the chosen

profile function. A right-click on the Le Bail label evokes a context menu from which the

configuration of different diffractometers can be set conveniently. Once a set of solutions

is found, it can be refined using different fit flags by clicking on Refine solutions.

The search algorithm is started by clicking the Find solutions and refine button. The

progress of the search and the number of solutions found in every step for each symmetry

is printed in the output box in the lower-right part of the window. If one or more solutions

have been found, a space-group analysis will be performed by checking the compatibility

of the m observed and used peaks with all space groups of the respective lattice system.
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Finally, the list of solutions will be shown in the lower part of the window sorted by in-

creasing χ2 value of the refinement process. The table lists the lattice system, the refined

lattice parameters, the refined volume, the most symmetric compatible space group, the

number of unindexed observed peaks as well as the figures of merit M20, FN and χ2. M20

is given by

M20 =
Q20

2⟨ϵ⟩N20
(6.2)

with Q20 being the Q (∼ 1/d2) value of the 20th observed peak, N20 the number of

different calculated Q values up to Q20 and ⟨ϵ⟩ the average absolute discrepancy between

the observed and calculated peak positions. FN is given by

FN =
1

⟨ϵ⟩
N

Nposs
, (6.3)

where Nposs is the number of possible peaks up to the N th observed line. More information

can be found in [39].

The different solutions can be shown by clicking on the vertical header number of the

solutions table, which will update the calculated angles and (hkl) indices in the peak

table as well as the predicted peak positions in the pattern editor. If the LeBail fit option

was activated, the refined pattern is shown in addition to the predicted peak positions. In

that case, it is also possible to visualize the expected peak positions within the different

compatible space groups. This can be done by right-clicking the space group label and

choosing a different space group from the context menu, which automatically refits and

displays the LeBail fit in the pattern editor. In order to improve clarity the peak markers

originating from the peak finder tool together with the indexed peak markers can be

removed by toggling the respective checkboxes in the Peak finder section. The influence

of the lattice parameters on the calculated peak positions can be studied by clicking a

parameter value in the lower-right corner of the window and by dragging the slider, which

will in turn modify the light blue markers.

6.10 Propagation vector finder

The first step in analyzing a magnetic structure from powder neutron diffraction data

is indexing the magnetic Bragg peaks for which it is necessary to know the propagation

vector, i.e. the magnetic translation symmetry in comparison to the nuclear cell. When

the propagation vector is unknown, but a number of additional magnetic intensities are

observable in the diffraction pattern, then the satellite tool in Mag2Pol can be used. It

can be found in the fit window under the Patterns tab and is ideally launched after the

nuclear scattering has been correctly described. A click on the Satellites icon opens a new

window which will list the selected satellite peaks and provides control for the subsequent
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Figure 6.9: Upper panel: Cell finder window showing the results of an indexation run.

Lower panel: Visualization of one of the results in the pattern editor.
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search for a possible propagation vector (note that the corresponding phase needs to be

activated in the fit window before entering the Satellites tool). In order to add a satellite

to the list, simply left-click on a magnetic Bragg peak in the pattern (note that the zoom

controls are still active). A vertical dark blue bar will be drawn at that position and the

corresponding 2θ/TOF value will be shown in the obs column of the table in the Satellites

window. The selection can be modified by hovering the mouse over the vertical bar - which

changes the mouse cursor to an open-hand symbol - and dragging it to another position.

In order to assist the user in finding the best possible position, the height of the bar will

be modified in order to reflect the amplitude of the satellite peak at that position. The

position can also be modified in the table which is synchronized with the plot. A selected

peak can be deleted by right-clicking on the vertical bar.

After selecting a few satellites, the search for a possible propagation vector can be started.

Different propagation vector symmetries can be included in the search algorithm, whereas

the high-symmetry lines of the Brillouin zone are selected by default. The checkboxes in

the second row denote planes in the Brillouin zone and activating the box in the third row

would include the search of a propagation vector with triclinic symmetry. Initial guesses

for possible propagation vectors are generated with a user-definable step size along the

a∗, b∗ and c∗ directions and the best n guesses (in terms of χ2, n = 20 by default)

will be used as starting parameters in a least-squares refinement with the corresponding

refinable parameters. Note that the explored parameter range depends on the centering

label of the space group. The results of the refinement are shown in the table in the

lower part of the Satellites window sorted by decreasing χ2 values. The best result is

automatically highlighted and the calculated positions are shown as larger light-blue bars

in the diffraction pattern as well as in the cal column of the upper table. The difference

between the observed and calculated positions is shown together with the corresponding

(hkl)± indices. By clicking on the vertical header labels one can cycle through the different

results, which will update the plot in the fit window. It is also possible to manually modify

the refinable propagation vector components. This can be done by clicking on one of the

three q components in the lower-right part of the Satellites window and then by dragging

the horizontal slider below the values, which will move the calculated peak positions

in the pattern plot. This is particularly useful to check, if a resulting q component is

incommensurate or not.

By clicking the OK button, the propagation vector is transferred to the active phase of

the active pattern in the fit window.
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Figure 6.10: Upper panel: Selected magnetic satellites shown by dark blue vertical bars.

Lower panel: A list of possible propagation vectors is shown with decreasing χ2 values.
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6.11 Guides to the eye

Certain nuclear and magnetic structures benefit from guides to the eye which highlight

their peculiarities. With Mag2Pol such hints can be added to the OpenGL unit cell plot

in 3D through the following objects (with their corresponding customizable properties):

• Arrow (position, direction, shaft radius, cone radius, cone length, color)

• Cylinder (start position, end position, radius, start color, end color, transparency,

gradient)

• Sphere (position, radius, color)

• Ellipse (position, first axis, second axis, color, transparency)

• Torus (position, first axis, second axis, radius, color)

• Spiral (position, first axis, second axis, radius, height, windings, phase, start color,

end color)

• Sine (position, propagation direction, amplitude, radius, cycles, phase, start color,

end color)

• Plane (at least 3 points, color, transparency)

• hkl plane (hkl indices, color, transparency, family)

• Box (position, length, width, height, color, transparency)

• Text (position, text, font size, color)

All positions are given in fractional coordinates with respect to the unit cell (just like

atomic positions), while all vector quantities are defined in units along the crystallographic

axes, i.e. in the same way as magnetic moments (the length corresponds to the that of

magnetic moments with a plot scale of 1.0). Note that the vectors are not normalized,

i.e. the size of an ellipse or the wavelength of a sine (through the propagation direction)

depend on the length of the vectors. The best way to invert the handedness of a spiral is

to define negative number of windings (it is also possible to define a negative height, but

the spiral will propagate in the opposite direction). Depending on the object it is possible

to define the transparency or a color gradient.

The Guides to the eye window can be accessed via the Tools menu or directly via its

toolbar icon. It shows a list of all guides to the eye presently defined in the unit cell plot.

From here it is possible to create a new guide to the eye (New button), modify a present
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one (Edit button), duplicate (Duplicate button) or delete it (Delete button). A click on

the New button opens a dialog from which one of the listed objects can be chosen. This

opens another window in which the respective properties can be entered (see Fig. 6.11).

Atomic positions and spin vectors can be pasted into the respective fields by selecting an

atom/spin in the unit cell plot and then by right-clicking on the respective label in the

object dialog (e.g. Position, Start, End, Direction, etc.). By selecting two atoms (as for

calculating the distance) the right-click menu allows to copy the midpoint between those

two atoms.

The visibility of guides to the eye can be triggered in the settings window under the

Figure 6.11: Guides to the eye window (left) showing a list of objects which are depicted

in the unit cell plot. New guides to the eye can be created, edited or deleted. A click on

the New button opens a dialog from which one of the implemented objects can be chosen.

Afterwards, the object can be customized in the object property window (right).

Plot tab. The figures below show some examples in which 3-dimensional guides to the

eyes may be useful (and one example where they are absolutely useless).

6.12 Phase transitions

In single-crystal diffraction experiments, nuclear and/or magnetic phase transitions are

best identified and illustrated by following e.g. the integrated intensity of selected Bragg

reflections as a function of temperature, magnetic field or pressure. Mag2Pol offers a

109



6 Tools

Figure 6.12: Examples of 3-dimensional guide-to-the-eye objects.
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Phase transition tool which helps to find appropriate (hkl) reflections showing a significant

difference between the involved structures, or - the other way round - to check if certain

structures explain an observed transition. In order to use this tool it is necessary to define

at least 2 phases in the main window, which are listed in the upper left part of the Phase

transitions window. Each phase is given an x value according to its number, which can be

changed in order to be taken into account in the plot on the right part of the window. In

the lower left part, a list of Bragg reflections reflections can be created by entering the h,

k, l and ±q values and clicking the Add button. The quantities according to the combo

boxes y axis1 and y axis 2 will be calculated and plotted against the different phases.

The plot can be modified with respect to the marker and line styles (note that a different

style is automatically applied for the right y axis, if enabled). User-defined axes, tick and

legend labels can be entered to customize the plot, which can be exported as a pdf or

ASCII file. Reflections can be removed by right-clicking the vertical header labels and

then clicking Remove reflection.

Figure 6.13: Phase transitions window.

6.13 Crystal calculator

After a crystal structure has been generated in the main window, the crystal calculator can

be used to compute distances, angles, vector cross products as well as matrix products and

inversions. Distances and vectors will be shown in the unit cell for a visual confirmation.

• Distances
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Two positions need to be entered in fractional coordinates of the direct lattice. The

result is given in Å and the points and distance are shown in the unit cell plot.

Similarly to the guides to the eye window, a right-click on the Position 1 or Position

2 label allows to copy the position of a previously selected atom (or the midpoint of

two previously selected atoms) in the main window unit cell plot.

• Angles

Here, two options are possible: the angle can be calculated by defining either two

vectors or three points. The angle which is plotted in the unit cell depends on the

Show checkbox. The vector coefficients can be entered in different bases and can even

be mixed which allows all the flexibility for the user. The direct and reciprocal bases

have the direct and reciprocal lattice vectors as basis vectors. The spin basis uses

the normalized direct lattice vectors as a basis. The diffractometer and Busing-Levy

bases refer to the orthonormal coordinate axis of the instrument (as defined in the

Instrument window) and of the Busing-Levy reference frame, respectively. Again,

a right-click on the vector and position labels allows to copy the atomic position or

spin direction of previously selected objects.

• Vectors

Two vectors can be entered using different bases and the cross product can be ex-

pressed in another basis. This allows for example to calculate the spin direction

which would maximize the intensities of two magnetic Bragg reflections which are

expressed by reciprocal lattice vectors as shown in Fig. 6.14. Another useful appli-

cation is to deduce the angle between a crystal axis or a magnetic moment and the

vertical diffractometer axis (UB matrix necessary). The labels Vector 1 and Vector

2 can be right-clicked in order to copy the spin values of a selected spin in the main

window unit cell plot and a right-click on Cross product copies the result to the

Angles tab for eventual further calculations.

• Matrices

The product of two matrices or the inverse of a matrix can be calculated. Right-click

context menus can be used to set the rotation matrix of a symmetry operator or to

copy the resulting matrix to one of the first slots in order to make another calculation.

If the matrix that has been set or calculated corresponds to the rotational part of a

symmetry operator the label of the latter will be shown as a tooltip when hovering

over the matrix elements.

• Magnetization

The magnetization along a given axis can be calculated, if the magnetic structure

model in the main window is ferro- or ferrimagnetic. The result is given in SI and
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CGS units and can be conveniently converted by directly modifying the respective

values and units.

Figure 6.14: Crystal calculator window with the different options under the 4 tabs Dis-

tances, Angles, Vectors and Matrices. The example shows the cross product of two vectors

given in reciprocal lattice units, where the result is converted to spin coefficients which can

directly be used to generate a magnetic structure which would maximize the intensities of

these two reflections, whose (hkl) planes are visualized as guides to the eye.

6.14 Cell animation

The unit cell plot of a crystal or magnetic structure can be animated in order to provide

a better understanding of the structural characteristics in different perspectives. Such an

animation can be useful to create vivid clips which can be used in presentations. The Cell

animation tool allows to do this in a very intuitive way.

After opening the tool via Tools → Cell animation or the corresponding toolbar icon,

one can choose from three built-in animations. Up to ten user-defined animations can be

saved and played from any *.xml file. The section Initial position defines the start of the

animation which is expressed in spherical coordinates, where θ is the rotation angle around

the viewport y axis (pointing upwards), ϕ is the rotation angle around the viewport z axis

(pointing out of the viewport, towards the observer) and χ is a rotation around the c∗

113



6 Tools

axis of the unit cell. The horizontal and vertical translations of the structure within the

viewport can be set with dx and dy. The zoom and depth values are the same as in the

unit cell plot in the main window (the latter is only used, if the perspective projection

is activated via the corresponding button). The easiest way to set a cell orientation is to

manipulate the structure in the OpenGL plot and to click the Get button afterwards.

The opposite can also be done, by adjusting the angle, offset and zoom values and then

by clicking the Set button, which will position the cell in the OpenGL plot.

The next part is the Animation sequence, where the number of steps and the frames per

second (fps) can be set. For each step, the difference in the orientation, position and zoom

values of the cell are adjustable in the same way as for the initial position, i.e. using the

Get and Set buttons. In addition, the duration (in seconds) of each step can be set. A

click on the Play button shows the animation in the main window, which can be recorded

using a separate screenshot tool. Alternatively, the graphics can be exported at each step

by activating the checkbox under the Export setting section. The zoom factor has the same

function as for exporting graphics from the main window. The output folder has to be set

and an optional file prefix can be set to which the extension stepnumber imagenumber

will be added.

6.15 Bond distances

This tool generates a list of bond distances between user-definable atoms and ranges

and offers the visualization of individual bonds from the list. After correctly generating

a crystal structure, this tool becomes available under Tools → Bond distances. Upon

entering the Bond distances window, atom pairs can be chosen from the combo boxes

under Atom 1 and Atom 2 which are ordered by elements and—after the separator—

by sites. For each chosen atom pair the minimum and maximum bond lengths can be

constrained. A click on the Add button adds the bond distance parameters to a numbered

table. The bonds corresponding to that input are shown in the bottom table. Note that

the information in the upper table can be modified as the bottom table is synchronized. By

clicking on the value of a particular bond length, the corresponding bonds are plotted in

the main window. Two options are available for increased visibility: (1) by activating hide

present bonds and polyhedra, the user-defined structural characteristics are temporarily

removed in order to clearly display the selected bonds. (2) The option show all connected

atoms extends the plot boundaries to include connected atoms outside of the user-defined

box. The bond distance table can be exported to an ASCII file by clicking on the button

on the lower-right of the window.
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Figure 6.15: Cell animation window showing the built-in sequence which focuses on the

three high-symmetry projections of an orthogonal system.
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6.16 Polarization matrix plot

Instead of listing all individual elements in the View data or View results windows, polar-

ization matrices can be visualized in matrix form using a polar color gradient going from

red (+1) over white (0) to blue (-1). Hereby, the table will be read from top to bottom

and different matrices (corresponding to (hkl) values and the cross section, e.g. ++, −−
etc) will be filled. This feature produces meaningful plots, when a certain structure of the

table exists, i.e. the matrix elements should be grouped by Miller indices and cross sections

and repeated measurements should be averaged first. Such a case is shown in Fig. 6.16

where eight complete polarization matrices were recorded, which are conveniently shown

in an automatically created grid. The table to the left lists the different reflections and

the measured cross section (i.e. the sign of the polarization and analysis axes) and some

plot controls. The plot checkbox toggles the visibility of the respective matrix, the index

is the placement in the grid (and allows to modify the plot order) and the label is based

on the (hkl), which can be modified by the user. The matrices are by default plotted

with elements Pi,f (according to the way of working on the D3 instrument), where i and

f stand for the direction of the polarization and analysis axes, respectively. The plots can

be transposed by selecting Pf,i from the combo box in order to plot matrices according to

the correct definition relating the incoming and final neutron polarization by Pf = PPi

(for the rotational part), see also Sec. 7.2. Different plot types can be chosen from the

next combo box, which is rather self-explaining. Nevertheless, note that the graphical rep-

resentation of the error bars is encoded in the gray scale of the marker edge which ranges

from 0 (black) to the maximal error among all observations (white). For plots comparing

calculated and observed values each marker is horizontally divided into left = observed

and right = calculated. Hovering above the matrix elements will show the exact values as

a tool tip. The checkbox numbers also allows to plot the numerical data/results in matrix

form. A right-click on any matrix evokes a menu from which one can choose to copy the

LATEX code to the clipboard (note that this option is disabled for observed vs. calculated

comparisons).
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Figure 6.16: Matrix color plot of a fit result with data containing 8 complete polarization

matrices.
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7.1 Basic equations

Mag2Pol uses the plane wave function following conventions of quantum mechanics,

which is generally used for neutron scattering and which is the complex conjugate of that

used in x-ray scattering:

ψQM = ψ∗
XR = ei(kr−ωt)

which requires

b = b′ − ib′′ with b′′ > 0

for the scattering length and yields the scattered wave as a superposition of the plane

wave and the spherical wave in the form of

ψ(r) = eikr + f(θ, ϕ)
eikr

r
.

The scattering amplitude is the Fourier transform of the scattering potential and is given

by

f(θ, ϕ) ∝ −
∫
V (r)e−iQrdr

with the scattering vector Q = kf − ki. Note that using the conventions for X-ray

scattering or Q = ki−kf leads to the complex conugate of the scattering amplitude. The

nuclear structure factor can therefore be written as

N(Q) =
∑
j

ojbje
−2πi(hxj+kyj+lzj)e−Bj sin

2 θ/λ2

with the second exponential term being the Debye Waller factor. The sum is done over

all the atoms in the unit cell and oj denotes the multiplicity and occupation of atom j.

Note that the leading minus sign has been dropped as the square of the structure factor

is used in all calculations.

The magnetic structure factor writes as

M(Q) =
∑
j

pnojSjfj(Q)e−2πi(hxj+kyj+lzj)e−Bj sin
2 θ/λ2

where pn = 0.2695420113693928312 is the conversion factor between Bohr magnetons and

scattering lengths. A factor 0.5 is applied, when the non-zero propagation vector +q is
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inequivalent to −q. Sj are the Fourier coefficients of the magnetic moment expansion

according to

µ =
1

2

∑
q

Sqe
iqR + S∗

qe
−iqR

The Fourier coefficients of a given magnetic moment contain a phase factor determined

by symmetry and a refinable one. For the calculation of (hkl) − q satellites the complex

conjugate of Sj .

The calculated intensities, which are to be compared to the observed ones, are given by

IN (Q) = scale · y ·NN∗

and

IM (Q) = scale · y ·M⊥(Q)M⊥
∗(Q)

with the magnetic interaction vector

M⊥ = Q̂× (M(Q)× Q̂)

scale is a simple scaling factor and y is the extinction correction mentioned in Sec. 3.3.

7.2 Polarization matrices

The polarization values are calculated using the density matrix formalism [40] according

to

Pf =
Tr(σ · M · ρ · M†)

Tr(M · ρ · M†)

with

σ =

(
Pf,z Pf,x − iPf,y

Pf,x + iPf,y −Pf,z

)
,

ρ =
1

2

(
1 + Pi,z Pi,x − iPi,y

Pi,x + iPi,y 1− Pi,z

)
,

and

M =

(
N +M⊥,z −iM⊥,y

iM⊥,y N −M⊥,z

)
.

M† denotes the conjugate transpose of M. The coordinates x, y and z refer to the local

coordination system, where x is always parallel to the scattering vector Q, z is vertical

and y completes the right-handed coordination system. The initial neutron polarization

is considered by multiplying it to the matrix of the incident beam ρ. The finite 3He cell
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efficiency is considered in the same way in the matrix of the analyzed beam σ.

The final neutron spin Pf is related to the initial one by

Pf = PPi +P′

where P is a rotation matrix acting on the initial neutron spin Pi and P′ is the cre-

ated/annihilated polarization. By aligning the initial neutron polarization along the di-

rections x, y or z and by analyzing the component of the final neutron spin along these

directions, one can summarize nine measurements in the so-called polarization matrix,

which is better defined as a pseudomatrix, since it combines the rotation and the cre-

ated/annihilated polarization. For the general case, i.e. including nuclear, magnetic and

interference terms as well as different degrees of polarization and analyzer efficiency for

the different directions, the polarization matrix is

Pf,i =



pfx
pix(N

2−M2)−Jyz
Ix

pfx
−piyJnz−Jyz

Iy
pfx

pizJny−Jyz
Iz

pfy
pixJnz+Rny

Ix
pfy

piy(N
2+M2

⊥y−M2
⊥z)+Rny

Iy
pfy

pizRyz+Rny

Iz

pfz
−pixJny+Rnz

Ix
pfz

piyRyz+Rnz

Iy
pfz

piz(N
2−M2

⊥y+M2
⊥z)+Rnz

Iz


with N2 = NN∗, M2 = M⊥M

∗
⊥, M

2
⊥,y = M⊥yM

∗
⊥y and M2

⊥z = M⊥zM
∗
⊥z. The mixed

magnetic terms are Ryz = 2ℜ(M⊥yM
∗
⊥z) and Jyz = 2ℑ(M⊥yM

∗
⊥z), while the nuclear-

magnetic interference terms are Rny = 2ℜ(NM∗
⊥y), Rnz = 2ℜ(NM∗

⊥z), Jny = 2ℑ(NM∗
⊥y)

and Jnz = 2ℑ(NM∗
⊥z). The respective matrix elements are normalized to the scattered

intensity depending on the initial neutron polarization:

Ix = N2 +M2
⊥y +M2

⊥z + pixJyz

Iy = N2 +M2
⊥y +M2

⊥z + piyRny

Iz = N2 +M2
⊥y +M2

⊥z + pizRnz

In the absence of nuclear scattering, i.e. for a purely magnetic peak, N = Rny = Rnz =

Jny = Jnz = 0. One can in general assume the same degree of incident neutron polarization

as well as analyzer efficiency for the different directions: pix = piy = piz = p0 and

pfx = pfy = pfz = pf . The latter is equal to 1 for data which have been already corrected

for the analyzer efficiency. The above polarization matrix is obtained by applying the

density matrix formalism for each individual element.
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7.3 Flipping ratios

The flipping ratio R of a Bragg reflection is defined as the intensity ratio between spin-up

and spin-down neutrons and is given by

R =
I+

I−
=
NN∗ + (NP0M

∗
⊥ +N∗P0M⊥) +M⊥M

∗
⊥

NN∗ − (NP0M∗
⊥ +N∗P0M⊥) +M⊥M

∗
⊥

where P0 is the vector of the initial neutron polarization to be taken along the vertical

axis of the diffractometer and the dot product P0M⊥ gives the projection of the magnetic

interaction vector onto the vertical polarization axis.

The extinction correction for flipping ratios corresponds to the one which is applied in

FullProf [15], see the Flipping Ratios in FullProf manual.The flipping ratio is then

written as

R =
(NN∗ +M⊥,zM

∗
⊥,z)p

+
p + (N∗p+

mM⊥ +Np+
mM∗

⊥) + (1− q2)M⊥M
∗
⊥ypm

(NN∗ +M⊥,zM
∗
⊥,z)p

−
p + (N∗p−

mM⊥ +Np−
mM∗

⊥) + (1− q2)M⊥M
∗
⊥ypm

with the correction factors

p±p =
1

2

[
(1± P0)(1 +

0.001I+λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2 + (1∓ P0)(1 +

0.001I−λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2

]

p±
m =

1

2

[
(1± P0)(1 +

0.001I+λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2 − (1∓ P0)(1 +

0.001I−λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2

]
P̂0

ypm = (1 +
0.001xaniso(1− q2)M⊥M

∗
⊥λ

3r

4 sin2(θ/λ) sin(2θ)
)−1/2,

where P0 is the beam polarization and I± are the uncorrected intensities for a spin-up and

spin-down beam, respectively. q = sinα with α being the angle between the scattering

vector and the vertical axis.

Mag2Pol version 3.0 introduced the feature of calculating magnetization density maps.

For the observed maps and difference maps, the magnetic structure factors (the coefficients

of the Fourier inversion) are obtained by isolating M from the flipping ratio expression:

M2 + aM + b = 0

with

a =
2Nq2(Rp−m − p+m)

q4(Rp−p − p+p ) + (1− q2)q2ypm(R− 1)
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and

b =
N2(Rp−p − p+p )

q4(Rp−p − p+p ) + (1− q2)q2ypm(R− 1)

Note that the present version of Mag2Pol uses the calculatedM to derive the extinction

correction factors analytically although this is an approximation. A numeric method will

be implemented in a future release.

7.4 Multipoles

The magnetization density m(r) is described by

m(r) = R′
0C

′
0
0d′0

0(r̂) +
4∑

l=0

Rl(r)
l∑

m=−l

Cm
l d

m
l (r̂)

where the dml are the density-normalized real spherical harmonics yml whose normalization

constants can be found in [41]. The primed quantities denote the first monopole besides

the one specified by R0, C
0
0 and d00. Rl is the radial dependence of a Slater-type orbital:

Rl(r) =
Znl+3

(nl + 2)!
rnl exp(−Zlr)

where n and Z can be chosen to be different for each l value. Z and the coefficients Cm
l

are refinable parameters. The normalization is such that:

∞∫
r=0

Rlr
2dr = 1.

The real spherical harmonics yml are obtained from the spherical harmonics Y m
l according

to

yml =


√
2 Im(Y

|m|
l ), if m < 0

Y 0
l , if m = 0

√
2Re(Y

|m|
l ), if m > 0

The spherical harmonics parametrized in the angles θ and φ are given by

Y m
l (θ, φ) =

√
2l + 1

4π
· (l −m)!

(l +m)!
Pm
l (cos θ)eimφ

As indicated e.g. in [42] the Condon-Shortley phase (−1)m which can be seen in some

textbooks is included in the associated Legendre polynomials Pm
l so that, e.g. P 1

1 (x) =
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−(1 − x2)
1
2 and P−1

1 (x) = −1
2P

1
1 (x). Therefore, the density-normalized real spherical

harmonics are normalized so that:

π∫
θ=0

2π∫
φ=0

|dml (θ, φ)| sin(θ)dφdθ =

1, for l = 0

2, for l > 0

The magnetic form factor is given by the Fourier transform of the magnetization density

and results in

f(Q) = ⟨j′l(Q)⟩C ′
0
0d′0

0(Q̂) +
4∑

l=0

il⟨jl(Q)⟩
l∑

m=−l

Cm
l d

m
l (Q̂)

where Q̂ is parametrized in terms of θ and φ and ⟨jl(Q)⟩ being the Fourier-Bessel transform
of the radial density:

⟨jl(Q)⟩ =
∞∫

r=0

Rl(r)jl(Qr)4πr
2dr

jl(x) are the spherical Bessel functions:

j0(x) =
sinx

x

j1(x) =
sinx

x2
− cosx

x

j2(x) =
3

x2 − 1

sinx

x
− 3 cosx

x2

etc. Note that in the spherical Bessel functions Q is expressed in atomic units by multi-

plying the Bohr atomic radius a0 in Å and that f(Q=0)=1 for C0
0 = 1, since ⟨j0(0)⟩ = 4π

and d00(Q̂) = 1
4π .

7.5 Orbitals

Here, the magnetization density m(r) is given by

m(r) = |ϕl(r)|2 =

∣∣∣∣∣Rl(r)

l∑
m=−l

Cm
l d

m
l (r̂)

∣∣∣∣∣
2

= R2
l (r)

2l∑
l′=0,2...

l′∑
m=−l′

βml′ d
m
l′ (r̂)

The product of two spherical harmonics is expressed as a sum over spherical harmonics

according to the contraction rule and the relation between the coefficients Cm
l and βml are

obtained by equating the orbital expansion with the multipole expansion which results in

the so called M matrix (see [21]). Therefore, the magnetic form factor becomes

f(Q) =
2l∑

l′=0,2...

il
′⟨jl′(Q)⟩

l′∑
m=−l′

βml′ d
m
l′ (Q̂)
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with ⟨jl′(Q)⟩ expressed like in the previous section

⟨jl′(Q)⟩ =
∞∫

r=0

R2
l′(r)jl′(Qr)4πr

2dr

The radial part can be expressed by using the tabulated ⟨jl′(Q)⟩ as for the sum of radial

integrals or by using Slater-like orbitals like in the multipole approach. A third option is

the hydrogen-like radial function which writes as

Rn,l =

[
ξ

2n
(n− l − 1)!(n+ l)!

] 1
2

exp

(
−ξr

2

)
(ξr)l+1

n−l−1∑
ν=0

(−ξr)ν

ν!(ν + 2l + 1)!(n− l − 1− ν)!

with ξ = 2Z
na0

.

7.6 Spin correlations

Given a periodic magnetic structure or the result of a reverse Monte-Carlo simulation in

a large supercell the intensities I(Q) can be calculated according to

I(Q) = C[µf(Q)]2 · 1

N

∑
i,j

[
Aij

sinQrij
Qrij

+Bij

(
sinQrij
(Qrij)2

− cosQrij
(Qrij)2

)]
, (7.1)

where C =
(γnre

2

)2
= 0.07265 barn, µ is the effective magnetic moment, f(Q) is the mag-

netic form factor, N is the number of atoms in the super cell, Q is the scattering vector

and the sum runs over the pairs of spins i and j separated by the distance rij . In order to

calculate the powder-averaged magnetic neutron scattering intensity for each spin pair in

the sum a local coordination system is defined where z is along the vector rij , y is parallel

to Si × z and x completes the right-handed system. With this definition Aij = Sx
i S

x
j and

Bij = 2Sz
i S

z
j − Sx

i S
x
j as implemented in Spinvert [34].

The analytical form of the mPDF was derived for the first time in [43] by calculating

the Fourier transform of the neutron scattering cross section from a collection of magnetic

moments. We have adapted the original formula by adjusting the prefactors in order to

be consistent with Eq. 7.1:

I(r) =
C[µf(Q)]2

b2M
· 1

N

∑
i,j

[
Aij

r
δ(r − rij) +Bij

r

r3ij
[1−Θ(r − rij)]

]
. (7.2)

b2M is the square of the magnetic scattering length 3.055 barn/str/Gd and 0.635 barn/str/Nd,

respectively. Furthermore, in order to allow the comparison with the Fourier transform of

the corrected raw data (without dividing by the magnetic form factor) we have replaced
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the delta function δ(r) and the step function Θ(r) by Gaussian and Error functions,

respectively, with a full width at half maximum (FWHM) in real space corresponding

to a Gaussian fit to the squared magnetic form factor in reciprocal space [FWHMR ≈
4 · ln(4)/(4πFWHMf2(Q))] (note that the factor 4π is due to the crystallographers’ def-

inition of Q widely used in particular for the analytical approximation of magnetic form

factors, which is also adapted in Mag2Pol).

7.7 Powder patterns

Rietveld refinement is a method which compares an experimentally observed powder (x-ray

or neutron) diffraction pattern with a calculated line profile in a least-squares algorithm

until the best possible agreement is found. The intensities of the Bragg reflections are

calculated based on the supplied nuclear/magnetic structure model, while for a LeBail

refinement the calculated intensities are set to the values of the observed intensities after

each refinement step (note that Mag2Pol does not save the somewhat artificial intensities

of each Bragg reflection in a LeBail refinement, but iteratively recovers them when re-

loading a saved refinement until the difference in χ2 is less than 0.005 with a maximum

of 1000 cycles). Mag2Pol supports diffraction patterns recorded on constant-wavelength

and time-of-flight instruments and the data should contain the scattering variable 2θ or

TOF, the intensity and eventually the standard deviation of the intensity. If the latter is

not given (depending on the input file format), the program takes the square root of the

intensity.

The following features and equations are based on the FullProf manual. For the sake

of completeness of this manual, the implemented equations are listed here as well.

7.7.1 Calculated profile

The theoretical profile is calculated from the given structure model with nuclear and/or

magnetic contribution. A single point in this profile is calculated according to

ycal,i =
∑
P

SP
∑
Q

IP,Q · Λ(2θi − 2θP,Q −∆2θ) + bi

where the sum runs over the number of phases P and all Bragg reflections Q which

contribute to the point ycal,i. SP is the scale factor of phase P , Λ is the profile function

with its peak at 2θP,Q (∆2θ contains all systematic offsets, see Secs. 7.7.1.5 and 7.7.1.6)

and bi is the background which is calculated according to the model used (see Sec. 7.7.1.7).

The intensity of the Bragg reflection Q of phase P writes as

IP,Q = (m · L ·A · P · T · F 2)P,Q
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7.7 Powder patterns

F 2 is the square of the nuclear/magnetic structure factor corresponding toNN∗ orM⊥M
∗
⊥

as shown in Sec. 7.1 and m is the multiplicity of the peak [e.g. m = 4 for a (200) reflection

in tetragonal symmetry]. The remaining quantities are described in the following sections.

7.7.1.1 Lorentz and polarisation factor

The Lorentz and polarisation factor L (in Debye-Scherrer geometry) is given by

L =
1−K +K cos2(2θM ) cos2(2θ)

2 sin2(θ) cos(θ)

with θM being the monochromator take-off angle and K the polarization factor, which is

0 for neutrons, 0.5 for characteristic non-polarised x-ray radiation and around 0.1 for syn-

chrotron radiation. Therefore, the take-off angle does not need to be given in the neutron

case.

7.7.1.2 Asymmetry

A is the peak asymmetry, a function which is multiplied to the profile function

A(x) = 1− A1Fa(x)−A2Fb(x)

tanh(θ)
− A3Fa(x) +A4Fb(x)

tanh(2θ)

with

x =
2θi − 2θQ −∆2θ

FWHM

∆2θ combines all systematic line-shifts which are explained in more detail in Sec. 7.7.1.6.

The functions Fa,b(x) are given by

Fa(x) = 2z exp(−z2)

Fb(x) = (2z2 − 3)Fa(x)

The parameters A1 to A4 can be refined. Note that the subtle differences in the equations

in comparison to the FullProf manual are on purpose, they have been adapted to obtain

the same asymmetries.

7.7.1.3 Preferred orientation

The two following preferred orientation functions are implemented in Mag2Pol:
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• Exponential function

The correction factor for the calculated intensities is given by

PQ = P2 + (1− P2) exp(−P1α
2
Q)

αQ is the acute angle between the scattering vector Q and the normal of the preferred

orientation (hkl) vector which has to be defined by the user. P1 and P2 are refinable

parameters.

• Modified March’s function

Here the correction is calculated by

PQ = P2 + (1− P2)

{
[P1 cos(αQ)]

2 +
sin2(αQ)

P1

}− 3
2

and P1 and P2 are again refinable parameters. P1 = 1 means no preferred orientation,

P1 < 1 refers to a platy habit (αQ is the acute angle between the scattering vector

and the normal of the crystallites) and P1 > 1 to a needle-like habit (αQ is the acute

angle bewteen the scattering vector and the axis of the needle).

7.7.1.4 Absorption and extinction

The effects of sample absorption depend on the scattering angle and can be corrected by

the following transmission factor for constant wavelength and Debye-Scherrer geometry:

TQ = exp
{
−
[
1.7133− 0.0368 sin2(θQ)

]
µλR+

[
0.0927 + 0.375 sin2(θQ)

]
[µλR]

2
}

The linear absorption coefficient is automatically calculated based on the given structure

model (averaged over the volumes of the contributing phases) and the corresponding wave-

length (λ1 or λ2), but the radius R of the cylindrical sample has to be given by the user.

For time-of-flight data different refinable absorption models are implemented:

• Model 1

Here the parameters µ1 and µ2 can be refined to mimic an effective µλR according

to

µλR = µ1 · λQ + µ2

with λQ being the wavelength associated with the particular reflection Q and the

transmission factor is given by

TQ =

1− µλR(1− 2
3µλR), if µλR ≤ 0.001

1−exp(−2µλR)
2µλR

, if µλR > 0.001
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• Model 2

This model corresponds to the one for the constant-wavelength case, but with a

refinable parameter µ1 which is multiplied with λQ representing µλR:

TQ = exp
{
−
[
1.7133− 0.0368 sin2(θB)

]
µ1λQ +

[
0.0927 + 0.375 sin2(θB)

]
[µ1λQ]

2
}

Hereby, θB is half the scattering angle of the corresponding detector bank.

• Model 3

Again, the parameter µ1 is multiplied with λQ associated to the reflection Q, there-

fore describing an effective µR, and the transmission factor is

TQ = exp(−µ1λQ)

• Model 4

This is the Loganov & alte da Veiga model [44]. For µ1λQ = µR < 3 cm−1

T = exp
[
−k0µ1λQ − k1(µ1λQ)

2 − k2(µ1λQ)
3 − k3(µ1λQ)

4
]

with

k0 =1.697653

k1 =
[
25.99978− 0.01911

√
sin(θB)

]
exp(−0.024514 sin2(θB))

+ 0.109561 sin(θB)− 26.0456

k2 =− 0.02489− 0.39499 sin2(θB) + 1.219077 sin3(θB)− 1.31268 sin4 θB

+ 0.871081 sin5(θB)− 0.2327 sin6(θB)

k3 = 0.003045 + 0.018167 sin2(θB)− 0.03305 sin4(θB)

For µ1λQ = µR > 3 cm−1 the transmission factor is given by

T =
k4 − k7

[1 + k5(µ1λQ − 3)]k6
+ k7

with

k4 = 1.433902 + 11.07504 sin2(θB)− 8.77629 sin4(θB)

+ 10.02088 sin6(θB)− 3.36778 sin8(θB)

k5 =
[
0.013869− 0.01249 sin2(θB)

]
exp

[
3.27094 sin2(θB)

]
+

0.337894 + 13.77317 sin2(θB)[
1 + 11.53544 sin2(θB)

]1.555039
k6 =

1.933433[
1 + 23.12967 sin2(θB)

]1.686715 − 0.13576 sin(θB) + 1.163198

k7 = 0.044365− 0.04259[
1 + 0.41051 sin2(θB)

]148.4202
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For time-of-flight data a primary extinction correction is implemented which is cal-

culated according to [45]. The extinction correction E is a combination of Bragg

and Laue components

E = EB sin2(θB) + EL cos2(θB),

where

EB =
1√
1 + x

and

EL = 1− x

2
+
x2

4
− 5x3

48
+ ... for x < 1

or

EL =

√
2

πx

(
1− 1

8x
− 3

128x2
− 15

1024x3
− ...

)
for x > 1

where

x = rbl

(
λQF

V

)2

where F is the calculated structure factor and V is the unit cell volume. rbl is a

refinable parameter and is a measure of the mosaic block size in µm2. Note that

a direct comparison of this value with FullProf is only possible, if the *.pcr file

contains the occupation factor as the ratio between special site and general site

multiplicity.

7.7.1.5 Profile functions

Except for the numerical and the split Pseudo-Voigt profile all constant-wavelength profile

functions available in FullProf are implemented inMag2Pol, in the current version two

time-of-flight peak profiles are implemented. If not otherwise specified, for all constant-

wavelength profiles the full width at half maximum Γ is composed of the Cagliotti formula

(u, v, w refinable parameters) and isotropic Gaussian broadening (IG refinable parameter):

Γ2 = u · tan2(θ) + v · tan(θ) + w +
IG

cos2(θ)

• Gaussian

Λ(x) = G(x) =
2

Γ

√
ln 2

π
exp

(
−4 ln 2

Γ2
x2
)

• Lorentzian

Λ(x) = L(x) =
aL

1 + bLx2

aL =
2

πΓ
bL =

4

Γ2
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• Modified Lorentzian

Λ(x) =
aML

(1 + bMLx2)
2

aML =
4
√√

2− 1

πΓ
bML =

4(
√
2− 1)

Γ2

• Intermediate Lorentzian

Λ(x) =
aIL

(1 + bILx2)
3/2

aIL =

√
22/3 − 1

Γ
bIL =

4(22/3 − 1)

Γ2

• Pearson VII

Λ(x) =
aV II

(1 + bV IIx2)
m

aV II =
Γ(m)

Γ(m)− 1/2

2
√
21/m − 1√
πΓ

bV II =
4(21/m − 1)

Γ2

The refinable parameter m can optionally be set to be a function of the scattering

angle (in degrees):

m = m0 +
100 ·X

2θ
+

1000 · Y
(2θ)2

where X and Y are further refinable parameters.

• Pseudo-Voigt

Λ(x) = pV (x) = η · L(x) + (1− η) ·G(x) 0 ≤ η ≤ 1

where L(x) and G(x) have the same full width at half maximum Γ. The mixing

parameter η can optionally be set to be a function of the scattering angle (in degrees):

η = η0 +X · 2θ

• Tripled Pseudo-Voigt

Λ(x) = X · pV (x−D) + (1−X − Y ) · pV (x) + Y · pV (x+D)

D =
S

d cos(θ)

where d is the d-spacing of the (hkl) reflection for which the profile is calculated and

S is a refinable parameter. The three Pseudo-Voigt profiles have the same η0 and Γ

and are mixed according to the refinable parameters X and Y .
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• Pseudo-Voigt with Finger-Cox-Jephcoat asymmetry [46]

Λ(x) =

Nmax∑
n=1

wnW (δn,2θ)pV (x+2θ−δn)
h(δn) cos(δn)

Nmax∑
n=1

wnW (δn,2θ)
h(δn) cos(δn)

The sum is a numerical integration corresponding to a Gauss-Legendre quadrature

procedure with wn and xn being the Gauss-Legendre weights and abscissae associ-

ated with the nth point and Nmax is the number of points chosen. In the original

paper it is recommended that Nmax ≥ 30 for values within six half-widths of the

profile peak and Nmax = 10 outside this region. Mag2Pol uses Nmax = 30 for every

point which yields smooth peak profiles with sufficiently fast calculation times.

h(δ) =

√
cos2(δ)

cos2(θ)
− 1 δn =

1

2
(2θ + 2φmin) +

xn
2
(2θ − 2φmin)

W (2φ, 2θ) =


SL +DL − h(δn), for 2φmin ≤ 2φ < 2φinfl

2min(SL, DL), for 2φinfl ≤ 2φ ≤ 2θ

0, else

The inequalities above apply to 2θ < 90◦ and have to be inverted for 2θ > 90◦.

Bragg peaks with a scattering angle closer than 0.1◦ to 90◦ are not corrected in

Mag2Pol. The respective limiting 2φ angles are given by

2φmin = cos−1
[
cos(2θ)

√
(SL +DL)2 + 1

]
2φinfl = cos−1

[
cos(2θ)

√
(DL − SL)2 + 1

]
The parameters SL and DL are refinable. The first refers to half the sample height

divided by the sample-to-detector distance and the second is half the detector height

divided by the sample-to-detector distance. The implemented code was successfully

compared to the example given in the original paper as well as with FullProf

examples. The recast of variables for special values of SL and DL in the refinement

procedure as proposed in [47] is implemented but needs to be tested more throroughly

as the resulting standard deviation proved to be a bit high for some examples.

• Thompson-Cox-Hastings Pseudo-Voigt with Finger-Cox-Jephcoat asymmetry

In comparison to the Pseudo-Voigt profile above the parameter η is not refinable but

calculated from the Lorentzian and Gaussian linewidths:

ΓG =

√
u · tan2(θ) + v · tan(θ) + w +

IG
cos2(θ)
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ΓL = X · tan(θ) + Y

cos(θ)

with X and Y being refinable parameters The numerical Pseudo-Voigt approxima-

tion of the convolution between the Lorentzian and a Gaussian function yields

Γ =
(
Γ5
G + 2.69269 · Γ4

GΓL + 2.42843 · Γ3
GΓ

2
L + 4.47163 · Γ2

GΓ
3
L + 0.07842 · ΓGΓ

4
L + Γ5

L

)1/5
η = 1.36603 · ΓL

Γ
− 0.47719 ·

(
ΓL

Γ

)2

+ 0.11116 ·
(
ΓL

Γ

)3

These values Γ and η are then used in the Pseudo-Voigt function pV (x) and the

optional Finger-Cox-Jephcoat asymmetry is calculated as described in the previous

point.

• Convolution of Pseudo-Voigt with a pair of back-to-back exponentials

Λ(x) = pV (x)⊛ E(x) =

∞∫
−∞

pV (x− t)E(t)dt

= (1− η)N [eu erfc(y)ev erfc(z)]− 2Nη

π
{ℑ[epE1(p)] + ℑ[eqE1(q)]}

with erfc being the complementary error function, E1 the exponential integral and

N =
αβ

2(α+ β)
.

The exponents u and v are given by

u =
1

2
α(ασ2G + 2x) u =

1

2
β(βσ2G − 2x),

the arguments y, z by

y =
ασ2G + x√

2σ2G

z =
βσ2G − x√

2σ2G

and the arguments p and q by

p = αx+
iαΓ

2
p = −βx+

iβΓ

2
.

The Gaussian component of the Pseudo-Voigt function is expressed by

σ2G = σ0 + σ1 · d2 + (σ2 + IG) · d4 + σQ/d
2 =

Γ2
G

8 ln 2

and the Lorentzian component writes as

γL = γ0 + γ1 · d+ γ2 · d2 = ΓL.
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Note that the Lorentzian size broadening is not yet implemented in Mag2Pol. The

relations between ΓG, ΓL and Γ as well as η are the same as for the Thompson-Cox-

Hastings Pseudo-Voigt function. The rise and decay constants α and β are given

by

α = α0 +
α1

d
+
αQ√
d

β = β0 +
β1
d4

+
βQ
d2

• Convolution of Pseudo-Voigt with the Ikeda-Carpenter function

The Ikeda-Carpenter function is the result of the convolution of two functions

Sk(t) =
α3

2
t2e−αt Rk(t) = (1−R)δ(t) +Rβe−βt,

which describe leakage of fast and slow neutrons from the moderator with the fast

and slow decay constants α and β:

Ik(t) = Sk(t)⊛Rk(t) = (1−R)Sk(t)⊛ δ(t) +RβSk(t)⊛ e−βt

= (1−R)Sk(t) +Rβ

∞∫
−∞

Sk(τ)
[
e−β(t−τ)

]
dτ

= (1−R)Sk(t) +Rβe−βt

t∫
0

Sk(τ)e
βtdτ

=
α3

2

{
(1−R)t2e−αt +

2Rβ

(α− β)3

[
e−βt − e−αt

(
(α− β)2

t2

2
+ (α− β)t+ 1

)]}
The implemented peak profile is obtained by the convolution of a Pseudo-Voigt

function with the Ikeda-Carpenter function:

Λ(x) = pV (x)⊛ Ik(x) =

∞∫
−∞

pV (x− t)Ik(t)dt = N [(1− η)ΛG(x) + ηΛL(x)]

with

N =
α(1− k2)

4k2

The Gaussian part ΛG is given by

ΛG(x) = Nue
u erfc(yu) +Nve

v erfc(yv) +Nse
s erfc(ys) +Nre

r erfc(yr)

with

Nu = (1−R
α−

w
) Nv = (1−R

α+

z
) Ns = −2(1−R

α

y
) Nr = 2Rα2β

k2

wyz

and

yu =
α−σ2G − x√

2σ2G

yv =
α+σ2G − x√

2σ2G

ys =
ασ2G − x√

2σ2G

yr =
βσ2G − x√

2σ2G
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where k = 0.05, R = exp
(
−81.799

κλ2

)
, α− = α(1 − k), α+ = α(1 + k), w = α− − β,

y = α− β and z = α+ − β. The parameters α and β are

α =
1

α0 + λα1
β =

1

β0

The u, v, s and r arguments of the exponential functions are

u =
1

2
α−(α−σ2G−2x) v =

1

2
α+(α+σ2G−2x) s =

1

2
α(ασ2G−2x) r =

1

2
β(βσ2G−2x)

The Lorentzian part is described by

ΛL(x) = − 2

π
{Nuℑ [ezuE1(zu)] +Nvℑ [ezvE1(zv)] +Nsℑ [ezsE1(zs)] +Nrℑ [ezrE1(zr)]}

with the zn being

zs = −αx+1

2
iαγL zu = −α−x+

1

2
iα−γL zv = −α+x+

1

2
iα+γL zr = −βx+1

2
iβγL

Note that σG and γL have the same definition as for the previous peak profile (con-

volution of Pseudo-Voigt and back-to-back exponentials).

7.7.1.6 Offsets / Time of flight

Systematic line-shifts in a powder pattern can occur due to an improper alignment of the

sample and/or the detector. The first offset parameter, ∆0 simply adds to the calculated

2θ value of a Bragg reflection and corresponds to the zero-shift of the detector. The

sample-dependent line-shifts result from the eccentricity e of a sample with radius R from

the central position

• perpendicular to the incident beam direction

∆2θ =
e

R
cos(2θ) = ∆x cos(2θ)

• parallel to the incident beam direction

∆2θ =
e

R
sin(2θ) = ∆y sin(2θ)

The above equations apply to the Debye-Scherrer geometry and the parameters ∆x and

∆y are refinable. Note that the correction perpendicular to the incident beam direction

is different from the cos(θ) term in the FullProf manual, but both programs yield no

shift for 2θ = 90◦.
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For TOF data the instrumental offsets in the peak positions are given by the 4 parameters

Z0, D1 and D2 and D−1 which yield the time of flight T for a reflection Q with d-spacing

d:

T = Z0 +D1 · d+D2 · d2 +D−1/d

7.7.1.7 Background

The different possibilities to describe the background of a powder diffraction pattern in

Mag2Pol are explained below

• linear interpolation

The user defines a number of discrete background points as explained in Sec. 4.5.3

and the program calculates a linear interpolation. The slope beyond the first and

last point is simply continued. When 0 points are defined, the background is 0

everywhere; when 1 point is defined, the background is flat and goes through that

point.

• polynomial (6 coefficients)

bi =
5∑

m=0

Cm

(
2θi
B0

− 1

)m

where the coefficients C0 to C5 are refinable parameters and B0 is the adaptable

origin of the polynomial.

• polynomial (12 coefficients)

bi =
−1∑

m=−3

Cm (2θi)
m +

8∑
m=0

Cm

(
2θi
B0

− 1

)m

where the coefficients C−3 to C8 are refinable parameters and B0 is the adaptable

origin of the polynomial.

• polynomial (6 coefficients) + Debye-like

bi =

5∑
m=0

Cm

(
2θi
B0

− 1

)m

+

6∑
n=1

C ′
n

sin(Qirn)

Qirn

with Qi = 4π sin(θi)
λ . The coefficients C0 to C5 as well as C ′

1 to C ′
6 and r1 to r6 are

refinable parameters and B0 is the adaptable origin of the polynomial.
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7.7.1.8 Size/strain broadening and microstructure analysis

Isotropic Gaussian and Lorentzian size and strain broadening depend differently on the

scattering variable and can therefore be refined simultaneously, when the instrument res-

olution is function is known and loaded (see Sec. 4.5.2.1). Within the Thompson-Cos-

Hastings Pseudo-Voigt profile function the different sample contributions to the peak

broadening of a CW pattern can be quantified as follows:

ΓG,s =

√
∆u · tan2(θ) + IG

cos2(θ)

ΓL,s = ∆X · tan(θ) + ∆Y

cos(θ)
,

where IG and ∆Y are the Gaussian and Lorentzian size broadening, while ∆u and ∆X

are the Gaussian and Lorentzian strain broadening.

The corresponding expressions for the TOF case are:

ΓG,s =
√
8 ln 2 · σG,s

σ2G,s = IG · d4 +∆σ1 · d2

ΓL,s = ∆γ2 · d2 +∆γ1 · d,

with IG and ∆γ2 being the Gaussian and Lorentzian size broadening and ∆σ1 and ∆γ1

the Gaussian and Lorentzian strain broadening parameters.

The integral breadth of a Bragg peak is calculated according to [48]:

β =
1

2

Γ

η/π + (1− η)
√
π/ ln 2

where Γ is the FWHM according to the TCH Pseudo-Voigt equation expressed in reciprocal

lattice units Å−1 (in the microstructure analysis window a factor 1000 is applied). The

apparent size is calculated as 1/βsize and is given in Å, while the maximum (upper limit)

strain is given by 0.5 ·βstrain ·d (a factor 10000 is applied in the table of the microstructure

analysis window).

7.8 Local susceptibility tensor

In analogy to the implementation in the CCSL, the local susceptibility tensor is defined

by its main axes x, y and z with x ∥ a∗, y ∥ b and z ∥ c. The six coefficients which can be

entered by the user construct the symmetric anisotropic tensor χ:

χ =

χ11 χ12 χ13

χ12 χ22 χ23

χ13 χ23 χ33


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and the magnetic moment (in the xyz reference frame) at position i is calculated by

µi = RiχR
−1
i H

with Ri being the rotational part of the the symmetry operator acting on the atomic

position and susceptibility tensor. Here, the magnetic field vector H is also expressed in

the xyz basis, i.e. the field direction (unit vector) given by the vertical diffractometer

axis in reciprocal lattice units and the multiplication factor H is transformed internally

before calculating the magnetic moment in the xyz basis. The magnetic moment µi is

then transformed back into the usual crystallographic frame in order to use the same

equations as given in Secs. 7.1, 7.2 and 7.3. The same site symmetry constraints as for the

anisotropic temperature factors [7] are applied to the local susceptibility tensors, however,

transformed into the xyz basis.

Finally, the bulk magnetization is given by

χbulk =
∑
j

∑
i

RiχR
−1
i ·multj · occj

where the sum is taken over all symmetry operators Ri of the crystallographic space

group and over all magnetic sites j with mult and occ being the site multiplicity and the

occupation factor, respectively.

7.9 Standard deviations and agreement factors

The standard deviations σ are obtained by taking the square root of the diagonal of the

covariance matrix C:

C = α−1 · χ2
r

The correlation matrix is obtained by dividing the elements Ci,j by the standard deviations

σi · σj . α is a n× n square matrix with n the number of refined parameters xj :

α = DT ·D

with D being a m× n matrix (m is the number of observations yobs,i or calculated values

ycal,i) where the jth column is given by:

D(j) =
ycal,i(xj +∆)− ycal,i(xj −∆)

2∆σi

The reduced χ2
r value is defined as

χ2
r =

χ2

(m− n)
.
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and χ2 is expressed by

χ2 =
∑
i

(
yobs,i − ycal,i

σi

)2

.

The observed and calculated values, yobs,i and ycal,i, can be integrated intensities, polar-

ization matrix elements or a point in a diffraction pattern.

The crystallographic RF factor is given by

RF = 100 ·

∑
Q

|Fobs,Q − Fcal,Q|∑
Q

Fobs,Q

and is calculated when integrated intensities or powder patterns are refined. In the case

of powder data refinement the observed quantities Fobs,i are calculated from the Rietveld

formula:

Iobs,Q = Ical,Q ·

∑
i
wi ·

yobs,i−bi
ycal,i−bi∑

i
wi

with

wi = Λ(2θi − 2θQ −∆2θ) ·A

i.e. the observed intensities are extracted based on the underlying structure model and

peak clusters are proportionally decomposed depending on the calculated intensities which

contribute. The weighting factors correspond to the amplitude within a specific profile

function multiplied by the asymmetry function (note that the asymmetry is not included

in FullProf, which, however does not make a difference).

For the determination of the standard deviations of the observed intensities the error

propagation of the quantity (yobs,i − bi)/(ycal,i − bi) is derived which results in

σ(Iobs,Q) =
Ical,Q√∑

i
wi

with

1/wi = σ2(yobs,i) ·
{

1

(ycal,i − bi)2
+

[
yobs,i − bi

(ycal,i − bi)2
ycal,i
yobs,i

]2
+

[
yobs,i − ycal,i
(ycal,i − bi)2

bi
yobs,i

]2}
The observed structure factor is then obtained from the observed intensity corrected for

the peak multiplicity and the Lorentz factor:

Fobs,Q =

√
Iobs,Q
m · L

.
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